SIEMENS

SIMATIC HMI

HMI device
MP 177 (WinCC flexible)

Operating Instructions

Ordernumber 6AV6691-1DP02-0AB0

08/2008

A5E01075489-01

Preface

Overview

Safety instructions

Planning application

Mounting and connecting

Operator controls and
displays

Configuring the operating
system

Commissioning a project

Operating a project

Operating alarms

Operating recipes

Maintenance and care

© 0O N oo o b~ WD

-_— -
- O

Technical specifications

Appendix

RN
N

Abbreviations




Legal information

Warning notice system
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

A\DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

AAWARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

A\CAUTION
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

CAUTION
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

NOTICE

indicates that an unintended result or situation can occur if the corresponding information is not taken into
account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and
operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes
in this documentation qualified persons are defined as persons who are authorized to commission, ground and
label devices, systems and circuits in accordance with established safety practices and standards.

Prescribed Usage
Note the following:

AAWARNING

This device may only be used for the applications described in the catalog or the technical description and only
in connection with devices or components from other manufacturers which have been approved or
recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage,
positioning and assembly as well as careful operation and maintenance.

Trademarks
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the
owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the
information in this publication is reviewed regularly and any necessary corrections are included in subsequent

editions.
Siemens AG Ordernumber: 6AV6691-1DP02-0ABO Copyright © Siemens AG 2008.
Industry Sector ® 08/2008 Technical data subject to change

Postfach 48 48
90026 NURNBERG
GERMANY
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Purpose of the operating instructions

These operating instructions provide information based on the requirements defined by DIN
EN 62079 for mechanical engineering documentation. This information relates to the place of
use, transport, storage, mounting, use and maintenance.

These operating instructions are intended for the following user groups:
® Operators

The operator operates and monitors the system during the process control phase. The
following chapters are relevant to the operator:

— Operator controls and displays
— Operating a project
— Operating recipes
— Operating alarms
® Commissioning engineers

The commissioning engineer integrates the HMI device into the system and ensures the
operating capability of the HMI device for the process control phase.

All the operating instructions are relevant for the commissioning engineer.

Depending on the use of the HMI device, certain chapters may not be of relevance to the
commissioning engineer, e.g. the chapter "Maintenance and care".

® Service technicians
Service technicians rectify faults that occur during the process control phase.
The entire set of operating instructions is relevant to service technicians in principle.

Depending on the use of the HMI device, however, certain chapters may not be relevant
to them, e.g., the chapter on "Maintenance and care".

® Maintenance technicians

Maintenance technicians carry out regular maintenance work during the process control
phase. The chapter on "Maintenance and care" is relevant to maintenance technicians.

The chapter "Safety instructions, standards and notes" should be particularly heeded by all
person groups.

The help integrated in WinCC flexible, the WinCC flexible Information System, contains
detailed information. The information system contains instructions, examples and reference
information in electronic form.

Basic knowledge required

General knowledge of automation technology and process communication is needed to
understand the operating instructions.

It is also assumed that those using the manual have experience in using personal computers
and knowledge of Microsoft operating systems.

MP 177 (WinCC flexible)
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Scope of the operating instructions

The operating instructions apply to the HMI device MP 177 in conjunction with the
WinCC flexible software package.

Position in the information landscape

These operating instructions form part of the SIMATIC HMI documentation. The following
information provides you with an overview of the SIMATIC HMI information landscape.

User manuals

WinCC flexible Micro

Describes basic principles of configuration using the WinCC flexible Micro Engineering
System.

WinCC flexible Compact/ Standard/ Advanced

Describes basic principles of configuration using the WinCC flexible Compact
Engineering System/WinCC flexible Standard/WinCC flexible Advanced.

WinCC flexible Runtime
Describes how to commission and operate your runtime project on a PC.
WinCC flexible Migration

— Describes how to convert an existing ProTool project or WinCC project to
WinCC flexible.

Communication

— Communication Part 1 describes the connection of the HMI device to SIMATIC PLCs
and WIinAC PLCs.

— Communication Part 2 describes the connection of the HMI device to third-party PLCs.

Getting started

WinCC flexible for first time users

Based on an example project, this is a step-by-step introduction to the basics of
configuring screens, alarms, recipes and screen navigation.

WinCC flexible for power users

Based on an example project, this is a step-by-step introduction to the basics of
configuring logs, project reports, scripts, user management, multilingual projects and
integration in STEP 7.

WinCC flexible options

Based on an example project, this is a step-by-step introduction to the basics of
configuring the WinCC flexible Sm@rtServices, Sm@rtAccess and OPC server options.

Mobile Panel 277 IWLAN

Introduces project design for WLAN communication step by step using a sample
structure.

MP 177 (WinCC flexible)
Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0
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Operating instructions
® Operating instructions for SIMATIC HMI devices
- OP73,0P77A,OP77B
— TP 170micro, TP 170A, TP 170B, OP 170B
— OP 73micro, TP 177micro
- TP 177A, TP 177B, OP 177B
- TP 270, OP 270
- TP 277,0P 277
- MP270B
- MP 177
- MP277
- MP 370
- MP377
® Operating instructions for mobile SIMATIC HMI devices
— Mobile Panel 177
— Mobile Panel 277
— Mobile Panel 277 IWLAN
— Mobile Panel 277F IWLAN
® QOperating instructions (compact) for SIMATIC HMI devices
- OP77B
— Mobile Panel 177
— Mobile Panel 277
® QOperating instructions for SIMATIC accessories
— Industrial USB Hub 4
® Function manual
— Fail-safe operation of the Mobile Panel 277F IWLAN

Online availability

Technical documentation on SIMATIC products and SIMATIC systems is available

in PDF format in various languages:
® SIMATIC Guide for Technical Documentation:

"http://www.automation.siemens.com/simatic/portal/htm|_76/techdoku.htm"

Screens

The HMI device is sometimes shown in the form of photographs in these operating

instructions. The photographs of the HMI device may differ slightly from the factory state of

the HMI device.

MP 177 (WinCC flexible)
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Conventions

Trademarks

Configuration and runtime software differ with regard to their names as follows:
o "WinCC flexible 2008" for example, refers to the configuration software.

The term "WinCC flexible" is used in a general context. The full name, for example
"WinCC flexible 2008", is always used when it is necessary to differentiate between
different versions of the configuration software.

o "WinCC flexible Runtime" refers to the runtime software that can run on HMI devices.

The following text notation will facilitate reading these operating instructions:

Notation Scope

"Add screen" e Terminology that appears in the user interface, for example
dialog names, tabs, buttons, menu commands

¢ Inputs required, for example limit values, tag values
e Path information

"File > Edit" Operational sequences, for example menu commands, shortcut
menu commands.

<F1>, <Alt+P> Keyboard operation

Please observe notes labeled as follows:

Note

Notes contain important information concerning the product, its use or a specific section of
the documentation to which you should pay particular attention.

Names labeled with a ® symbol are registered trademarks of the Siemens AG. Other names
used in this documentation may be protected by third-party trademarks.

* HMI®
SIMATIC®
SIMATIC HMI®
WinCC®

Representatives and offices

If you have any further questions relating to the products described in this manual, please
contact your local representative at the Siemens branch nearest you.

Find your contact person at "http://www.siemens.com/automation/partner”

MP 177 (WinCC flexible)
Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0
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Training center

Siemens AG offers a variety of training courses in order to familiarize you with automation
systems. Please contact your regional training center, or our central training center in 90327
Nuremberg, Germany, for details.

Phone: +49 (911) 895-3200

Internet: "http://www.sitrain.com"

Technical Support
Technical support for all SIMATIC products is available:

® Using the Web form to request support
"http://www.siemens.com/automation/support-request"”

® Phone: +49 180 5050 222
® Fax: +49 180 5050 223

You will find more information on our technical support on the Internet at
"http://www.siemens.com/automation/service"

Service & Support on the Internet

Service & Support provides additional comprehensive information on SIMATIC products
through online services at "http://support.automation.siemens.com"

® The newsletter offers you the latest information about your products

® A large document base is available using our Service & Support search engine
e A forum for global exchange of information by users and experts

® Current product information, FAQs and downloads

® You local representative

® |nformation about on-site services, repairs, spare parts, and more

Recycling and disposal

Due to the low levels of pollutants in the HMI devices described in these operating
instructions, they can be recycled. For environment-friendly recycling and disposal of your
old equipment, contact a certified disposal facility for electronic scrap.

MP 177 (WinCC flexible)
Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0 7
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Overview

1.1 Product Overview

Possible applications of the MP 177

The Multi Panel MP 177 with a 6" touch screen represents an expansion of the Multi Panel
device series.

All the Multi Panels are based on the innovative standard operating system Microsoft
Windows CE 5.0. Multi Panels offer enhanced communication options to the office world. All
Multi Panels optimally support WinAC MP (software PLC) because of their special hardware.

The MP 177 offers a variety of application uses, high performance, and a favorable
cost/performance ratio.

The MP 177 has:

PROFIBUS port
Ethernet port for connection to PROFINET (LAN)
USB port

TFT screen

The following software options have been added to the functions of the MP 177 as a
"multifunctional platform:"

MP 177 (WIinCC flexible)

Software PLC WinAC MP (as of WinAC MP 2008)
Sm@rtService
Sm@rtAccess

Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0 15
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1.2 Design of the MP 177 HMI device

1.2 Design of the MP 177 HMI device

Front view and side view

@
@

® Slot for a memory card

® Display/touch screen

® Oblong holes for mounting clamps

@ Mounting seal

Bottom view
@ Ports

MP 177 (WinCC flexible)
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1.3 Supplementary pack and other accessories

Rear view
\m‘ l I :5?22?455
@

0] Rating label

® Slot for a memory card

® Interface name

@ DIP switch
See also

Ports (Page 41)
1.3 Supplementary pack and other accessories
Accessory kit

The accessory kit contains the following:
e 1 terminal block for the power supply
® Mounting clamps for installation

Additional documents may be enclosed with the accessory kit.

RS 422-RS 232 converter

The converter is required for the connection of controllers of other manufacturers. Connect
the RS 422-RS 232 converter to the RS 422/RS 485 port. The converter converts the input
signals to RS-232 signals.

The converter is not part of the scope of delivery of the HMI device. The converter can be
ordered separately using order number 6AV6 671-8XE00-0AXO0.

MP 177 (WinCC flexible)
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1.3 Supplementary pack and other accessories

90° elbow adapter

PC/PPI cable

Protective foil

Protective cover

Memory card

18

If space is limited, you can use an elbow adapter at the RS 422/RS 485 interface.

The adapter is not part of the scope of delivery of the HMI device. The adapter can be
ordered with order number 6AV6 671-8XD00-0AXO0.

The PC/PPI cable is required when updating the operating system by resetting to factory
settings. You can also use the cable for data transfer. Connect the PC/PPI cable to the
RS 422/RS 485 port. The cable converts the input signals to RS-232 signals.

The cable is not supplied with the HMI device. The cable can be ordered separately under
the order number 6ES7 901-3CB30-0XA0.

Note

If the connection fails during the operating system update, set the system to a lower bit rate.
If you use a higher bit rate, you must use the PC/PPI cable release 3 or higher. The version
code is printed on the cable (e.g., "E-Stand 3" corresponds to version 3).

Protective foil is available for HMI devices with a touch screen. The protective foil is not part
of the scope of delivery of the HMI device.

The protective foil can be ordered with order number 6AV6 574-1AD00-4DXO0.

The protective cover is used to protect the front of the HMI device. It protects both the
display and the frame of the HMI device against dirt, scratches, and chemicals. This also
enables the use of these HMI devices in ambient conditions containing a high percentage of
pollutants.

One set containing 2 protective covers can be ordered with order number
6AV6 574-1AE00-4AX0.

Note
Multimedia card

The multimedia card of the SIMATIC S7 PLC cannot be used.

Only use SD memory cards or MultiMediaCards tested and approved by Siemens AG.
MultimediaCards, for example, can be ordered with order number 6AV6 671-1CB00-0AX2.
SD memory cards, for example, can be ordered with order number 6AV6 671-8XB10-0AX0.
You can find additional information under "http://mall.automation.siemens.com".

MP 177 (WinCC flexible)
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1.4 Configuration and process control phase

1.4 Configuration and process control phase

Introduction
You must follow the phases below in order to use an HMI device in the system:
® (Configuration phase

® Process control phase

Configuration phase

The HMI device project, which includes the plant screens, is created during the configuration
phase.

The following actions are carried out as part of the configuration phase:
® (Creating the project

® Testing the project

e Simulating the project

e Backing up the project

After the configuration phase, the project is transferred to the HMI device by the

configuration PC.
|-

Configuration PC HMI device

MP 177 (WinCC flexible)
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1.5 Functional Scope with WinCC flexible

Process control phase

Once the project is transferred to the HMI device, the operator operates and monitors current
processes in the process control phase. The HMI device is connected to a PLC in the plant
and exchanges values with this PLC. The plant screens on the HMI devices are used to

provide a clear overview of the active processes.

o]

HMI device

o

WinAC MP

HMI device

with software PLC Distributed 1/0

1.5 Functional Scope with WinCC flexible

The following tables show the objects that can be integrated in a project for an MP 177.

Alarms
Object Specification MP 177
Alarms Number of discrete alarms 2.000
Number of analog alarms 50
Length of the alarm text 80 characters
Number of tags in an alarm Max. 8
Display Alarm window, alarm view
Acknowledge error alarm individually Yes
Acknowledge multiple error alarms simultaneously 16 acknowledgment
(group acknowledgement) groups
Edit alarm Yes
Alarm indicator Yes
Alarm buffer, retentive Alarm buffer capacity 256 alarms
Simultaneously queued alarm events Max. 64
View alarm Yes
Delete alarm buffer Yes
Print alarms line by line Yes

MP 177 (WIinCC flexible)
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1.5 Functional Scope with WinCC flexible

Tags, values and lists

Object Specification MP 177
Tags Number 1.000
Limit value monitoring Input/Output Yes
Linear scaling Input/Output Yes
Text lists Number 300
Screens
Object Specification MP 177
Screens Number 500
Fields per screen 50
Tags per screen 50
Complex objects per screen (e.g. bars) 5
Template Yes
Recipes
The specified values are maximum values and should not be used as additive.
Object Specification MP 177
Recipes Number 100
Data records per recipe 200
Entries per recipe 200
Memory location e Memory card
e USB memory stick "
e Network drive
1 The number of recipe data records might be restricted by the capacity of the storage medium.
Safety
Object Specification MP 177
Safety Number of user groups 50
Number of users 50
Number of authorizations 32

MP 177 (WIinCC flexible)
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1.6 Software Options
Infotexts
Object Specification MP 177
Infotexts Length (no. of characters) 320
(depending on font)
For alarms Yes
For screens Yes
For screen objects (for example for 1/O field, switch, Yes
button, invisible button)
Additional functions
Object Specification MP 177
Screen settings Touch screen calibration Yes
Brightness setting Yes
Language change Number of languages 5
Graphic objects Vector and pixel graphics Yes
Trend views Number 50
Trends per view Number 8
Task planner Number of tasks 10
Text objects Number 2.500
Direct keys Yes
1.6 Software Options
The following software options are available for the MP 177:
® WinCC flexible/Sm@rtService
The Sm@rtService option enables you to access a remote HMI device from the HMI
device or PC via Ethernet.
o WinCC flexible/Sm@rtAccess
The Sm@rtAccess option enables you to set up communication between different HMI
systems.
e WinAC MP
WInAC MP is a software PLC. WinAC MP as of version WinAC MP 2008 can run on the
MP 177.
e Uninterruptible Power Supply (UPS) with USB support
The option "Uninterruptible Power Supply (UPS) with USB support" supports the
connection of an uninterruptible power supply. In the event of a power failure, the HMI
device is shut down in a controlled manner after a buffer time. The MP 177 supports
SITOP DC UPS modules connected via the USB port.
MP 177 (WinCC flexible)
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1.7

Communications

Number of connections

PLCs

1.7 Communications

Connection

MP 177

Number using a bus connection

Number of connections based on "SIMATIC HMI HTTP Protocol"

Note

In the following cases, you may not enable PROFINET 10 in the Control Panel of the HMI

device:

e Use of PLCs from other manufacturers
e Use of SIMATIC 500/505 via NITP

The following table shows the PLCs which can be used with the HMI devices and the
protocols or profiles which can be used.

Goldstar) / IMO

series G4, G6 and G7
e Dedicated communication ©)7)

PLC Protocol MP 177
SIMATIC S7 e PPI Yes
e MPI M
¢ PROFIBUS DP
e TCP/IP (Ethernet)
SIMATIC S5 e PROFIBUS DP Yes
SIMATIC 500/505 e NITP Yes
¢ PROFIBUS DP
SIMATIC HMI HTTP Protocol |e HTTP/HTTPS (Ethernet) Yes
Allen-Bradley PLC series SLC500, SLC501, SLC502, SLC503, Yes
SLC504, SLC505, MicroLogix and PLC5/11,
PLC5/20, PLC5/30, PLC5/40, PLC5/60, PLC5/80,
MicroLogix
e DF1256)7)
e DH+ via KF2 module 3) 56 7)
e DH485 via KF3 module 46 7)
e DH4854%
ControlLogix 5500, CompactLogix 5300
e Allen-Bradley E/IP C.Logix (Ethernet IP)
GE Fanuc Automation PLC series 90-30, 90-70, VersaMax Micro Yes
e SNPO&7
LG Industrial Systems (Lucky | PLC series GLOFA GM (GM4, GM6 and GM7) / Yes

MP 177 (WinCC flexible)
Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0
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1.7 Communications

See also

24

PLC Protocol MP 177
Mitsubishi Electric PLC series MELSEC FX and MELSEC FX0 Yes
e FX67)
Mitsubishi Electric PLC series MELSEC FXO0, FX1n, FX2n, AnA, AnN, Yes
AnS, AnU, QnA and QnAS
e Protocol 48 7)
OMRON PLC series SYSMAC C, SYSMAC CV, SYSMAC Yes
CS1, SYSMAC alpha and CP
e Hostlink/Multilink (SYSMAC Way) 6 7)
Modicon PLC series Modicon 984, TSX Quantum and TSX Yes
(Schneider Automation) Compact
e Modbus RTU 987
PLC series Quantum, Momentum, Premium and
Micro
PLC series Compact and 984 via Ethernet bridge
e Modbus TCP/IP (Ethernet)
Telemechanique TSX 7 with P47 411, TSX 7 with P47/67/87/107 Yes
420, TSX 7 with P47/67/87/107 425, module TSX
SCM 21.6 with the specified TSX 7 CPUs, TSX 17
with module SCG 1161, TSX 37 (Micro), TSX 57
(Premium)
e Uni-Telway®7
R Not possible when connected to S7-212.
2) Applies to controllers SLC503, SLC504, SLC505, PLC5, MicroLogix.
3) Applies to controllers SLC504, PLC5 over DF1.
4) Applies to controllers SLC500 to SLC 505 and MicroLogix.
5) Only with converter RS 422-RS 232 6AV6 671-8XE00-0AX0 (option).
6) PROFINET IO must be locked.
7) Deactivate the "Remote Control" check box in the "Transfer Settings" under "Channel 1."

Enabling PROFINET IO (Page 91)

MP 177 (WinCC flexible)
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2.1 Safety Instructions

Working on the control cabinet

A WArRNING

Open equipment

The HMI device is an open equipment. This means that the HMI device may only be
mounted in housings or cabinets, whereby the device can be operated from the front panel.

Access to the housing or cabinet in which the HMI device is installed should only be
possible by means of a key or tool and only for trained and authorized personnel.

Dangerous voltage
Opening the cabinet will expose high voltage parts. Contact with these parts could be fatal.

Switch off the power supply to the cabinet before opening it.

Hazardous areas

When operating the HMI device in hazardous areas the following warning applies.

AWARNING

Explosion Hazard

Do not disconnect while circuit is live unless area is known to be non-hazardous.
Substitution of components may impair suitability for Class |, Division 2 or Zone 2.

High frequency radiation

NOTICE

Unintentional operating situations

High-frequency radiation, for example from cellular phones, can lead to undesirable
operating situations.

Proper use

A WArRNING

Commissioning of the HMI device is forbidden until it has been absolutely ensured that the
machine in which the HMI device is to be installed complies with Directive 98/37/EC or
Directive 2006/42/EC as of 29 December 2009.

MP 177 (WIinCC flexible)
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2.2 Standards, Certificates and Approvals

2.2 Standards, Certificates and Approvals

Certifications

CE approval

UL approval

26

A\ crution

The following overview shows possible approvals.

The HMI device itself is certified as shown on the rear panel labels.

C€

The HMI device meets the general and safety-related requirements of the following EC
directives and conforms to the harmonized European standards (EN) for programmable logic
controllers published in the official gazettes of the European Union:

® 2004/108/EC Electromagnetic Compatibility Directive (EMC Directive)

® 2006/95/EC "Electrical equipment for use within specific voltage limits" (Low-Voltage
Directive)

EC Declaration of Conformity

The EC Declarations of Conformity are available to the relevant authorities at the following
address:

Siemens AG
Industry Sector
[IAAS RD ST PLC
P.O. Box 1963
D-92209 Amberg

Underwriters Laboratories Inc., to
e UL 508 (Industrial Control Equipment)
® (CSA C22.2 No. 142 (Process Control Equipment)

or

MP 177 (WinCC flexible)
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FM Approval

2.2 Standards, Certificates and Approvals

Underwriters Laboratories Inc., to

e UL 508 (Industrial Control Equipment)

® (CSA C22.2 No. 142 (Process Control Equipment)
e UL 1604 (Hazardous Location)

® (CSA-213 (Hazardous Location)

Approved for use in

® C(Class I, Division 2, Group A, B, C, D or

® C(Class I, Zone 2, Group IIC or

® non-hazardous locations

APPROVED
Factory Mutual Research (FM) conforming to
® Approval Standard Class Number 3611, 3600, 3810
Approved for use in
e (lass I, Division 2, Group A, B, C, D T4
® (Class |, Zone 2, Group lIC T4

Marking for Australia

IEC 61131

0 N11/

The HMI device fulfills the requirements of standard AS/NZS 2064 (Class A).

The HMI device satisfies the requirements and criteria conforming to IEC 61131-2,
Programmable Logic Controllers, Part 2: Equipment requirements and tests.

MP 177 (WinCC flexible)
Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0
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2.3 Notes about Usage

2.3 Notes about Usage

Use in industry

The HMI device is designed for industrial use, limit class A. For this reason, the following
standards are met:

® Requirements for emissions EN 61000-6-4: 2007
® Requirements for interference immunity DIN EN 61000-6-2: 2005

Note
Residential use

The HMI device is not suitable for use in residential areas: If you use the HMI device in
residential areas, the radio/TV reception may be impeded.

If you operate the HMI device in a residential area, you must take measures to achieve Limit
Class B conforming to EN 55011 for RF interference.

Suitable measures for achieving the required RF interference level for Limit Class B include
for example:

® |nstallation of the HMI device in grounded control cabinets
® Use of filters in electrical supply lines

Individual acceptance is also required.

24 Electromagnetic Compatibility

Introduction

The HMI device fulfills requirements of the EMC directive of the domestic European market
and other requirements.

EMC-compliant installation of the HMI device

The EMC-compliant installation of the HMI device and the application of interference-proof
cable is the basis for interference-free operation. The "Directives for interference-free
installation of PLCs" and the "PROFIBUS Networks" manual also apply for the installation of
the HMI device.

Pulse-shaped interference

28

The following table shows the electromagnetic compatibility of modules with regard to pulse-
shaped interference. This requires the HMI device to meet the specifications and directives
for electrical installation.

MP 177 (WinCC flexible)
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2.4 Electromagnetic Compatibility

Pulse-shaped interference Test voltage Degree of
severity

Electrostatic discharge Air discharge: 8 kV 3

in accordance with IEC 61000-4-2 | Contact discharge: 6 kV

Bursts 2 kV power supply cable 3

(high-speed transient 2 kV signal cable, > 30 m

interference) 1 kV signal cable, <30 m

in accordance with IEC 61000-4-4

High-power surge pulses in accordance with IEC 61000-4-5, external protective circuit required
(refer to the manual Automation System S7-300, Installation, "Lightning and overvoltage protection”
section)

Asymmetrical coupling 2 kV power cable 3
DC voltage with protective elements
2 kV signal/data cable, > 30 m,

with protective elements as required

Symmetrical coupling 1 kV power cable 3
DC voltage with protective elements
1 KV signal cable, > 30 m,

with protective elements as required

Sinusoidal interference

The following table shows the EMC behavior of the modules with respect to sinusoidal
interference. This requires the HMI device to meet the specifications and directives for
electrical installation.

Sinusoidal interference Test values Degree of
severity

HF radiation (in electromagnetic | 80% amplitude modulation at 1 kHz 3

fields) in accordance with with 10 V/m in the range of 80 MHz to 1 GHz

IEC 61000-4-3 with 3 V/m in the range 1.4 GHz to 2 GHz

with 1 V/m the range 2 GHz to 2.7 GHz

¢ 10 V/m with 50% pulse modulation at 900 MHz
10 V/m with 50% pulse modulation at 1.89 GHz

HF conductance on cables and Test voltage 10 V, with 80% amplitude modulation 3
cable shields in accordance with | of 1 kHz in the 10 kHz to 80 MHz range
IEC 61000-4-6

Emission of radio interference

The following table shows the unwanted emissions from electromagnetic fields in
accordance with EN 55011, Limit Value Class A, Group 1, measured at a distance of 10 m.

from 30 to 230 MHz <40 dB (V/m) quasi-peak
from 230 to 1000 MHz <47 dB (V/m) quasi-peak

Additional measures

Before you connect an HMI device to the public network, ensure that it is compliant with Limit
Value Class B in accordance with EN 55022.

MP 177 (WinCC flexible)
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2.5 Transport and Storage Conditions

2.5 Transport and Storage Conditions

Mechanical and climatic transport and storage conditions

30

The transportation and storage conditions of this HMI device exceed requirements in
accordance with IEC 61131-2. The following specifications apply to the transportation and
storage of an HMI device in its original packaging.

The climatic conditions comply with the following standards:

e |EC 60721-3-3, Class 3K7 for storage

e |EC 60721-3-2, Class 2K4 for transportation

The mechanical conditions correspond to IEC 60721-3-2, Class 2M2.

Type of condition Permitted range
Drop test (in transport package) <1m
Temperature From -20 to +70 °C
Atmospheric pressure From 1080 hPa to 660 hPa,
corresponds to an elevation of —1,000 to 3,500 m
Relative humidity From 10 % to 90 %, without condensation
Sinusoidal vibration in accordance with 51t08.4 Hz: 3.5 mm
IEC 60068-2-6 8.4 to 500 Hz: 9.8 m/s?
Shock in accordance with IEC 60068-2-29 250 m/s2, 6 ms, 1000 shocks

NOTICE

Ensure that no condensation (dewing) develops on or inside the HMI device after
transporting it at low temperatures or after it has been exposed to extreme temperature
fluctuations.

The HMI device must have acquired room temperature before it is put into operation. Do
not expose the HMI device to direct radiation from a heater in order to warm it up. If dewing
has developed, wait approximately 4 hours until the HMI device has dried completely
before switching it on.

Proper transport and storage, installation and assembly as well as careful operation and
maintenance are required to ensure trouble-free and safe operation of the HMI device.

The warranty for the HMI device will be deemed void if these stipulations are not heeded.

MP 177 (WinCC flexible)
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3.1 Mounting Information

Mechanical and climatic conditions of use

The HMI device is designed for use in a location protected from the effects of the weather.

The conditions of use are compliant with requirements to DIN IEC 60721-3-3:

® (Class 3M3 (mechanical requirements)

® (Class 3K3 (climatic requirements)

Use with additional measures

The HMI device should not be used at the following locations unless additional measures are

taken:

® |n locations with a high degree of ionizing radiation

® |n locations with difficult operating conditions - for example due to:

— Corrosive vapors, gases, oils or chemicals

— Electrical or magnetic fields of high intensity

® |n systems that require special monitoring - for example:

— Elevators

— Systems in especially hazardous rooms

Mechanical ambient conditions

The mechanical ambient conditions for the HMI device are specified in the following table in
terms of sinusoidal vibration.

Frequency range in
Hz

Constant

Occasional

10=f<58

Amplitude 0,0375 mm

Amplitude 0,075 mm

58 < f< 150

Constant acceleration 0.5 g

Constant acceleration 1 g

Reducing vibrations

If the HMI device is subjected to greater shocks or vibrations, you must take appropriate

measures to reduce acceleration or amplitudes.

We recommend fitting the HMI device to vibration-absorbent material (on metal shock
absorbers, for example).

MP 177 (WIinCC flexible)
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3.1 Mounting Information

Testing mechanical ambient conditions

The following table provides information on the type and scope of tests for mechanical
ambient conditions.

Tested for Test standard Comments

Vibrations Vibration test in accordance with Type of vibration:

IEC 60068, part 2-6 (sinusoidal) Transitional rate of the frequency:

1 octave/minute.

10 = f < 58,

constant amplitude 0.075 mm

58 <f< 150,

Constant acceleration 1 g

Vibration duration:

10 frequency cycles per axis in each
of the three mutually vertical axes

Shock Shock testing in accordance with Type of shock: half-sine

IEC 60068, Part 2 -29 Shock intensity:

Peak value 5 g, duration 11 ms

Direction of impact:
3 shocks in * direction in each of the
three mutually vertical axes

Climatic ambient conditions

The following table shows the climatic environmental conditions under which the HMI device
can be operated.

Ambient conditions Permitted range Comments
Temperature See section "Mounting Positions
e Vertical mounting From 0 to 50° C and Type of Fixation (Page 33)."
e Mounting at an angle |From 0to40°C
Relative humidity 10 to 90 %, without condensation
Atmospheric pressure 1.080 to 795 hPa Corresponds to an elevation of —
1,000 to 2,000 m
Pollutant concentration | SO2: < 0.5 ppm; Check: 10 cm3/m3; 10 days
Relative humidity < 60%, no
condensation
H2S: < 0,1 ppm; Check: 1 cm3/m3; 10 days
Relative humidity < 60%, no
condensation

MP 177 (WinCC flexible)
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3.2 Mounting Positions and Type of Fixation

3.2 Mounting Positions and Type of Fixation

Mounting position
The HMI device is suitable for installation in:
® Mounting cabinets
® Control cabinets
e Control boards
e Consoles

In the following, all of these mounting options are referred to by the general term "cabinet".

The HMI device is self-ventilated and approved for vertical and inclined mounting in
stationary cabinets.

Mounting position Deviation from the vertical
@ Inclined <35°
® Vertical 0°

A\ crution

Impermissible ambient temperatures

Do not operate the HMI device without auxiliary ventilation if the maximum permissible
ambient temperature is exceeded. The HMI device may otherwise get damaged and its
approvals and warranty will be void!

MP 177 (WinCC flexible)
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3.3 Preparing for Mounting

Mounting

Metal mounting clamps are provided for mounting. The mounting clamps hook into oblong
holes on the HMI device.

—®

@ Threaded stud
® Hook

3.3 Preparing for Mounting

Select the mounting location of the HMI device
Points to observe when selecting the mounting location:
e Position the HMI device so that it is not subjected to direct sunlight.

® Position the HMI device such that it is ergonomically accessible for the user. Choose a
suitable mounting height.

e Ensure that the air vents of the HMI device are not covered as a result of the mounting.
® Observe the permissible mounting positions for the HMI device.

Degrees of protection

The degrees of protection are only guaranteed when the following is observed for the
mounting cut-out:

® Thickness of material at the mounting cut-out for protection classes IP65 or
NEMA 4X/NEMA 12 (indoor use only):
3 mmto 6 mm

® Permitted deviation from plane at the mounting cut-out: < 0,5 mm
This condition must be fulfilled for the mounted HMI device.

® Permissible surface roughness in the area of the seal: < 120 um (Rz 120)

Dimensions of the mounting cut-out

The following table shows the dimensions of the mounting cut-out required.

Mounting cut-out MP 177
Width 1971 mm
Height 141*" mm
Depth 45 mm

MP 177 (WinCC flexible)
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3.4 Specifications for Insulation Tests, Protection Class and Degree of Profection

Note

You can use an MP 177 in the mounting cut-out of the following HMI devices:

o TPA177A
e TP177B 6"
o TP 277

Maintaining clearances

The HMI device must be installed with the following clearances:

® 50 mm above and below the mounting cut-out for ventilation

e 15 mm to the right and left of the mounting cut-out for inserting the mounting clamps for

installation

® At least 10 mm clearance in addition to the mounting cut-out of the HMI device is required

at the rear

NOTICE

Ensure that the maximum ambient temperature is not exceeded when mounting the
device in a cabinet and especially in a closed enclosure.

3.4 Specifications for Insulation Tests, Protection Class and Degree of

Protection

Test voltages

Insulation strength is demonstrated in the type test with the following test voltages in

accordance with IEC 61131-2:

Circuits with a nominal voltage of Ue to other
circuits or ground

Test voltage

<50V

500 VDC

Protection class

Protection Class | in accordance with IEC 60536, i.e. PE/ground terminal to profile rail

required.

MP 177 (WinCC flexible)
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Planning application

3.5 Rated voltages

Protection against foreign objects and water

Degree of protection in accordance with Description
IEC 60529
Front When mounted:
o |P65
o NEMA 4X/NEMA 12 (indoor use only)
Rear IP20
Protection against touch with standard test fingers.
There is no protection against ingress by water.

The degree of protection provided by the front can only be guaranteed when the mounting
seal lies completely against the mounting cut-out.

3.5 Rated voltages

The following table shows the rated voltage and the corresponding tolerance range.

Nominal voltage Tolerance range

+24 VDC 19.2 V t0 28.8 V (=20 %, +20 %)
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Mounting and connecting

4.1

Checking the Package Contents

Check the package content for visible signs of transport damage and for completeness.

4

NOTICE

Do not install parts damaged during shipment. In the case of damaged parts, contact your
Siemens representative.

The following is supplied:
e HMI device
® Accessory kit
The accessory kit contains the following:
— 1 terminal block for the power supply
— Mounting clamps for installation
Additional documents may be enclosed with the accessory kit.

The documentation belongs to the HMI device and is required for subsequent
commissioning. Retain all enclosed documentation for the entire service life of the HMI
device. You must pass on the enclosed documentation to any subsequent owner or user of
the HMI device. Make sure that every supplement to the documentation that you receive is
stored together with the operating instructions.

MP 177 (WinCC flexible)
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Mounting and connecting

4.2 Mounting the HMI Device

4.2 Mounting the HMI Device

Requirement

All packaging components and protective foils should be removed from the HMI device.

To install the HMI device, you need the mounting clamps from the accessories. The
mounting seal must be fitted on the HMI device. If the mounting seal is damaged, order a
replacement seal. The mounting seal is part of the associated service pack.

To ensure the necessary degree of protection on the HMI device, the positions listed below
must be observed for the mounting clamps.

Positions of the mounting clamps on the MP 177

In total, you will need 7 mounting clamps for the installation.

The following figure shows the counting direction for the insertion of the mounting clamps.

| >

N N

The following table shows the positions of the mounting clamps on the MP 177. Please note
the counting direction. The position indicated corresponds to the first oblong hole occupied
for each mounting clamp in the counting direction. The inserted mounting clamp covers
several oblong holes.

Page Number of mounting Mounting clamp Mounting clamp Mounting clamp
clamps position 1 position 2 position 3

Top 3 1 13 24

Right 2 1 8 -

Bottom No mounting clamp necessary.

Left 2 2 15 -

MP 177 (WinCC flexible)

38 Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0




Mounting and connecting
4.2 Mounting the HM/ Device

Procedure - Mounting the HMI device

NOTICE

Installation of the HMI device

Always mount the HMI device according to the instructions in this manual.
Risk of guaranteed level of protection not being met

If the mounting seal is damaged or protrudes beyond the HMI device, the level of protection
is not ensured.

Check the fit of the mounting seal.

Note

Tighten the set screws of the mounting clamps until the HMI device is flush with the surface
of the control cabinet. Alternatively, tighten the mounting clamps using a maximum torque of
0.2 Nm.

Proceed as follows:
1. Check that the mounting seal is fitted on the HMI device.

Do not install the mounting seal turned inside out. This may cause leaks in the mounting
cut-out.

2. Insert the HMI device into the mounting cut-out from the front.

3. Insert a mounting clamp into the cut-out provided on the HMI device.

(=

4. Fasten the mounting clamp by ® tightening the set screw @.
5. Repeat steps 3 and 4 for all the required mounting clamps.
6. Check the fit of the mounting seal.

If necessary, repeat steps 1 to 5.
Result

The HMI device is mounted and the relevant level of protection is ensured at the front.

MP 177 (WinCC flexible)
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4.3 Connecting the HMI device

4.3 Connecting the HMI device

431 Overview

Requirement

® The HMI device must be mounted according to the specifications of these operating
instructions.

® Always use shielded standard cables.

You can find more information on the Internet at "http://mall.automation.siemens.com".

Connection sequence
Connect the HMI device in the following sequence:
1. Equipotential bonding
2. Power supply

Perform a power-up test to ensure the power supply is connected with the correct
polarity.

3. PLC
4. Configuring PC as necessary

5. 1/Os as necessary

NOTICE

Connection sequence

Always follow the correct sequence for connecting the HMI device. Failure to do so may
result in damage to the HMI device.

Disconnect the HMI device by completing the above steps in reverse order.

Connecting the cables

When connecting the cables, ensure that the contact pins are not bent. Secure the
connectors with screws.

The pin assignment of the ports is described in the technical specifications.

MP 177 (WinCC flexible)
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Mounting and connecting
4.3 Connecting the HMI device

43.2 Ports
The following figure shows the ports of the MP 177 HMI device.

Chassis terminal for equipotential bonding
Power supply connector

RS 422/RS 485 port X2/ IF 1B
PROFINET interface

USB port

®©® 000

NOTICE
Connecting external devices to the USB port

If you wish to connect external devices with their own power supply to the USB port, ensure
that the installation is non-isolated.

Connect PROFIBUS DP or MPI to the X2 / IF 1B port.

See also
Design of the MP 177 HMI device (Page 16)

Power Supply (Page 204)

RS 422/RS 485 (IF 1B) (Page 204)
USB ((Page 205)

PROFINET (Page 205)

MP 177 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

43.3 Connection of equipotential

Potential differences

Differences in potential between spatially separated system parts may occur. The
differences in potential can lead to high equalizing currents over the data cables and

the

refore to the destruction of their ports. Equalizing currents may arise if the cable shielding

is terminated at both ends and grounded at different system parts.

Differences in potential may develop when a system is connected to different mains
supplies.

General requirements for equipotential bonding

Differences in potential must be reduced by means of equipotential bonding in order to
ensure trouble-free operation of the relevant components of the electronic system. The
following must therefore be observed when installing the equipotential bonding circuit:

The effectiveness of equipotential bonding increases as the impedance of the
equipotential bonding conductor decreases or as its cross-section increases.

If two parts of the system are connected to each other by means of shielded data cables,
and its shielding is connected at both ends with the grounding/protective grounding
conductor, then the impedance of the additionally-laid equipotential bonding may amount
to a maximum of 10% of the screened impedance.

The cross-section of a selected equipotential bonding conductor must be capable of
handling the maximum equalizing current. The best results in practical applications for
equipotential bonding between two cabinets have been achieved with a minimum
conductor cross-section of 16 mm?2.

Use equipotential bonding conductors made of copper or galvanized steel. Establish a
large surface contact between the equipotential bonding conductors and the
grounding/protective conductor and protect these from corrosion.

Clamp the shielding of the data cable on the HMI device flush and near the equipotential
busbar using suitable cable clamps.

Route the equipotential bonding conductor and data cables in parallel with minimum
clearance between these.

NOTICE

Equipotential bonding conductor

Cable shielding is not suitable for equipotential bonding. Always use the prescribed
equipotential bonding conductors. The minimum cross-section of a conductor used for
equipotential bonding is 16 mm?2. When you install MPI and PROFIBUS DP networks,
always use cables with a sufficient cross-section. The interface modules may otherwise
be damaged or destroyed.
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Mounting and connecting

4.3 Connecting the HMI device

Connection graphic

Chassis terminal on the HMI device, example

Equipotential bonding conductor cross-section: 4 mm?2
Switching cabinet

Equipotential bonding conductor cross-section: min. 16 mm?2
Ground connection

Cable clip

Voltage bus

CESNONCNCNONONC)

Parallel routing of the equipotential bonding conductor and data cable

MP 177 (WinCC flexible)
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Mounting and connecting
4.3 Connecting the HMI device

434 Power supply connection

Connection diagram
The following figure shows the connection of the HMI device and the power supply.

~

Note when connecting

The plug-in terminal strip for connecting the power supply is contained in the accessories
pack. The plug-in terminal strip is designed for conductors with a maximum cross-section of
1.5 mm?2.

Connecting the plug-in terminal strip

NOTICE

Damage

Do not tighten the screws of the plug-in terminal strip if the latter is plugged into the HMI
device. The pressure from the screwdriver may otherwise damage the HMI device socket.

Only connect the wires when the plug-in terminal strip is withdrawn.

\\— GND
+24 VDC
Connect the plug-in terminal strip to the cables of the power supply as shown in the figure

above. Ensure that the lines are connected properly to the correct terminals. Refer to the
label for the contact pins on the rear of the HMI device.

MP 177 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

Reverse polarity protection
The HMI device is equipped with a reverse polarity protection circuit.

Connecting the power supply

CAUTION

Safe electrical separation

Use only power supply units with safety isolation complying with IEC 60364-4-41 or
HD 384.04.41 (VDE 0100, Part 410), for example according to the PELV standard, for the
24 VDC supply.

The supply voltage must be within the specified voltage range. Malfunctions in the HMI
device may otherwise result.

Applies to non-isolated system design:

Connect the connection for GND 24 V from the 24 V power supply output to equipotential
bonding for uniform reference potential. For this purpose, choose a connecting point that is
as close as possible to the center.

MP 177 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

4.3.5

Connecting a PLC

Connection diagram

46

The following figure shows the connection of the HMI device and the PLC.

SIMATICS? < PROFINET
PLC
from different e PROFINET (Ethernet/LAN)
manufacturers
SIMATIC S7 —C RS 485
SIMATIC S5 —C RS 265
SIMATIC 500/505 — RS 465
SIMATIC 500/505 —< TYTn
PLC
from different —g
manufacturers RS 422/RS 485
PLC
from different —C — RS 232
manufacturers RS 485
PLC
from different —C — RS 232
manufacturers RS 422
NOTICE

Always use the approved cables to connect a SIMATIC S7 PLC.

Standard cables are available for the connection. You can find more information about this
on the Internet at "http://mall.automation.siemens.com".

MP 177 (WinCC flexible)
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Mounting and connecting
4.3 Connecting the HMI device

Connecting PROFINET

NOTICE
Damage to the HMI device

Only connect the HMI device to public Ethernet networks using a switch or comparable
device.

NOTICE
PROFINET 10 communication

For instructions regarding the installation of PROFINET networks, please refer to the
"PROFINET system description" manual.

Configuring an RS-422/RS-485 port

A DIP switch for the configuration of the RS-422/RS-485 interface is located on the back of
the HMI device.

In the factory state, the DIP switch is set for communication with the SIMATIC S7 PLC via
RS 485.

Note
Note the diagrams of the DIP switch settings on the back of the HMI device.

The following table shows the settings of the DIP switch. The transmitting and receiving
direction is switched internally with the RTS signal.

Communication | Switch setting Meaning
RS 485 4321 No RTS on plug, for data transfer between PLC and HMI
ON device
(factory state)
4321 RTS on pin 4, same as PLC,
ON for example for commissioning
4321 RTS on pin 9, same as programming device,
ON for example for commissioning
RS 422 4321 RS-422 port is active.
on

MP 177 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

4.3.6 Configuration PC connection

Connection diagram
The following figure illustrates the connection between the HMI device and the configuration

PC.
—< USB
—< PROFINET (Ethernet/LAN)
/—— N
—< RS 485
RS 232
—< RS 485

B
g
o

]

The ports are described in the specifications.
For RS-485-RS-232 conversion, you can order the PC/PPI cable from Siemens AG.

Configuring a PC/PPI cable
Use the DIP switches to configure the transfer rate of the PC/PPI cable.

Note

If the connection fails during the operating system update, set the system to a lower bit rate.
If you use a higher bit rate, you must use the PC/PPI cable release 3 or higher. The version
code is printed on the cable (e.g., "E-Stand 3" corresponds to version 3).

@ DIP switch
® LEDs

MP 177 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

Set the DIP switches 1 to 3 to the same value as in WinCC flexible. DIP switches 4 to 8 must
be set to "0".

; PRRAEEEE

12345

® DIP switch

The following bit rates can be set:

Bit rate in Kbps DIP switch 1 DIP switch 2 DIP switch 3
115,2 1 1 0
57,6 1 1 1
38,4 0 0 0
19,2 0 0 1
9,6 0 1 0
4,8 0 1 1
2,4 1 0 0
1,2 1 0 1

In the figure, the bit rate is set to 115.2 Kbps.

Note when connecting

NOTICE

USB connection sequence

Observe the following sequence when connecting by USB:
1. HMI device

2. PC

USB Host-to-Host cable

Use only the driver for the USB host-to-host cable that is included in the WinCC flexible
package. Never use the driver supplied with the USB Host-to-Host cable.

Restoring factory settings

If there is no serviceable HMI device image on the HMI device, you can only update the
operating system by restoring the factory settings. Use the RS-422/485 port with the
PC/PPI cable on the HMI device.

MP 177 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

437 USB device connection

The following devices can be connected to the USB port of the HMI device:

Note
Only use approved devices for connection to the HMI device.

The list of approved or recommended devices you can connect to HMI devices via the USB
port can be found on the Internet at
"http://support.automation.siemens.com/WW/view/en/19188460" and
"http://support.automation.siemens.com/WW/view/en/11376409"

® External mouse

® External keyboard

® Printer

e USB memory stick

® |ndustrial USB Hub 4

® Barcode reader

Note when connecting

NOTICE
Functional problem with USB port

If you connect external devices with their own power supply to the USB port without using
an non-insulated installation, you may experience functional problems.

Ensure a non-insulated installation.

NOTICE
Excessive rated load on port

A USB device with too high a power load may possibly cause functional problems.

Observe the values for the maximum load of the USB interface. You will find the values in
the technical specifications.

See also
USB ((Page 205)
Ports (Page 41)

MP 177 (WinCC flexible)
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Mounting and connecting
4.3 Connecting the HMI device

438 Printer connection

Connection diagram
The following figure shows the connection of the HMI device and the printer.

A printer server is required for connecting a network printer to the HMI device.

n

usB

|

é='—_> PROFINET (Ethernet/LAN)

%

[0 —
] =
]

Note when connecting

NOTICE

Data exchange cables

If you use cables without a metallic netting shield between the HMI device and printer, you
may experience functional problems.

Only use cables with metal-braided shielding grounded at both ends for connecting the HMI
device and printer.

The list of current printers and required settings for HMI devices can be found on the Internet
under "http://support.automation.siemens.com/WW/view/en/11376409".

Observe the supplied printer documentation when you connect the printer.

MP 177 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

4.3.9

Uninterruptible power supply connection

Connection diagram

52

The following figure shows the connection between the uninterruptible power supply and
HMI device. The uninterruptible power supply is connected to the 24-V input and one of the
HMI device's USB ports.

When connected to the HMI device's USB port, the following uninterruptible power supplies
are supported:

e SITOP DC UPS modules as of a rated power value of 6 A, e.g. 6EP1931-2DC42.

Uninterruptible power supply

N 1

el 3H

Note
Observe all the notes relating to connecting a power supply.

MP 177 (WinCC flexible)
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4.4 Swifching on and Testing the HM/I device

44 Switching on and Testing the HMI device

Procedure
Proceed as follows:
1. Switch on the power supply.

The display lights up after power is switched on. A progress bar is displayed during
startup.

If the HMI device does not start, it is possible the wires on the terminal block have been
crossed. Check the connected wires and change the connections. The Loader is
displayed once the operating system has started.

Transfer

Skart

Contraol
Panel

Taskbar

The HMI device automatically switches to "transfer" mode during initial startup under the
following conditions:

— No project is loaded on the device.
— At least one data channel has been configured.

During this process the following dialog appears:

Connecting ko hosk ...

Canecel

2. Press "Cancel" to stop the transfer.

Result

The Loader appears again.

Note

When restarting the system, a project may already be loaded on the HMI device. The system
then skips "Transfer" mode and starts the project.

Use the relevant operating element to close the project.

Refer to your plant documentation to find any additional information on this topic.

MP 177 (WinCC flexible)
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Mounting and connecting

4.4 Swifching on and Testing the HM/ device

Function test

Perform a function test following commissioning. The HMI device is fully functional when one
of the following states is indicated:

® The "Transfer" dialog is displayed.
® The Loader is displayed.

® A project is started.

Switching off the HMI device
Terminate the project at the HMI device before switching it off.
You have the following options for switching off the HMI device:
e Switch off the power supply.
® Disconnect the plug-in terminal strip on the HMI device.

MP 177 (WinCC flexible)
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Operator controls and displays

5.1

MP 177

Front operator controls

0] Display with touch screen

The MP 177 Touch is operated via the touch screen. All operating elements required for
operator input are displayed on the touch screen once the HMI device has started.

Note when operating

See also

NOTICE

Unintentional actions

Do not carry out several operations simultaneously. You may otherwise trigger
unintentional actions.

Always touch only one operating element on the screen.

NOTICE

Damage to the touch screen

Never touch the touch screen with pointed or sharp objects. Avoid applying excessive
pressure to the touch screen with hard objects. Both these will substantially reduce the
useful life of the touch screen and even lead to total failure.

Only use your fingers to operate the touch screen of the HMI device.

Design of the MP 177 HMI device (Page 16)

MP 177 (WinCC flexible)
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Operafor controls and displays
5.2 Using Memory Cards with the HMI Device

5.2 Using Memory Cards with the HMI Device

Introduction
The following can be saved to the memory card of the HMI device:
® Recipes
® QOperating system
e Applications
® Additional specifications

The memory card can be inserted and removed during operation. Do not remove the
memory card while data is being accessed by an application, e.g. during backup or recipe
transfer.

NOTICE
Multimedia cards of SIMATIC S7 can no longer be used

If you format a multimedia card for the SIMATIC S7 in the HMI device, you can no longer
use this multimedia card in the SIMATIC S7.

Only use multimedia cards that are suitable for the HMI device. You can find additional
information on this under "http://mall.automation.siemens.com"”.

Procedure for inserting a memory card
Proceed as follows:
Insert the memory card into the memory card slot.

¢

When inserting the memory card, please note that it can only be inserted as shown in the
diagram. The memory card is inserted correctly in the memory card slot when the card lock
engages.

MP 177 (WinCC flexible)
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Operafor controls and displays
5.2 Using Memory Cards with the HM/I Device

Using a memory card for the first time

NOTICE
Data loss

If the HMI device asks you to perform formatting the first time you use a memory card, back
up any existing data on the memory card first.

Proceed as follows in order to prevent data loss:
1. Cancel the formatting procedure by pressing "ESC".

. Remove the memory card from the HMI device.

2
3. Save a backup copy of vital data, for example, to a PC.
4. Insert the memory card into the HMI device.

5

. Format the memory card on the HMI device.

Procedure for ejecting a memory card

NOTICE

Data loss

The data on the memory card may be lost if you attempt to remove it while the HMI device
is accessing its data.

Do not remove the memory card while data is being accessed. Observe the corresponding
alarms on the screen.

0] Eject button

MP 177 (WinCC flexible)
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5.2 Using Memory Cards with the HMI Device

58

Proceed as follows:
1. Press the ejection button.

This ejects the memory card out of the slot.

NOTICE

Do not force the ejector, as this could damage the eject mechanism.

2. Store the memory card in a safe place.

MP 177 (WinCC flexible)
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Configuring the operating system

6.1 Loader

Overview

The following figure shows the Loader. The header line contains details of the loader
version. These details are not shown in the following figure.

Transfer

Skart

Contraol
Panel

Taskbar

The Loader buttons have the following functions:
® Press the "Transfer" button to set the HMI device to "Transfer" mode.

The transfer mode can only be activated when at least one data channel has been
enabled for the transfer.

® Press the "Start" button to start the project on the HMI device.

If you do not perform an operation, the project on the HMI device will automatically start
after a delay.

® Press the "Control Panel" button to open the HMI device Control Panel.
You can change various settings in the Control Panel, for example, the transfer settings.

® Press the "Taskbar" button to activate the taskbar with the Windows CE start menu open.

MP 177 (WinCC flexible)
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Configuring the operating system

6.1 Loader

My TaskBar
Computer

ﬂ Transfer

Recycle Bin

Skark

L= Conkral
Parel

seCLre mode

Taskbar

Open Loader
The following options are available to open the Loader:
® The Loader appears briefly after starting the HMI device.
® The Loader appears when the project is closed.
If configured, use the relevant operating element to close the project.

For further information on this, refer to your plant documentation.

Protection against unauthorized use
You can protect the Control Panel against unauthorized access by using a password.

You can also protect the taskbar and the Desktop with the help of the SecureMode. If the
HMI device is protected, this is indicated in the Windows-CE Desktop by the wording "secure
mode." Additional information on SecureMode is available in the section "Setting up and
canceling secure mode (Page 61)."

The "Transfer" and "Start" buttons can always be used without having to enter a password.

Password protection prevents maloperation. This in turn increases security on the plant or
machine. Settings for the active project can only be changed by entering the password.

NOTICE

Loss of data possible

If the password is no longer available, you can only cancel password protection by

"resetting the factory settings." All data on the HMI device will be deleted when "resetting to
factory settings."

Back up the HMI device's data.

MP 177 (WinCC flexible)
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Configuring the operating system

6.2 Setting up and canceling secure mode

See also
Setting up and canceling secure mode (Page 61)
Changing password protection (Page 73)
Configuring the data channel (Page 93)

6.2 Setting up and canceling secure mode

Overview

You can protect the Control Panel against unauthorized access with a password. You can
also protect the taskbar and the Desktop with the help of the SecureMode.

Function of SecureMode

You set up SecureMode by setting up a password in the Control Panel. SecureMode is then
automatically activated. The wording "secure mode" is displayed in the Windows-CE
Desktop.

Additional information on passwords can be found in the section "Changing password
protection (Page 73)."

If you now want to use a function on the taskbar or Desktop, you have to enter the password.
When you have entered the password, the wording "secure mode" is no longer displayed. All

the functions of the taskbar and Desktop can now be used freely. To reactivate SecureMode,

double-click the g icon on the Desktop. The wording "secure mode" is displayed again and

the HMI device is protected once again.

Canceling SecureMode

To completely cancel SecureMode, delete the password.

See also
Changing password protection (Page 73)
Loader (Page 59)

MP 177 (WinCC flexible)
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6.3 Control Panel

6.3

6.3.1

62

Control Panel

Overview

The HMI device's Control Panel is similar to the control panel on a PC.

The Control Panel looks like this:

File View

@ = B

;Eackupfﬂezt Certificates DatefTime  InputPanel  Kevboard

.............. are ...

@ =3 /l) B @

o =
Metwork and MNetwork ID Passvword Printer
Dial-up Co...

H @ &8 L I

1 La®

Regional  S7-Transfer ScreenSaver  System Transfer
Settings Settings

o E

iR C

Internet

Settings

2]

MoLse

i

PROFIMET

[» ]

<

The control panel can be used to modify the following settings:

® Date and time

® Screen saver

® Regional settings
® Transfer settings
® Network settings
® Delay time

e Password

MP 177 (WIinCC flexible)
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Configuring the operating system

6.3 Control Panel

6.3.2 Opening the Control Panel

Introduction
The HMI device Control Panel can be opened as follows:
® Independently of a running project
— Press the "Control Panel" button of the Loader.
— By calling up from the Windows CE start menu.
e \With active project
An operating element must be configured to open the Control Panel for this purpose.

Procedure for opening the Control Panel via the Start menu
Proceed as follows:

1. Open the Windows CE start menu. Alternatively, press the key twice on the

alphanumerical screen keyboard.

2. Select "Settings > Control Panel."

Result
The Control Panel is open.

6.3.3 Reference for functions

Overview of functions
The following table shows the settings in the Control Panel.

Symbol Functions

@ Saving to external storage device (backup) (Page 107)
Restoring from external storage device (Page 109)

S Importing and deleting certificates|(Page 106)

paq Setting the date and time (Page 74)

Configuring the screen keyboard (Page 67)

Setting the character repeat (Page 68)

%) Setting the double-click (Page 70)

MP 177 (WinCC flexible)
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See also

64

Symbol Functions
e Changing the network configuration (Page 102)
=~ e IP address

e Name server

1L

o Changing the logon data (Page 104)

Backup registry information (Page 77)

Changing monitor settings (Page 79)

Displaying information about the HMI device (Page 84)

Restarting the HMI device (Page 82)

Calibrating the touch screen (Page 71)

Activate memory management (Page 86)

Changing password protection (Page 73)

Changing the printer properties (Page 81)

Enabling PROFINET 10 (Page 91)

Changing regional settings (Page 76)
e Number format

e Currency

Changing the time format

e Date format

O & | @B

Changing MPI/PROFIBUS DP settings (Page 96)

Setting the screen saver (Page 79)

I8 &

e Screen saver
¢ Reducing screen backlighting

Displaying system properties (Page 85)

®

Displaying memory distribution (Page 86)

Setting the device name of the HMI device (Page 100)

L] Configuring the data channel (Page 93)
Lo Setting the delay time (Page 89)

bhs Setting storage location (Page 88)

r—'" Changing e-mail settings (Page 105)|"

R Additional tabs may appear in the "WinCC flexible Internet Settings" dialog. This depends on

the options that have been enabled for network operation in the project.

Setting the uninterruptible power supply (Page 90)

MP 177 (WIinCC flexible)
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6.3.4 Operating the Control Panel

6.3.4.1 Operator control options for the Control Panel

Entries using the touch screen

The operating elements shown in the dialogs are touch-sensitive. Touch objects are
basically operated in the same way as mechanical keys. You activate operating elements by
touching them with your finger. To double-click them, touch an operating element twice in
succession.

Entries using an external USB keyboard

An external keyboard can be used to operate the Control Panel in exactly the same way as
the HMI device keyboard. Use the keys of the external keyboard which correspond to the
HMI device keys in the description.

Operating using an external USB mouse

An external mouse can be used to operate the Control Panel in exactly the same way as the
HMI device touch screen. Click the described operating elements with the mouse.

6.3.4.2 Operating the Control Panel with the touch screen

Introduction
The Control Panel is operated with the HMI device touch screen or a connected mouse.

Requirement
An active project has been terminated. The Loader is displayed.

Procedure

Proceed as follows to change settings in the Control Panel:

1. Open the Control Panel with the "Control Panel" button.

2. To open the required dialog, double-click its icon.

3. Change the tab as required.

4. Make the necessary changes.
Touch the corresponding input object.
— Use the screen keyboard of the HMI device to enter the new values in the text boxes.
— Touch a button to operate it.

— Touch the selection box to open a drop down list box. Touch the required entry from
the drop down list box.

— Touch the check box to select or clear a check box.

— Touch a radio button to select it.

MP 177 (WinCC flexible)
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5. Confirm the entries using the button or terminate the entries using the button .

The dialog closes.

6. Close the Control Panel with the "“ button.
The Loader is displayed.

Input with the screen keyboard

A screen keyboard is available for data input. The screen keyboard is displayed as soon as
you touch a text box. You can also call up the screen keyboard directly from the
Control Panel.

Display methods for the screen keyboard

You can change the display method for the screen keyboard and fix the position on the
screen. Confirm an entry using the key or terminate the entry using the key . Either
action closes the screen keyboard.

® Numerical screen keyboard

7]8 9| [l=]

41 5| 6 [Num -

1| 2| 3 |—»|ESC

0| - . | =

® Alphanumerical screen keyboard

“[1]2]3[als|e]7]s]olo]-]=][E "1
Murdl g [w|e|r |ty |lulilo|lp|[]]]|o]|+
tlals|d|flg|h|ij|[k|I]|;]"]|=]|*|EC
col| v |z |[x|c|v|b|n|im|,|.|/|*|+]|>

The alphanumerical keyboard is organized in the following two layers:
— Normal level
— Shift level

® Reduced screen keyboard

#= [l

MP 177 (WinCC flexible)
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Changing the display of the screen keyboard

Functions

Switching between the numerical and alphanumerical keyboard

Switching between the normal level and Shift level of the alphanumerical screen
keyboard

Switching from full display to reduced display

Switching from reduced display to full display

Closing the screen keyboard in the reduced display

M[E 0| =@k

See also
Configuring the screen keyboard (Page 67)

6.3.5 Changing settings for operation

6.3.5.1 Configuring the screen keyboard

Introduction

You can set the screen position and type of display in which the screen keyboard is opened.

Requirements

You have opened the "Siemens HMI Input Panel - Options" dialog with the "InputPanel" f

icon.

Siemens HMI Input Panel - Options m

Position and Size

Currently closed...

| Open Input Panel : @

Save current size and position...

‘ Save : @

® Button for displaying the screen keyboard
® Button for saving the screen keyboard settings

MP 177 (WinCC flexible)
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Procedure
Proceed as follows:
1. Use the "Open Input Panel" button to open the screen keyboard.

2. If you want to switch between the numeric and alphanumeric screen keyboard, press

the key.

3. If you want to change the position of the screen keyboard, use the mouse pointer to
select a free space between the keys.

Move the screen keyboard to the required position and release the mouse pointer when
the required position has been reached.

4. If you want to save the settings, press the "Save" button.
5. Confirm your entries.

The dialog closes.

Result
The screen keyboard settings have been modified.

See also
Operating the Control Panel with the touch screen (Page 65)

6.3.5.2 Setting the character repeat

Introduction

The details provided below will explain how to set the character repetition and the associated
delay for the screen keyboard.

MP 177 (WinCC flexible)
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Requirement

You have opened the "Keyboard Properties" dialog with the "Keyboard" @ icon.

Fepeat |

( Enable character repeaté)

Feteat delay:
Short

Lon?
@ Repeat rate:

Slowe Fast

Tap here and hulg down a key to test:

bbb

Check box for selecting the character repeat

Slider control and buttons for the delay time
before character repeat

Slider control and buttons for the rate of the
character repeat

® ©® 006

Test box

Procedure
Proceed as follows:
1. If you want to enable character repetition, select the "Enable character repeat" check box.
2. If you want to change the delay, press a button or the slider in the "Repeat delay" group.

Moving the slider to the right will shorten the delay. Moving to the left will extend the
delay.

3. If you want to change the repeat rate, press a button or the slider in the "Repeat rate"
group.

Moving the slider to the right will shorten the repeat rate. Moving to the left will extend the
repeat rate.

4. Touch the test field to check the settings.
The screen keyboard opens.
5. Move the screen keyboard as needed.
6. Press an alphanumeric key and keep the key pressed down.

Check the implementation of the character repetition and the rate of the character
repetition in the test box.

7. If the settings are not perfect, correct them.
8. Confirm your entries.

The dialog closes.
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Result

The character repetition and delay are set.

6.3.5.3 Setting the double-click

Introduction

Requirement

Procedure

70

You can start applications in the Control Panel and in Windows CE with a double-click. A
double-click corresponds to two brief touches in sequence.

In the "Mouse Properties" dialog, make the following adjustments for touch screen operation
and operation with external mouse:

® |nterval between touch contacts on the touch screen

® |nterval between mouse clicks

You have opened the "Mouse Properties" dialog with the "Mouse" %) icon.

Mouse Properties m
Double-Click |

Double-click this grid to set the double-

click sensitivity for both the speed and
physical distance between clicks, @——G)

Double-click this icon to test your
double-click settings. If this icon dossn't
change, adjust your settings using the
grid abowe,

O] Pattern
® Symbol

Proceed as follows:
1. Click the pattern twice.

After the second click, the colors of the pattern will be reversed and the white fields will
change to gray. The time before the second click is saved.

25
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2. Check the double-click.

Click on the icon twice in succession to do this. If the double-click is recognized, the icon
is displayed as follows:

3. If the settings are not perfect, correct them.
To do this, repeat steps 1 to 2.
4. Confirm your entries.

The dialog closes.

Result
The double-click adjustment is completed.

6.3.5.4 Calibrating the touch screen

Introduction

Depending on the mounting position and viewing angle, it is possible that parallax may occur
when operating the touch screen. In order to prevent any operating errors as a result,
calibrate the touch screen again in the startup phase or during runtime.

Requirement

You have opened the "OP Properties" dialog box, "Touch" tab, by touching the "OP" 4@

icon.

If wour windows CE device is not responding
f propetly ko your kaps, vou may need to
recalibrate yvour screen, — —@

To start, kap Recalibrate,

Recalibrate @

0] If the HMI device does not respond exactly to touches, the touch screen may have to be
calibrated.

@ Button for calibrating the touch screen

MP 177 (WinCC flexible)
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Procedure
Proceed as follows:
1. Click on the "Recalibrate" button.

The following dialog opens:

Carefully press and briefly hold stylus on the center of
the target. Repeat as the target moves around the screen. |7 @

+ ®

@ Carefully press on the middle of the calibration crosshairs. Repeat this action as long as
the calibration crosshairs move on the touch screen.

@ Calibration crosshairs
2. Briefly touch the center of the calibration crosshairs @.
The calibration crosshairs is then displayed at four more positions.
3. Briefly touch the middle of the calibration crosshairs for each position.

Once you have touched all the positions of the calibration crosshairs, the following dialog
appears:

New calibration settings have been measured.
Tap the screen to register saved data.
Wait for 30 seconds to cancel saved data and @

keep the current setting.

Time limit: 30 sec @

©) New calibration settings have been measured. Touch the touch screen to save the
calibration values. Wait 30 seconds if you want to discard the new calibration values.

® Remaining time until calibration values are discarded
4. Touch the touch screen.

The calibration is saved. The "OP Properties" dialog box, "Touch" tab is displayed again.
If you do not touch the touch screen within the time shown, your original setting will be
retained.

5. Close the dialog.

MP 177 (WinCC flexible)
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Result
The HMI device touch screen is calibrated.

6.3.6 Changing password protection

Introduction

You can protect access to the Control Panel and the Windows CE taskbar with a password.
When you set up password protection, secure mode is automatically activated. Additional
information on the SecureMode can be found in the section "Setting up and canceling secure
mode (Page 61)/"

Requirement

You have opened the "Password Properties" dialog with the "Password" Q@ icon.

Password Properties m

Pazsword Settings l

Fa%

Password

Password:
Confirmn passwaord:

NOTICE

Password not available

If the password is no longer available, you can only do the following after resetting the
factory settings:

e Change settings in the Control Panel
e Use the Windows CE taskbar

All data on the HMI device will be deleted when you reset the factory settings.

Therefore use the password to protect against loss.
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Procedure for activating password protection

Result

Note

The following characters cannot be used in passwords:
e Blank
e Special characters *? . % /\'"

Proceed as follows:

1. Enter a password in the "Password" text box.

2. Repeat the password entry in the "Confirm password" text box.
3. Confirm your entries.

The dialog closes.

You cannot open the Control Panel or Windows CE taskbar without entering a password.

Procedure for removing password protection

Result

See also

Proceed as follows:
1. Delete the entries in the "Password" and "Confirm password" text boxes.
2. Confirm your entries.

The dialog closes.

Password protection for the Control Panel and Windows CE taskbar is canceled and they
can be freely accessed.

Setting up and canceling secure mode (Page 61)

6.3.7 Changing HMI device settings

6.3.7.1 Setting the date and time

Introduction

74

You can set the date and time on the HMI device. The HMI must be restarted in the following
cases:

® You have changed the time zone setting.

® You have changed the "Daylight savings time currently in effect" check box setting.

MP 177 (WinCC flexible)
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Requirement

12

You have opened the "Date/Time Properties" using the "Date/Time Properties" -GJ icon.

DatefTime Properties m
DatefTime I

Time Zone I(GMT) Greenwich Mean Time : Dublin, EdinbllZl_

Kl Februar 2007 |3 CUIRERS i

MDD MDEFES5 5 |03 [

29030 31 1 oz 3 4
5 6 7 8 9 10 11
12 13 14 15 17 15
19 20 21 22 23 24 25
2728 1 2 3 4

5 6 7 & 9 1011 EDD":"_:

E Davlight savings kime
currently in etbeckt

b4l |

Date selection box

Text box for the time

Button for applying changes
Time zone selection box

CECHCONCHC

"Daylight savings" check box

Procedure
Proceed as follows:
1. Select the appropriate time zone for the HMI device from the "Time Zone" selection box.
2. Touch the "Apply" button to confirm your entry.

The time of day shown in the "Current Time" box is adjusted correspondingly to the
selected time zone.

3. Set the date in the selection box.
4. Set the current time of day in the "Current Time" input field.
5. Touch the "Apply" button to confirm your input.

The values you have set are now in effect.

Note

The system does not automatically switch between winter and summer time.

6. If you want to switch from winter to summer time, select the
"Daylight savings time currently in effect" check box.

When you press the "Apply" button, the time is brought forward by one hour.

7. If you want to switch from summer to winter time, clear the
"Daylight savings time currently in effect" check box.

When you press the "Apply" button, the time is moved backwards by one hour.
8. Confirm your entries.

The dialog closes.
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Result
The settings for the data and time of day have now been changed.

Internal clock
The HMI device has an internal, buffered clock. Buffering of the internal clock is time limited.

Synchronizing the date and time with the PLC

The date and time of the HMI device can be synchronized with the PLC if this has been
configured in the project and the PLC program.

Additional information on this subject is available in the "WinCC flexible" system manual.

NOTICE

Time-dependent reactions

You have to synchronize the date and time when time-controlled responses are triggered in
the PLC by the HMI device.

See also
Restarting the HMI device (Page 82)

6.3.7.2 Changing regional settings

Introduction
In different countries, for example, the date, time and decimal points are displayed
differently. You can adjust this display to meet the requirements of different regions.

The country-specific settings apply to the current project. If the project language is changed,
the country-specific settings are also changed.

MP 177 (WinCC flexible)
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Requirement
You have opened the "Regional and Language Settings" dialog with the

"Regional Settings" :? icon.

Regional and Language Settings m
Regional Settings | Murnber I Tirnl 4 | 2

Mary programs have different
international settings, Regional
adjustrnents in date-, time-,
:.? currency- and numbers-
conwentions for displaying and
sorting data can be achieved in

changing those international
settings.

Region,

0] Region selection box

Procedure
Proceed as follows:
1. Select the region from the selection box.

2. Change to the "Number”, "Currency"”, "Time" and "Date" tabs and set the selection boxes
to the desired settings.

3. Confirm your entries.

The dialog closes.

Result
The HMI device's regional settings have been changed.

6.3.7.3 Backup registry information

Registry information and temporary data

You can install and uninstall your own programs on the HMI devices under Windows CE.
You must save the registry settings after installation or uninstallation.

You can save the following data to the flash memory:
® Registry Information

® Temporary files
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Restoring the file system of a memory card

Requirements

Procedure

Result

78

If memory cards are used, the file system on the memory card may become damaged,
perhaps due to a power failure. The HMI device detects the defective file system on start-up
or when the memory card is inserted. The HMI device can restore the file system
automatically or on request.

You have opened the "OP Properties" dialog, "Persistant Storage" tab with the "OP" 6@
icon.

E | Display I Device I Touch Im
-

Save actual registry settings to Flash,
System will start with saved regiskry Save Fegistry
\setkings nexk time. Y,

(Bave all files From temporary memary)
(e.g. the "\Program Files' directory) ko Sawve Files
flash. The files will be restored during
system startup, The 1 Temp' directary

\ il ok be saved. )

@L@@ ®O

D Autornatically repair file swstem errors on storage
cards at syskem starbup and card insertion kime

Saves the current registry information to the flash memory. The HMI device loads the saved
registry information the next time it boots.

Button for saving registry information
Button for saving temporary files

®e e o

Saves all the files in temporary storage to the flash memory (for example, from the "Program
Files" directory). These files are written back when the HMI device is started. The "Temp"
directory is not saved.

® Automatically restores the file system on the memory card when the HMI device starts up and
when a memory card is inserted.

Proceed as follows:

1. If you want the system to be restored automatically, activate the "Automatically repair file
system errors ..." check box.

If the check box is unchecked, the system is restored only once prompted to do so.
2. Click on the necessary buttons.
3. Confirm your entries.

The dialog closes.

The HMI device uses the saved registry information the next time it starts. The temporary
files are copied back.
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6.3.74 Changing monitor settings

Requirement

You have opened the "OP Properties" dialog box, "Display" tab, by touching the "OP" 4@

icon.

Persistent Storage | Display l Device l Touch ] FAlr

EBrightness

P DOAWT

Procedure
Proceed as follows:
1. If you want to increase the brightness, press the "UP" button.
2. If you want to decrease the brightness, press the "DOWN" button.
3. Confirm your entries.
The dialog closes.
Result

The screen settings have been changed.

6.3.7.5 Setting the screen saver

Introduction
You can set the following time intervals on the HMI device:
® For the automatic activation of the screen saver
® For the automatic reduction in the screen's backlighting

When you do not undertake an operation within the configured interval, the configured
function will be activated automatically.

The screen saver and the reduced screen backlighting functions are switched back off by
means of the following actions:

® By pressing any key

e By touching the touch screen
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Requirement

Procedure

80

The function associated to the key or button will not be executed by this.

NOTICE

Reduce backlighting
The brightness of the backlighting decreases incrementally during its operational life.

In order to not shorten the operational lifetime of the backlighting unnecessarily, activate
the backlighting reduction.

Activating the screen saver

Screen contents which remain unchanged for long periods can remain dimly visible in the
background. This effect is reversible.

Therefore activate the screen saver. When the screen saver is active, the backlighting is

also reduced.

You have opened the "Screensaver" dialog with the "ScreenSaver" @ icon.

Dirn Backlight becomes active after | § =] minutes 1

Screensaver becomes active after | g

I_EI minukes @

[ @ Skandard O Blank Screen } @

Enter a '0' ko disable the Function.
The minimum time is S and the maximum is 71582 minutes,

@ Time interval in minutes until backlighting is reduced
® Period of time in minutes before the screen saver is activated
® Radio buttons for the screensaver

Proceed as follows:

1. Enter the interval in minutes after which the backlighting is to be reduced.
Entering "0" will deactivate the backlighting reduction.

2. Enter the number of minutes before the screen saver is to be activated.

The minimum time is 5 minutes and the maximum time is 71582 minutes. Entering "0"
disables the screen saver.

3. Select either the screen saver or an empty screen.
— If you want the screen saver to function, activate the "Standard" radio button.

— If you do not want the screen saver to function, activate the "Blank Screen" radio
button.

4. Confirm your entries.

The dialog closes.
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The screen saver and the reduced backlighting for the HMI device is set.

6.3.7.6 Changing the printer properties

Introduction

Requirement

The HMI device can print on local printers or network printers. You can print hardcopies and
reports on a network printer. Line printing of alarms is not possible on a network printer.

A printer server is required for connecting a network printer to the HMI device.

The list of current printers and required settings for HMI devices can be found on the Internet
under "http://support.automation.siemens.com/WW/view/de/11376409".

&
You have opened the "Printer Properties" dialog with the "Printer"” E':T " icon.

Printer Properties m

Printer Language: IPCL Inkjet E— —@
Port: E_ _@
Metwork: — —@
Paper Size: |.0.4 E_ _@
Crrienkation
@) Portrait () Landscape —I—@)
|_|j Draft Mode I_?l Color |_|j MY

o o

Selection boxd for the printer

Interface selection box

Network address of the printer

Paper format selection box

Group "Orientation" with radio buttons for print orientation

Check box for improving the color quality (for Brother HL 2700 printer only)
Color printing check box

CHONONCNCNONONC)

Print quality check box
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Procedure
1.
2.
3.
4.
6.
7.
8.
9

Result

6.3.7.7

Introduction
[ ]
[ ]
[ ]

82

Proceed as follows:

Select a printer from the "Printer Language" selection box.
Select the port for the printer from the "Port" selection box.

If you wish to print via the network, enter the printer's network address in the "Network"
text box.

Select the paper format from the"Paper Size" selection box.

5. Activate a radio button in the "Orientation" group.

"Portrait" for vertical format
"Landscape" for horizontal format
Select the print quality.
— Select the "Draft Mode" check box if you wish to print in draft mode.
— Clear the "Draft Mode" check box if you wish to print with higher quality.

If the printer selected can print in color and you wish it to do so, activate the "Color" check
box.

If you are using the printer model Brother HL 2700, activate the check box "CMY." This
improves the color quality for printing.

. Confirm your entries.

The dialog closes.

The settings for the printer have now been changed.

Restarting the HMI device

The HMI device must be restarted in the following cases:

You have activated or deactivated the PROFINET 1O direct keys.
You have changed the time zone setting.

You have changed the automatic daylight savings and standard setting.

NOTICE

Data loss when the HMI device is restarted

All volatile data is lost when the HMI device is restarted.

Check the following:
e The project on the HMI device is complete.

e No data is being written to the flash memory.

MP 177 (WinCC flexible)
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Requirement

Procedure

Result

See also

6.3 Control Panel

icon.

0P Properties

Persistent Storage I Display |} Device |
Device: MP 177 £" Touch
Irnage Yersion: ¥01.00.00.00_01.41
Bootloader Yersion: 1.00
Bootloader Rel,Date: 12.3.2008
Flashsize: &4 MB
MAC-Address: 08-00-06-17-76-17
Reboot : @

0] Button for restarting the HMI device

1. If you want to restart the HMI device, press the "Reboot" button.

The following message is displayed:

ATTENTION!

If you execute this
function, you lose all
unsaved files, —@

Please close all applications
before rebooting,

Reboot now?

©) If you run this function, all data which has not been backed up will be lost. Please close all
applications before restarting.

2. Click on the "Yes" button.

The HMI device restarts without delay. If you click "No," the message will be closed.
There will be no restart.

The HMI device starts.

Displaying information about the HMI device (Page 84)
Setting the date and time (Page 74)
Enabling PROFINET IO |(Page 91)
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6.3.7.8 Displaying information about the HMI device

Introduction

Requirement

See also

84

You will need the device-specific information when you contact Technical Support.

You have opened the "OP Properties" dialog box, "Device" tab, by touching the "OP" 6@
icon.
The HMI device-specific information is displayed in the "Device" tab.

The data displayed in the image are device-specific and may therefore deviate from that of
your HMI device.

OP Properties

Persiskent Starage I Display |

Device: MP 177 &" Touch —@

Image version: ¥01.00.00.00_01.41 @

Bootloader Wersion: 1.00 @

Bootloader Rel Date: 12,3.2008 @

Flashsize: &4 MB @

MAC-Address: 08-00-06-17-76-17 @
Reboot : @

HMI device name

Version of the HMI device image

Version of the boot loader

Boot loader release date

Size of the internal flash memory in which the HMI device image and project are stored
MAC address of the HMI device

See section "Restarting the HMI device (Page 82)."

CNONCONONCNONC)

Note

The size of the internal flash memory does not correspond to the available working memory
for a project.

Restarting the HMI device (Page 82)

MP 177 (WinCC flexible)
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6.3.7.9 Displaying system properties

Introduction

The general system-specific information provides you with information about the processor,
operating system and memory.

Requirement
You have opened the "System Properties" dialog box, "General" tab, by touching the

"System" : icon.

The data displayed in the image are device-specific and may therefore deviate from that of
your HMI device.

System Properties m

General | Mernary | Device Name |

(Microsoft® WindowsE CE
Wersion 3.00

computer program is protected by LS, and
\internatinnal copyright s,

(Pracessar Type:

& 2004 Microsoft Corp. Al rights reserved, This :

\Memur\;: 05772 KB RAM

® Copyright for Microsoft Windows CE
® Details on processor and size of internal Flash memory

Displaying system properties
The system properties are displayed. This dialog is read-only. Close the dialog.

MP 177 (WinCC flexible)
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6.3.7.10 Displaying memory distribution

Introduction
The "Memory" system-specific information provides you with information about the
distribution and size of the memory in the HMI device.

NOTICE

"Memory" tab
Do not change the memory allocation in the "Memory" tab.

Applies for the usage of options:
An alteration to the memory allocation may be necessary. Please refer to the

accompanying documentation for further information.

Requirement

You have opened the "System Properties" dialog box, "Memory" tab, by touching the

HE oy

H L]
"System" 3 icon.
System Properties m

General || l Device Mame |

Mowve slider to the left for more mermory to n
programs. Move slider to the right for more
storage room. Only unused RAM can be adjusted,

Storage A —— Program

Memory i Memory

Allocated 312KE Allocated 95260KB
In Use BZEOKE In Use 14096KE

Procedure
1. Determine the current memory structure of the HMI device.

2. Close the dialog.
6.3.7.11  Activate memory management

Memory management
If memory management is activated, the HMI device will automatically close the project if the
memory needs reorganizing during an active project.
The project is shut down and the HMI device will display a message. You have to restart the
project.

MP 177 (WIinCC flexible)
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NOTICE

Memory management

If you do not activate memory management, undefined states can occur during the runtime
of the project.

Select memory management in the "OP Properties" dialog box.

Requirement

You have opened the "OP Properties" dialog box, "Memory Monitoring" tab, by touching the
"OP" 4@ icon.

OP Properties

Maxirurn used memary: 22%

Zurrent used memory; 22%

®
@
—@

D Shut dovan HMI Runkime if memory is running low,

0] Maximum memory used since the HMI device was last switched on
® Percentage of memory currently used
® Activate memory management

Procedure
Proceed as follows:
1. If you want to enable memory management, activate the check box.
If memory management is active and there is not enough working memory, the
SIMATIC HMI runtime and therefore the current project will be closed.
2. Confirm your entries.
The dialog closes.
Result

Memory management is activated.

MP 177 (WinCC flexible)
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6.3.8 Setting storage location

Introduction

There are various storage locations available for storing the compressed source file of your
project. The following describes how you can set the storage location.

Requirement

You have opened the "Transfer Settings" dialog box, "Directories" tab, by touching the

8
"Transfer" i,m icon.

Transfer Settings

Praject File
I'I,FIash'l,Simatic'l,

Praject Backup i‘!%/
I'I,Stnrage Card MM\ Simakich, B0 RS | _@
®

Autastart application:
Path: Wit [sec]:
I'I,FIash'l,Simatic'l,HmiRTm.exe |3 EI

0] Directory where the project file is stored

® Directory where the compressed source file of your project is stored
® Storage location and initialization file of the HMI device for process operation
NOTICE

Settings under "Project File" and "Path"

The project may not open the next time the HMI device is started if changes are made in
the "Project File" and "Path" text boxes.

Do not change the entries in the "Project File" and "Path" text boxes.

Procedure
1. Select a storage location from the "Project Backup" text box.
The external memory card or the location in the data network can be defined as the
storage location. During the next backup process, the project source file is stored in the
specified location.
2. Confirm your entries.
The dialog closes.
Result

The storage location for the source file is now set.

MP 177 (WinCC flexible)
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6.3.9 Setting the delay time

Introduction

Once the HMI device has been switched on, a project can be started after a delay. The
Loader is displayed during the delay time.

Requirement

You have opened the "Transfer Settings" dialog box, "Directories" tab, by touching the
=

"Transfer" T, icon.

Transfer Settings m

Channel | Directories l

Project File
|'|,Flash'|,5imatic'|,

Project Backup
|'|,5tu:|rage Card MM\ Simatich,

Aukostart application:
Path: Wi ait [sec]:
|'|,FIash'|,5imatic'|,HmiRTm.exe |3 j
NOTICE

Settings under "Project File" and "Path"

The project may not open the next time the HMI device is started if changes are made in
the "Project File" and "Path" text boxes.

Do not change the entries in the "Project File" and "Path" text boxes.

Procedure
1. Select the desired delay time in seconds from the "Wait [sec]" selection box.

With the value "0", the project starts immediately. It is then no longer possible to call the
Loader after switching on the HMI device. If you still wish to access the Loader, an
operator control must be configured to close the project.

2. Confirm your entries.

The dialog closes.

Result
The delay time for the HMI device is now set.

MP 177 (WinCC flexible)
Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0 89



Configuring the operating system

6.3 Control Panel

6.3.10 Setting the uninterruptible power supply

Introduction

Requirement

UPS monitoring is an option you load as an add-on with ProSave.

A UPS ensures that the HMI device is shut down in a controlled manner after a buffer time in
the event of a power failure. This avoids the loss of data.

The following uninterruptible power supplies are supported:
e SITOP DC UPS modules as of a rated power value of 6 A, for example 6EP1931-2DC42

Connect the UPS to the 24-V input and a USB port. Configure the USB port for UPS
monitoring.

You have opened the "UPS Properties" dialog box, "Configuration" tab, by touching the

A}
"UPS" _jfﬂ icon.

Text box for the time after which the "Battery mode activated" message is displayed
Check box for enabling battery mode

Text box for the time after which the "Faulty port" message is displayed

Check box for the "Faulty port" message

® e 00

Procedure for setting the USP

90

Proceed as follows:
1. Deactivate the "Battery mode" check box to activate battery mode.
2. Enter a time period in the "min" and "s" text boxes.

The HMI device will receive a message when UPS takes effect.

If battery mode is activated, the applications on the HMI device will be terminated after
the adjustable time period.

3. To receive a message if the port to which the UPS is connected is faulty, activate the
"Port disturbed" check box.

4. Select the message you want from the selection box.

5. Enter the time period after which the "Faulty port" message is displayed in the "min" and
"s" text boxes.

MP 177 (WinCC flexible)
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Result
Port monitoring for the UPS is set.

Procedure for displaying the state of the USP

To display the monitoring state of the UPS, change to the "Current Status" tab. If you want to
refresh the display, press the "Update" button.

6.3.11 Enabling PROFINET 10

PROFINET 10

If the HMI device is connected to the PLC via PROFINET, function keys can be configured
as PROFINET IO direct keys. If PROFINET 10 direct keys are used in the project, they must
be enabled.

Note

If you enable PROFINET IO direct keys, you cannot use the RS 422/RS 485 port for serial
communication.

PROFINET IO direct keys and PROFIBUS DP direct keys are mutually exclusive.

Requirement

You have opened the "PROFINET" dialog with the "PROFINET" ) icon.

PROFINET OK|
[]p

-----

Device name: {max, 240 characters)

@
IMPl.T".T" __@
-

MaC-Adrass: 0§-00-06-17-76-17

0] Activating or deactivating the PROFINET 10 direct keys
® Text box for the device name
® MAC address of the HMI device

NOTICE

Inconsistent device name

If the device name does not match the device name entered in the HW Config of STEP 7,
the direct keys do not work.

Use the device name from the HW Config of STEP 7. This device name does not
correspond to the device name used under Windows CE.

MP 177 (WinCC flexible)
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Procedure

Result

See also

92

Within the ETHERNET data network, the device name must be unique and satisfy the DNS

conventions. These include:

® The device name may have a maximum of 240 characters.

e |f the device name is longer than 63 characters, it must be divided into name
components. Each name component may have a maximum of 63 characters. Name

components are separated by periods.

® Example: <Subdomain Name>.<Domain Name>.<Top-Level Domain Name>

® The device name may contain letters, digits, hyphens or periods.

® The device name must not start or end with a the "-" character.

® The device name must not take the form n.n.n.n (n = 0 to 999).

® The device name must not start with the character sequence "port-xyz-" (x, y, z= 0 to 9).

Proceed as follows:

1. If you want to enable the PROFINET 10 direct keys, activate the "PROFINET 10 enabled"

check box.
2. Enter the device name of the HMI device.
3. Confirm your entries.

The dialog closes.

The PROFINET IO direct keys are enabled.

Restarting the HMI device (Page 82)
Direct Keys (Page 138)

Communications (Page 23)

MP 177 (WinCC flexible)
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6.3.12 Transfer settings

6.3.12.1  Configuring the data channel

Introduction

Requirement

If you block all data channels, the HMI device is protected against unintentional overwriting
of the project data and HMI device image.

Note

A project can only be transferred from the configuring PC to the HMI device when at least
one of the data channels is enabled on the HMI device.

The "Transfer Settings" dialog, "Channel" tab has been opened with the

]
"Transfer Settings" ¢, g icon.

Transfer Settings

 Channel | pirectories |

Channel 1: @

Serial:via R5232/PPI Multi-Master Cable

[ Enable Channel [ Remate Control

Channel 2: @
|ETHERKET =]
Enable Channel Remate Cantral| | 4400 -ed @

0] Group for the data channel 1 (Channel 1)
® Group for the data channel 2 (Channel 2)
® Button for the "S7-Transfer Settings" and/or "Network and Dial-Up Connections" dialog

A WARNING

Unintentional transfer mode

Unintentional transfer mode could cause unintentional actions to be triggered in the plant.

Ensure that the configuration PC does not inadvertently switch the HMI device to transfer
mode during the open project.

MP 177 (WinCC flexible)
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NOTICE

"Remote control" for "Channel 1"

If the Remote Control check box is activated during "Online" operating mode, the X2 port
cannot be used for communication.

The Remote Control check box must be deactivated for "Online" operating mode. Once the
serial transfer is complete, you will have to deactivate the "Remote Control" check box in

the "Channel 1" group.
Transfer mode using "Channel 2"

When the project on the HMI device starts, transfer parameters, for example HMI device
address, for MPI/PROFIBUS DP are overwritten with the values from the project.

You can change the settings for the transfer via "Channel 2."

The following steps are required:

e Close the project.

¢ Change the settings on the HMI device.
e Then return to "Transfer" mode.

The next time the project is started on the HMI device, the settings will be overwritten by
the values from the project.

Note

If the HMI device is in "Transfer" mode while changes are made to the transfer settings, the
settings only go into effect after the transfer function is restarted.

This may occur if the Control Panel is opened to change the transfer properties in an active
project.

MP 177 (WinCC flexible)
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Procedure

Result

See also

MP 177 (WIinCC flexible)

6.3 Control Panel

Proceed as follows:
. If you want to enable a data channel, activate the "Enable Channel" check box in the

"Channel 1" or "Channel 2" group.

In the "Channel 1" group, the RS-422/RS-485 port is enabled for the serial data transfer.
The network port is enabled in the "Channel 2" group.

. If you want to enable the automatic transfer, activate the associated "Remote Control"

check box.

. If you have enabled the data channel for "Channel 2", select the log from the selection

box.

. Enter further parameters if required.

Applies to "MPI/PROFIBUS/S7 Ethernet:"

— Press the "Advanced" button to switch to the "S7-Transfer Settings" dialog box. There
you can change the settings for MPI/PROFIBUS/S7 Ethernet.

— Confirm your entries.

— The "S7-Transfer Settings" dialog box closes.

Applies to "ETHERNET":

— Press "Advanced" to change to "Network&Dial-Up Connections."

— Open the "LAN9115" entry. You can change the TCP/IP settings there.
— Confirm your entries.

— Close "Network&Dial-Up Connections".

Applies to "USB:"

— No settings required for "USB."

. Confirm your entries.

The dialog closes.

The data channel is programmed.

Overview of network operation (Page 99)
Changing MPI/PROFIBUS DP settings (Page 96)
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6.3.12.2 Changing MPI/PROFIBUS DP settings

Introduction

The communication settings for MPl, PROFIBUS DP, and S7 Ethernet are defined in the
HMI device project.

In the following cases, the transfer settings might have to be changed:
® The first time the project is transferred

® |f changes are made to the project but are only applied later.

NOTICE
Transfer mode using MPI/PROFIBUS DP
The bus parameters are read from the project currently loaded on the HMI device.

The settings for MPI/PROFIBUS DP transfer can be modified. The following steps are
required:

¢ Close the project.

e Change the settings on the HMI device.

e Return to "Transfer" mode.

The changed MP/PROFIBUS DP settings will be overwritten in the following cases:
e The project is started again

e A project is transferred and started

Transfer settings

If the HMI device is in "Transfer" mode while changes are made to the transfer settings,
the settings only go into effect after the transfer function is restarted.

Requirement

You have opened the "S7-Transfer Settings" dialog with the "S7-Transfer Settings" jﬁﬂ

icon.

S57-Transfer Settings m

MP1

S7-Ethernet J——

—®
@

‘ Propetties. .. :—

@ Network selection
® Button for opening the properties dialog

MP 177 (WinCC flexible)
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Procedure

Proceed as follows:

1.

Select a network.

6.3 Control Panel

If you have selected S7 Ethernet, continue as described under "Configuring the data

channel (Page 93)."

Skation Parameters

Panel is the only master on the bus:

Address: |1

Time-out: 10s .

Mekwark Parameters

@O

Skation Parameters

Transmission Rake: |18?,5 kbitsts - :
Highest Station 126 -
PROFIBUS 0K,

@®

Panel is the only master on the bus:

Address: I1

Tirme-ouk: 1s -

Mekwark Parameters

OIOIO;

Transniission Rate: IWE @
Highest Station Address: |31 - @
Profile oF i @

O] The HMI device is the only master on the bus.

® Bus address of the HMI device

® Time-out

® Data transmission rate in total network

® Highest station address in the network

® Profile

@) Button for displaying the bus parameters

. Use the "Properties" button to open the "MPI" or "PROFIBUS" dialog.
MPI 0K,

If there are several masters connected on the bus, deactivate the "Panel is the only

master on the bus" check box.

4. Enter the bus address for the HMI device in the "Address" text box.

MP 177 (WIinCC flexible)

NOTICE

The bus address in the "Address" text box must be unique throughout the

MPI/PROFIBUS DP network.
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5. Select the transmission rate from the "Transmission Rate" text box.
6. Enter the highest station address on the bus in the "Highest Station Address" or "Highest
Station" text box.
7. For PROFIBUS settings: Select the desired profile from the "Profile" selection box.
8. For PROFIBUS settings: If you want to view the profile data, press the "Busparameter”
button of the "PROFIBUS" dialog.
The profile data are displayed. The "Profile" dialog is read-only.
NOTICE
The bus parameters must be the same for all stations in the MPI/PROFIBUS DP
network.
Profile m
Tslot: 1000 fBit Trdly: 11 tBit
Mir Tsdr: 11 tBit Tidl1: 76 tBit
Max Tsdr: 00 tBEit Tidz: 800 thit
Tset: 16 1Bit
Touii: 9 {Bit
Gap factor 10
Retry limit: 4
9. Close the "Profile" dialog.
10.Confirm your entries.
The dialog closes.
Result

The MPI/PROFIBUS DP settings of the HMI device have been changed.

MP 177 (WinCC flexible)
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6.3.13.1

Introduction

Addressing

6.3 Control Panel

Network operation

Overview of network operation

You can connect the HMI device to a PROFINET network via the Ethernet port.

Note
The HMI device can only be used in PROFINET networks.
If Sm@rtService or Sm@rtAccess are not used on the HMI device, the following applies:

The HMI device only has client functionality in the PC network. This means that users can
access files of a node with TCP/IP server functionality from the HMI device via the network.
However, you cannot, for example, access data on the HMI device from a PC via the
network.

The options Sm@rtService or Sm@rtAccess enable you to access an HMI device from a
remote station.

Note

Information on communication using SIMATIC S7 via PROFINET is provided in the
"WiIinCC flexible communication" user manual.

The connection to a network offers, for example, the following options:

® Printing via a network printer

® Saving, exporting and importing of recipe data records on or from a server
® Transferring a project

® Saving data

Within a PROFINET network, computers are usually addressed using computer names.
These device names are translated from a DNS or WINS server to TCP/IP addresses. This
is why a DNS or WINS server is needed for addressing via computer names when the HMI
device is in a PROFINET network.

The corresponding servers are generally available in PROFINET networks.

Note

The use of TCP/IP addresses to address PCs is not supported by the HMI device's operating
system.

Consult your network administrator if you have questions in this regard

MP 177 (WinCC flexible)
Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0 99



Configuring the operating system

6.3 Control Panel

Printing via a network printer

The HMI device's operating system does not support line by line alarm logging via a network
printer. All other printing functions, for example hardcopy or logs are available without
restriction via the network.

Preparation

Before beginning the configuration, request the following network parameters from your
network administrator.

® Does the network use DHCP for dynamic assignment of network addresses?
If not, get a new TCP/IP network address for the HMI device.

® Which TCP/IP address does the default gateway have?

o |f a DNS network is used, what are the addresses of the name server?

e [f a WINS network is used, what are the addresses of the name server?

General procedure for configuring the network

The HMI device must be configured prior to network operation. The configuration is basically
divided into the following steps:

1. Enter the device name of the HMI device.
2. Configure the network address.

3. Set the logon information.
4

. Save the settings.

See also
Setting the device name of the HMI device (Page 100)

6.3.13.2  Setting the device name of the HMI device

Introduction
The HMI device uses the device name to identify itself in the communication network.

MP 177 (WinCC flexible)
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Requirement

You have opened the "System Properties" dialog box, "Device Name" tab, by touching the

"System" : icon.

System Properties m
Device Name
lf—_ These settings are used to identify
woLr Windows CE device to other
computers,

Please type a name (without any
spaces) and a short description.

Dievice name: |SeIlaE | —

Device description; IHMI Device —

—®
—@

@®  Computer name of the HMI device
®  Description for the HMI device (optional)

Note
To activate the network functions, enter a unique device name in the Device name text box.

Procedure
Proceed as follows:
1. Enter the device name for the HMI device in the "Device name" text box.
2. If necessary, enter a description for the HMI device in the "Device description" text box.
3. Confirm your entries.
The dialog closes.
Result
The device name for the HMI device is now set.
See also

Overview of network operation (Page 99)

MP 177 (WinCC flexible)
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6.3.13.3  Changing the network configuration

Introduction
You can change the network settings for the LAN connection under "Network&Dial-

Up Connections."
Requirement

You have opened the following display by touching the "Network&Dial-Up Connections" e;_,

icon.

|Fi|E Edit View Advanced ||}(|| El

Procedure
Proceed as follows:
1. Open the "LAN9115" entry.
The "LAN9115' Settings" dialog box opens.

IP Adldress lName Servers | Etherr <[ *

An IP address can be automatically
assigned to this computer,

) Ohtain an IP address via DHCP
() Specify an IP address

[192 166 557 156
Crruj
Crrrj

2. If you need automatic issuing of addresses, select the "Obtain an IP address via DHCP"
radio button.

3. If you need manual issuing of addresses, select the "Specify an IP address" radio button.

4. If you have selected manual issuing of addresses, enter the corresponding addresses in
the "IP Address," "Subnet Mask" text boxes and if necessary in "Default Gateway."

MP 177 (WinCC flexible)
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5. If a name server is used in the network, change to the "Name Servers" tab.

IP Address | Marmne Servers ]Etherr_l_'

Marne server addresses

Prirnary DMS: |:|
Secondary DMS: |:|
Primary WINS: |I|
Secondary WIMNS: I:|

6. Enter the respective addresses in the text boxes.

7. If you want to change the Ethernet settings, change to the "Ethernet Parameters" tab.

Ethernet Parameters l 4
Part: Portl.

Mode and

Speed: ﬂ

"Automatic" is preset in the field "Mode and Speed" for the data rate and transmission
rate of the Ethernet connection. With this setting, the HMI device automatically detects
the data rate and speed of communication via Ethernet and adapts to this.

8. If you do not want to use this setting, select the required combination of transfer mode
and data rate in the selection field.

9. Confirm your entries.
The dialog closes.
10.Close the "Network&Dial-Up Connections" display.

The Control Panel is displayed again.

Result
The LAN connection parameters for the HMI device have been changed.

See also
Overview of network operation (Page 99)

MP 177 (WinCC flexible)
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6.3.13.4 Changing the logon data

Introduction

Windows CE uses this logon data to gain access to the network resources. Enter the user
name, password and domain you have received from your administrator.

If the Control Panel is protected with a password, you have to enter the password again to
change the logon data.

Requirement

] 5
You have opened the "Owner Properties" dialog with the "Network ID" icon.

Metwork 1D l

Windows CE uses this information to gain access
to network resources, Enter the user name,
pazswiord, and domain provided by your netwiork
adrministratar,

lJser name:
Password:
Comair:

Procedure
Proceed as follows:
1. Enter the user name in the "User name" text box.
2. Enter your password in the "Password" text box.
3. Enter the domain name in the "Domain" text box.
4. Confirm your entries.

The dialog closes.

Result
The logon data has now been set.

See also

Overview of network operation (Page 99)

MP 177 (WinCC flexible)
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6.3.13.5 Changing e-mail settings

Requirement

Procedure

Result

You have opened the "WinCC flexible Internet Settings" dialog with the

SMTP server

@ IJse the default of the project file
O ®
Mame
Sender: I @
Authentication: I @

0] Setting the SMTP server

® Name for the sender

® E-mail account

Note

Additional tabs may appear in the "WinCC flexible Internet Settings" dialog. This depends on
the options that have been enabled for network operation in the project.

Proceed as follows:
1. Specify the SMTP server.

— Select the "Use the default of the project file" option button if you want to use the
SMTP server configured in the project.

— Clear the "Use the default of the project file" option button if you do not want to use the
SMTP server configured in the project. Specify the required SMTP server.

2. Enter the name for the sender in the "Sender" text box.
3. Enter the e-mail account for your e-mail in the "Authentication" text box.

Some e-mail providers only allow you to send mail if you specify the e-mail account. The
"Authentication” text box can remain empty if your e-mail provider allows you to send mail
without checking the account.

4. Confirm your entries.

The dialog closes.

The e-mail settings have been changed.

MP 177 (WinCC flexible)
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See also

6.3.13.6

Overview

Overview of network operation (Page 99)

Importing and deleting certificates

You can import, view and delete certificates that have been imported for the HMI device. The
certificates differ in the following ways:

® (Certificates that you trust
® Own certificates

e Other certificates

You can import additional certificates and delete certificates that are not required.

The required settings can be obtained from your network administrator.

Requirement

Procedure

106

You have opened the "Certificates" dialog with the "Certificates" icon.

Stores ]

Lists the certificates

W=l | frusted by wou

Class 2 Public Primnary Certification Authority
Class 3 Public Prirnary Certification authority
Entrust.net Certification Authority (2048)
Entrust.net Secure Server Certification Authorit
Equifax Secure Certificate Authority

GlobalSign Root CA

Import.. Yiew.. Remove |

=]

Proceed as follows:

1. Select the type of certificate from the selection box:

"Trusted Authorities"
"My Certificates"
"Other Certificates"

2. If required, start the importing process with the "Import" button.

A dialog with source details opens.

3. Ifrequired, delete certificates with the "Remove" button.

Mark the desired certificate.

MP 177 (WIinCC flexible)
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4.
5.

Result

6.3 Control Panel

If you want to list the properties of the certificate marked, press the "View" button.
Confirm your entries.

The dialog closes.

The changes to the certificates have been carried out.

See also

Overview of network operation (Page 99)

6.3.14 Backup and restore

6.3.14.1  Saving to external storage device (backup)

Introduction

Backup involves copying the following data of the HMI device to an external storage device:

Requirement

MP 177 (WIinCC flexible)

Operating system
Applications
Data from the internal flash memory

Software PLC data, without current values

The HMI device features an external storage device with sufficient free space.

You have opened the "Backup/Restore" dialog with the "Backup/Restore" @ icon.

Backup [ Restore

all other application rust be ended before
starting <BACKUP= or <RESTORE:=.

Backup (to storage card)

BACKUP

Restore (from storage card)

RESTORE
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6.3 Control Panel

Procedure for using a memory card for the first time

NOTICE

Loss of data possible
The first time you use a memory card the HMI device will request that you format the card.

Save a backup copy of memory card data to a PC before formatting.

Proceed as follows:

1.

Cancel the formatting procedure by pressing "ESC".

. Remove the memory card from the HMI device.

. Save a backup copy of vital data to a PC.

Insert the memory card into the HMI device.

. Format the memory card on the HMI device.

Proceed as follows:

Press the "BACKUP" button to open the "Select Storage Card" dialog.

The --- no storage card available --- message appears if there is no external memory in
the HMI device or if this memory is defective. Insert an external memory or a different
one.

Select the external memory for backup from the "Please select a Storage Card" selection
list.

Click on the "Start Backup" button.
The HMI device checks the external memory.

If an external memory with a greater memory capacity is needed, a message is
displayed. Acknowledge this message. Backup is aborted. Insert an external memory
with a greater memory capacity and restart the backup process.

If the "You may have an old backup on the storage card. Do you want to delete it?"
message appears, there is already a backup on the external memory. If you do not want
to overwrite the backup, press the "No" button. Otherwise click on the "Yes" button.

Several messages are displayed in sequence during the backup process:
"Saving registry data"
"Copy files"

A progress bar shows the status of the backup process. When the backup process is
completed, the following message is displayed:

"The operation completed successfully."
Acknowledge this message.

The dialog closes.

The HMI device data is now saved on the external memory.

2
3
4.
5
Procedure
1.
2.
3.
4.
Result
108

MP 177 (WinCC flexible)
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6.3 Control Panel

6.3.14.2 Restoring from external storage device

Introduction

A restore operation deletes the old data from flash memory of the HMI device on
confirmation. The data stored on the external memory is then copied to the internal flash
memory.

Requirement

® The external memory holding the backed up data is inserted in the HMI device.

® You have opened the "Backup/Restore" dialog with the "Backup/Restore" @ icon.

Backup [ Restore

all other application rust be ended before
starting <BACKUP> or <RESTORE:.

Backup (to storage card)

BACKUP

Restore (from storage card)

RESTORE

NOTICE

Loss of data possible

All data on the HMI device will be deleted during a restore operation. License keys are
deleted after counter-inquiry.

Back up the HMI device's data before restoring if required.
External memory with data backup

If several external memories with data backups are plugged in, the data cannot be
restored.

Remove the external memory with the data backups not needed.

Procedure
Proceed as follows:
1. Select "RESTORE" to start Restore.
The HMI device checks the external memory.
The HMI device issues messages in the following situations:
— The external memory is not available or is defective:
Acknowledge the displayed messages.
The Control Panel is displayed again.

Replace the external memory.

MP 177 (WinCC flexible)
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6.3 Control Panel

Result

110

More than one external memory with valid backup is available:
Remove all external memories with backups that are not needed.

If necessary, you can check the available external memories using the "REFRESH"
button.

. If necessary, start the restore process with the "RESTORE" button.

The data to be restored is checked.

When the check is complete, one of the following prompts is displayed:

"You are starting RESTORE now. All files (except files on storage cards) and the
registry will be erased. Are you sure?"

At this point you can cancel the restore using the "No" button to prevent the data on
the HMI device from being deleted.

You are now starting RESTORE. All files on the panel and the licenses listed below as
well as the registry will be erased. Are you sure?

This query is displayed when license keys are available both on the HMI device and in
the backup data. If necessary, cancel the restore process with the "No" button and first
back up the HMI device's license keys. Further information on this can be found in the

section "Transferring and transferring back license keys (Page 132)". Then restart the

restore process.

. Start to restore the data by selecting "Yes".

The following messages are displayed in sequence during the restore:

"Deleting files on flash"
"Restore CE Image"
A progress bar shows the status of the restoration of the Windows CE image.

After successful restoration of the Windows CE image, the following message is
displayed: "Restore of CE Image is finished. The device will be rebooted now. Don't
remove the storage card.".

. Acknowledge this message.

The HMI device starts. The operating system boots, opening the "Loader" and "Restore"
dialog in sequence.

The restore process is resumed. All data stored on the flash file system is restored.
Afterwards the following message is displayed "Restore succesfully finished. Press ok,
remove your storage card and reboot your device.".

5. Remove the external memory.

6. Acknowledge this message.

The HMI device starts.

The data from the external memory is now on the HMI device.

Note
Calibrating the touch screen

After the restore, you may have to re-calibrate the touch screen.

MP 177 (WinCC flexible)
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7.1 Overview

Configuration phase

A project — the process image of the working process — is produced during configuration to
visualize automated working processes. The process displays for the project contain
displays for values and messages which provide information about process statuses. The
process control phase follows the configuration phase.

Process control phase

The project must be transferred to the HMI device if it is to be used in process control.
Another precondition for process control is that the HMI device is connected online to a
controller. Current working processes - operating and observing - can then be subject to
process control.

Transferring the project to the HMI device
You can transfer a project to an HMI device as follows:
® Transfer from the configuration PC
® Restore from a PC using ProSave

In this case, an archived project is transferred from a PC to the HMI device. The
configuration software need not be installed on this PC.

® Restoring from external storage device (Page 109)

Commissioning and recommissioning
Initial and re-start-ups differ in the following respects:
® \When the HMI device is commissioned there is no project at first.
The HMI device is also in this state after the operating system has been updated.

e \When recommissioning, any project already on the HMI device is replaced.

MP 177 (WinCC flexible)
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7.2 Operating Modes

7.2 Operating Modes

Operating modes
The HMI device may be in the following operating modes:
e Offline
® Online
® Transfer

"Offline mode" and "Online mode" can be set on both the configuration PC and the HMI
device. To set these modes on the HMI device, use a corresponding operator control of the
project.

Changing the operating mode

The configuration engineer must have configured an appropriate operator control to allow a
change of the operating mode on the HMI device during ongoing operation.

Refer to your plant documentation to find any additional information on this topic.

"Offline" operating mode

In this mode, there is no communication between the HMI device and PLC. Although the
HMI device can be operated, it cannot exchange data with the PLC.

"Online" operating mode

In this mode, the HMI device and PLC communicate. You can operate the plant on the HMI
device according to your system configuration.

"Transfer" mode

In this mode, you can transfer a project from the configuration PC to the HMI device or
backup and restore HMI device data, for example.

The following options are available for setting "Transfer" mode on the HMI device:
® \When the HMI device starts up

Start "Transfer" mode manually in the HMI device Loader.
e During ongoing operation

Start the "Transfer" mode manually within the project using an operator control. The HMI
device toggles to "Transfer" mode when automatic mode is set and a transfer is initiated
on the configuring PC.

Note

An installed software PLC always operates independently of the project. This also applies
if the project is not active or if the project is transferred.

MP 177 (WinCC flexible)
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7.3 Using Existing Projects

7.3 Using Existing Projects

TP 177 6"

The MP 177 is a new device in the 6" Multi Panel segment. You can reuse TP 177B 6"
projects directly via a device switch.

MP 277 Touch

MP 277 Touch projects can be reused, taking into consideration the screen size and
available memory. Please note that the MP 177 does not support the following functions:

® OPC server
® Script function
® Archive function

Further information on the subject can be found in the WinCC flexible Online Help or in the
"WinCC flexible Migration™ manual.

7.4 Data Transmission Options

Overview

The following table shows the options for data transfer between the MP 177 and the
configuring PC.

Type Data channel MP 177
Backup Serial " Yes
MPI/PROFIBUS DP Yes
uSB Yes
Ethernet Yes
Restoring Serial Yes
MPI/PROFIBUS DP Yes
uUSB Yes
Ethernet Yes
Updating the operating system | Serially, with resetting to factory settings Yes
Serial Yes
MPI/PROFIBUS DP Yes
uSB Yes
Ethernet Yes
Transferring a project Serial Yes
MPI/PROFIBUS DP Yes
uSB Yes
Ethernet Yes

MP 177 (WinCC flexible)
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7.5 Transfer

Type Data channel MP 177
Installing or removing an option | Serial V Yes
MPI/PROFIBUS DP Yes
uUSB Yes
Ethernet Yes
License key transferring or Serial Yes
transferring back MPI/PROFIBUS DP Yes
uSB Yes
Ethernet Yes

R Applies when PC/PPI cable is used

7.5 Transfer
7.5.1 Overview
Transfer

Backtransfer

114

Transfer the executable project from the configuring PC to the HMI device.
You can start the "Transfer" mode manually or automatically on the HMI device.

Transferred data is written directly to the internal flash memory on the HMI device. For the
transfer, you use a data channel which you have to configure before starting a transfer.

You have the option to transfer the compressed project file together with the runtime project
to the HMI device. If necessary, the compressed project file can be transferred back to the
configuring PC and edited.

The HMI device must be equipped with an external memory card to which the compressed
project file can be saved.

NOTICE

Compressed project file

WinCC flexible does not check whether the compressed project file stored on the HMI
device corresponds to the existing runtime project.

MP 177 (WinCC flexible)
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7.5 Transfer

7.5.2 Starting manual transfer

Introduction

Requirements

Procedure

Result

See also

You can manually switch the HMI device to "Transfer" mode as follows:
e With a configured operating element during ongoing operation.
® In the Loader of the HMI device.

® The project "*.hmi" is opened in WinCC flexible.
® The HMI device is connected to a configuring PC
® The data channel is configured on the HMI device

® The HMI device is in "Transfer" mode

Proceed as follows:

1. On the configuring PC, select the "Transfer settings" command in the menu "Project >
Transfer" in WinCC flexible.

The "Select devices for transfer" dialog opens.

2. Select the HMI device in the left area of the dialog.

3. Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.

4. Set the transfer parameters in the right area of the dialog.

5. If you wish to transfer the compressed project file together with the runtime project to the
HMI device:

Select the "Enable backtransfer" check box.
6. Start transfer in WinCC flexible with "Transfer".

The configuring PC checks the connection to the HMI device. The project is transferred to
the HMI device. If the connection is not available or is defective, an error message is
displayed on the configuring PC.

When the transfer is completed successfully, the project can be found on the HMI device.
The transferred project is then started automatically.

Data Transmission Options (Page 113)
Operating Modes (Page 112)
Configuring the data channel (Page 93)
Overview (Page 114)

MP 177 (WinCC flexible)
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7.5 Transfer

753 Starting automatic transfer

Introduction

The HMI device can be automatically switched to "Transfer" mode during runtime as soon as
transfer is started on the configuring PC connected.

Automatic transfer is particularly suited for the test phase of a new project since transfer is
completed without interfering with the HMI device.

Automatic transfer is available for the following data channels:

Requirements

116

Serial
MPI/PROFIBUS DP
usB

Ethernet

NOTICE

If the automatic transfer has been activated on the HMI device and a transfer is initiated
on the configuring PC, the project currently running is automatically stopped. The HMI
device then automatically switches to "Transfer" mode.

After the commissioning phase, deactivate the automatic transfer so that the HMI device
cannot be inadvertently switched to transfer mode. The transfer mode can trigger
unintentional actions in the device.

You can set a password for the Loader of the HMI device to restrict access to the

transfer settings and thus avoid unauthorized modifications.

The project *.hmi is opened in WinCC flexible.

The HMI device is connected to a configuring PC

The data channel is configured on the HMI device

The automatic transfer is activated in the data channel for the transfer.

The project is started on the HMI device.

MP 177 (WinCC flexible)
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7.5 Transfer

Proceed as follows:

On the configuring PC, select the "Transfer settings" command in the menu "Project >
Transfer" in WinCC flexible.

The "Select devices for transfer" dialog opens.

Select the HMI device in the left area of the dialog.

3. Select the type of connection between the HMI device and the configuring PC.

Set the connection parameters.

Set the transfer parameters in the right area of the dialog.

5. If you wish to transfer the compressed project file together with the runtime project to the

HMI device:
Select the "Enable backtransfer" check box.
Start transfer in WinCC flexible with "Transfer".

The configuring PC checks the connection to the HMI device. The HMI device shuts
down the current project and automatically switches to "Transfer" mode The project is
transferred to the HMI device. If the connection is not available or is defective, an error
message is displayed on the configuring PC.

When the transfer is completed successfully, the project can be found on the HMI device.
The transferred project is then started automatically.

Procedure
1.
2.
4.
6.

Result

See also

Data Transmission Options (Page 113)

Operating Modes (Page 112)

Configuring the data channel (Page 93)

Overview (Page 114)

MP 177 (WIinCC flexible)
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7.5 Transfer

754 Starting backtransfer

Requirements

Procedure

Result

See also

118

No project is open on the configuring PC in WinCC flexible
The HMI device is connected to this configuring PC

The data channel is configured on the HMI device

The HMI device is in "Transfer" mode

The memory card containing the compressed project file is inserted into the HMI device

Proceed as follows:

1.

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuring PC.

Set the connection parameters.

4. Close the dialog with "OK".

5. Select the "Transfer" > "Backtransfer" command in the "Project” menu.

The "Backtransfer" dialog opens.
Click "OK" to start the backtransfer process.

The configuring PC checks the connection to the HMI device. The compressed project file
is transferred back from the HMI device to the configuring PC. If the connection is not
available or is defective, an error message is displayed on the configuring PC.

After successful backtransfer, the project is opened on the configuring PC in WinCC flexible.

Data Transmission Options (Page 113)

Operating Modes (Page 112)

Configuring the data channel (Page 93)

Overview (Page 114)

MP 177 (WinCC flexible)
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7.5 Transfer

755 Testing a project

Introduction

There are two options to test a project:

Test the project on the configuring PC

You can test a project at a configuring PC, using a simulator. For detailed information,
refer to the "WIinCC flexible" user manual and to the WinCC flexible Online Help.

Offline testing of the project on the HMI device

Offline testing means that communication between the HMI device and PLC is down
while the test is being carried out.

Online testing of the project on the HMI device

Online testing means that the HMI device and PLC communicate with each other during
testing.

Perform the tests, starting with the "Offline test", followed by the "Online test".

Note

You should always test the project on the HMI device on which the project will be used.

Check the following:

1.
2.
3.
4.

Check the correct layout of the screens
Check the screen navigation
Check the input objects

Enter the tag values

The test increases the certainty that the project will run error-free on the HMI device.

Requirements for offline testing

Procedure

The project has been transferred to the HMI device

The HMI device is in "Offline" mode

In "Offline" mode, you can test individual project functions on the HMI device without them
being affected by the PLC. PLC tags, therefore, are not updated.

Test the operating elements and visualization of the project as far as possible without
connecting to the PLC.

Requirements for online testing

® The project has been transferred to the HMI device

o The HMI device is in "Online" mode

MP 177 (WIinCC flexible)
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7.6 Backup and restore

Procedure

7.6

7.6.1

In "Online" mode, you can test individual project functions on the HMI device without them
being affected by the PLC. PLC tags are updated in this case.

You have the option to test all communication-dependent functions, for example alarms, etc.

Test the operating elements and views of the project.

Backup and restore

Overview

Backup and restore

You can back up and restore the following data found in the internal flash memory of the HMI
device with a PC:

® Project and HMI device image

® User administration

® Recipe data

® License keys

Use one of the following tools for backup and restore:
e WinCC flexible

® ProSave

Note

Alternatively, use the control panel to back up to an external memory device. Further
information on this can be found in the section "Saving to external storage device
(backup) (Page 107)".

General information

120

NOTICE
Power failure

If a complete restore operation is interrupted due to power failure on the HMI device, the
operating system of the HMI device may be deleted! In this case, you have to reset the HMI
device to its factory settings.

Compatibility conflict

If a message is output on the HMI device warning of a compatibility conflict during the
restore operation, the operating system must be updated.

MP 177 (WinCC flexible)
Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0



Commissioning a project
7.6 Backup and restore

7.6.2 Backup and restore using WinCC flexible

Requirement
® No project is open on the configuration PC in WinCC flexible.
® The HMI device is connected to this configuration PC.

® The data channel is programmed on the HMI device.

Procedure — backup
Proceed as follows:

1. On the configuration PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication settings" dialog box opens.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuration PC.
Set the connection parameters.

4. Close the dialog with "OK".

5. Select the "Backup" command in the menu "Project > Transfer" in WinCC flexible.
The "SIMATIC ProSave [Backup]" dialog box opens.

6. Select the data to be backed up.

7. Select a destination folder and a file name for the "*.psb" backup file.

8. Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the HMI device automatically
sets "Transfer" mode when a backup is initiated.

9. Start the backup operation in WinCC flexible with "Start Backup" on the configuring PC.
Follow the instructions in WinCC flexible.

A status view opens to indicate the progress of the operation.

Result
The system outputs a message when the backup is completed.

The relevant data is now backed up on the configuration PC.

MP 177 (WinCC flexible)
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7.6 Backup and restore

Procedure - restoring
Proceed as follows:

1.

© o kDN

Result

On the configuration PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication settings" dialog box opens.

Select the type of HMI device.

Select the type of connection between the HMI device and the configuration PC.
Set the connection parameters.

Close the dialog with "OK".

Select the "Restore" command in the menu "Project > Transfer" in WinCC flexible.
The "SIMATIC ProSave [Restore]" dialog box opens.

Select the "*.psb" backup file to be restored from the "Open" field.

You can see the HMI device for which the backup file was created and the type of backup
data the file contains.

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when a restore operation is initiated.

Start the restore operation in WinCC flexible with "Start Restore" on the configuring PC.

If there are license keys both on the HMI device and in the backup, a dialog box will
appear. Use this dialog to establish whether you want to overwrite the license keys or
abort the restore process.

— If necessary, abort the backup and first back up the HMI device's license keys. Further
information on this can be found in the section "Transferring and transferring back
license keys (Page 132)".

— Then restart the restore process.
Follow the instructions in WinCC flexible.

A status view opens to indicate the progress of the operation.

When the restore is successfully completed, the data backed up on the configuration PC is
now on the HMI device.

See also

Data Transmission Options (Page 113)

Operating Modes (Page 112)

Configuring the data channel (Page 93)

Overview (Page 120)
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7.6 Backup and restore

7.6.3 Backup and restore using ProSave

Requirement

o The HMI device is connected to a PC on which ProSave is installed.

® The data channel is programmed on the HMI device.

Procedure — backup

Proceed as follows:

1.
2.
3.

From the Windows Start menu, start ProSave on the PC.
Select the HMI device type in the "General" tab.
Select the type of connection between the HMI device and the PC.

Set the connection parameters.

4. Select the data to be backed up in the "Backup" tab.

5. Select a destination folder and a file name for the "*.psb" backup file.

6. Set "Transfer" mode on the HMI device.

Result

If automatic transfer mode is enabled on the HMI device, the HMI device automatically
sets "Transfer" mode when a backup is initiated.

Start the backup operation in ProSave with "Start Backup".
Follow the instructions in ProSave.

A status view opens to indicate the progress of the operation.

The system outputs a message when the backup is completed.

The relevant data is now backed up on the PC.

MP 177 (WIinCC flexible)
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7.6 Backup and restore

Procedure - restoring

Result

See also

124

Proceed as follows:

1.

From the Windows Start menu, start ProSave on the PC.

2. Select the HMI device type in the "General" tab.

3. Select the type of connection between the HMI device and the PC.
4.
5

. Select the "*.psb" backup file to be restored from the "Restore" tab.

Set the connection parameters.

You can see the HMI device for which the backup file was created and the type of backup
data the file contains.

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when a restore operation is initiated.

. Start the restore operation in ProSave on the PC with "Start Restore".

If there are license keys both on the HMI device and in the backup, a dialog box will
appear. Use this dialog to establish whether you want to overwrite the license keys or
abort the restore process.

— If necessary, abort the backup and first back up the HMI device's license keys. Further
information on this can be found in the section "Transferring and transferring back
license keys (Page 132)".

— Then restart the restore process.
Follow the instructions in ProSave.

A status view opens to indicate the progress of the operation.

When the restore is successfully completed, the data backed up on the PC is now on the
HMI device.

Data Transmission Options (Page 113)

Operating Modes (Page 112)

Configuring the data channel (Page 93)

Overview (Page 120)
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7.7 Updating the operating system

7.7 Updating the operating system

7.71 Overview

Updating the operating system

A compatibility conflict may occur when transferring a project to the HMI device. This is
caused by different versions of the configuration software used and the HMI device image
available on the HMI device. If there are different versions, the transfer is aborted. A
message indicating a compatibility conflict is displayed on the configuration PC.

There are two ways to match the versions:

e Update the HMI device image if the project was created with the most recent version of
the configuration software.

e Transfer a matching version of the HMI device image if you do not want to adapt the
project for the HMI device to the most recent version of the configuration software for the
project.

Note
When WIinAC MP is used, all data channel parameters are reset.

7.7.2 Resetting factory settings

NOTICE

Data loss

Data on the HMI device will be deleted when you update the operating system.

In ProSave or WinCC flexible, you can update the operating system with or without resetting
to the factory setting.

e Updating the operating system without resetting to factory settings

First, switch into "Transfer" mode on the HMI device or use the automatic transfer
function if the project is active. Then start the operating system update in ProSave or
WinCC flexible.

e Updating the operating system with reset to factory setting

Note
Calibrating the touch screen
After the reset to factory settings, you may have to recalibrate the touch screen.

MP 177 (WinCC flexible)
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NOTICE

Loss of license keys

The license keys on the HMI device will be deleted when resetting to factory settings.
The license keys on the HMI device will be retained when updating the operating system
without resetting to factory settings.

NOTICE

Data channels

When resetting to factory settings, all data channel parameters are reset. The transfer
can only be started following reconfiguration of the data channels.

Note

You can perform an operating system update by resetting to factory settings if you want
to restore the delivery state. For example, the default settings in the Control Panel and
the password for the Control Panel are reset.

You have to perform an operating system update with reset to factory settings if the HMI
device does not yet have an operating system or if the operating system of the HMI
device is corrupt.

First, start the operating system update in ProSave or WinCC flexible and switch the power
on the HMI device off and on again when prompted.

7.7.3 Updating the Operating System using WinCC flexible

Requirement

Procedure

126

The HMI device is connected to a configuration PC.
No project is open in WinCC flexible.
Only when updating the operating system without reset to the factory settings:

The data channel is programmed on the HMI device.

Proceed as follows:

1.

When updating the operating system with reset to the factory settings only:
Switch off power to the HMI device.

On the configuration PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication settings" dialog box opens.

3. Select the type of HMI device.

4. Select the type of connection between the HMI device and the configuration PC, then set

the connection parameters.

MP 177 (WinCC flexible)
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Result

See also

7.74

Requirement

10.

11

12.

7.7 Updating the operating system

Close the dialog with "OK".
In WinCC flexible, select the command "Update OS" in the "Project > Transfer" menu.

Select whether to update the operating system with or without resetting the factory
settings by setting the "Reset to factory settings" check box accordingly.

LLE
A

In "Image path”, select the HMI device image file ".img".

The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation DVD.

In the output area, you are provided information on the version of the HMI device image
file after it is opened.

When updating the operating system without resetting the factory settings:
Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when an update is initiated.

In WinCC flexible, select "Update OS" on the configuration PC to run the operating
system update.

. When updating the operating system with resetting the factory settings:

Switch on the power supply to the HMI device.
Follow the instructions in WinCC flexible.

During the operating system update a status view opens to indicate progress.

A message is displayed when the operating system update is successfully completed.

This operation has deleted the project data from the HMI device.

Data Transmission Options (Page 113)

Operating Modes (Page 112)

Configuring the data channel (Page 93)

Overview (Page 125)

MP 177 (WinCC flexible)
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7.7 Updating the operating system

Procedure

Result

See also

128

Proceed as follows:

1.

11.

When updating the operating system with resetting the factory settings:
Switch off power to the HMI device.

From the Windows Start menu, start ProSave on the PC.

Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC, then set the
connection parameters.

Select the "OS Update" tab.

Select whether to update the operating system with or without resetting the factory
settings by setting the "Reset to factory settings" check box accordingly.

LLE -
R

In "Image path”, select the HMI device image file ".img".

The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation DVD.

In the output area, you are provided information on the version of the HMI device image
file after it is opened.

When updating the operating system without resetting the factory settings:
Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when an update is initiated.

Select "Update OS" on the PC to run the operating system update.

. When updating the operating system with resetting the factory settings:

Switch on the power supply to the HMI device.
Follow the instructions in ProSave.

During the operating system update a status view opens to indicate progress.

A message is displayed when the operating system update is successfully completed.

This operation has deleted the project data from the HMI device.

Data Transmission Options (Page 113)

Operating Modes (Page 112)

Configuring the data channel (Page 93)

Overview (Page 125)
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7.8 Installing and removing opfions

7.8 Installing and removing options

7.8.1 Overview

Installing and removing options

You can install options on the HMI device, for example, additional programs developed
especially for the HMI device.

You can also remove the option from the HMI device again.

Note
License key

A license key may be needed to run an option. The license key unlocks the option for use.

7.8.2 Installing and Removing Options using WinCC flexible

Requirements

The HMI device is connected to a configuring PC
No project is open in WinCC flexible

The data channel is configured on the HMI device

Procedure for installing an option

Proceed as follows:

1.

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuring PC, then set

N o o s

MP 177 (WIinCC flexible)

the connection parameters.

Close the dialog with "OK".

Select the "Options" command in the menu "Project > Transfer" in WinCC flexible.
Select the desired option under "Available options".

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the installation of an option is initiated.

Start the installation of the option in WinCC flexible on the configuring PC with the ">>"
button.

Follow the instructions in WinCC flexible.

A status display appears indicating the progress of the installation.
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7.8 Installing and removing opfions

Result

The option has now been installed on the HMI device.

Procedure for removing an option

Proceed as follows:

1.

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuring PC, then set

N o o~

the connection parameters.

Close the dialog with "OK".

Select the "Options" command in the menu "Project > Transfer" in WinCC flexible.
Select the desired option under "Installed options".

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the removal of an option is initiated.

. Start the removal of the option in WinCC flexible on the configuring PC with the "<<"

button.
Follow the instructions in WinCC flexible.

A status display appears indicating the progress of the removal.

Result

The option has now been removed on the HMI device.
See also

Data Transmission Options (Page 113)

Operating Modes (Page 112)

Configuring the data channel (Page 93)

Overview (Page 129)
7.8.3 Installing and removing options using ProSave

Requirements

130

The HMI device is connected to a PC on which ProSave is installed

The data channel is configured on the HMI device

MP 177 (WinCC flexible)
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7.8 Installing and removing opfions

Procedure for installing an option

Result

Proceed as follows:

N o o s~ 0D =

From the Windows Start menu, start ProSave on the PC.

Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC.
Set the connection parameters.

Select the "Options" tab.

Select the desired option under "Available options".

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the installation of an option is initiated.

8. Start the installation of the option in ProSave with the ">>" button.

9. Follow the instructions in ProSave.

A status display appears indicating the progress of the installation.

The option has now been installed on the HMI device.

Procedure for removing an option
Proceed as follows:

Result

© N o O~ wDdhd =

From the Windows Start menu, start ProSave on the PC.

Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC.
Set the connection parameters.

Select the "Options" tab.

Press the "Device status" button to update the display.

Select the desired option under "Installed options".

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the removal of an option is initiated.

. Start the removal of the option in ProSave with the "<<" button.

Follow the instructions in ProSave.

A status display appears indicating the progress of the removal.

The option has now been removed on the HMI device.

MP 177 (WinCC flexible)
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7.9 Transferring and transferring back license keys

See also

Data Transmission Options (Page 113)

Operating Modes (Page 112)

Configuring the data channel (Page 93)

Overview (Page 129)
7.9 Transferring and transferring back license keys
7.9.1 Overview

Transferring and transferring back license keys

With the purchase of an optional package, you obtain a specific user license with an
associated license key. Once you have installed an option, transfer a license key to the HMI
device. The license key unlocks an option for use.

You can also transfer back the license key from the HMI device to the storage location.

Note
You only transfer license keys with the Automation License Manager or WinCC flexible.

See also
Transferring and transferring back license keys (Page 132)

7.9.2 Transferring and transferring back license keys

Requirements
e \When transferring or transferring back using WinCC flexible:
No project is open on the configuring PC in WinCC flexible.
® The HMI device is connected to this configuring PC.
® The data channel is configured on the HMI device.

® The storage location and the license key awaiting transfer are ready.

MP 177 (WinCC flexible)
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7.9 Transferring and transferring back license keys

Procedure for transferring a license key

Proceed as follows:

1.
2.

N o o »~

Result

Switch to "Transfer" mode on the HMI device.
When transferring using WinCC flexible:

Select the "License Keys" command in the menu "Project > Transfer". The
Automation License Manager opens.

When transferring using the Automation License Manager:
Start the Automation License Manager via the Windows Start menu.

In the Automation License Manager, select the command "Connect HMI device" in the
menu "Edit > Connect target system".

The "Connect Target System" dialog opens.

Under "Device Type", select the appropriate HMI device type.
Select the type of connection from the "Connection" box.

Set the connection parameters.

Select "OK".

The connection to the HMI device is established. The connected HMI device is displayed
in the left window of the Automation License Manager.

In the left window, select the source drive.
The right window displays the available license keys.

Drag one or more license keys from the right window and drop them on the HMI device in
the left window.

The license keys are then transferred to the HMI device.

The license key is transferred from the storage location to the HMI device.

MP 177 (WIinCC flexible)
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7.9 Transferring and transferring back license keys

Procedure for transferring a license key back

Result

See also

134

Proceed as follows:

1.
2.

N o o »~

Switch to "Transfer" mode on the HMI device.
When transferring back using WinCC flexible:

Select the "License Keys" command in the menu "Project > Transfer". The
Automation License Manager opens.

When transferring back using the Automation License Manager:
Start the Automation License Manager via the Windows Start menu.

In the Automation License Manager, select the command "Connect HMI device" in the
menu "Edit > Connect target system".

The "Connect Target System" dialog opens.

Under "Device Type", select the appropriate HMI device type.
Select the type of connection from the "Connection" box.

Set the connection parameters.

Select "OK".

The connection to the HMI device is established. The connected HMI device is displayed
in the left window of the Automation License Manager.

In the left window, select the HMI device.
The right window displays the available license keys.

Drag one or more license keys from the right window and drop them on the destination
drive in the left window.

The license keys are transferred back to the storage location.

The license key is transferred back from the HMI device to the storage location.

Data Transmission Options (Page 113)

Operating Modes (Page 112)

Configuring the data channel (Page 93)

Overview (Page 132)
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8.1

Overview

Configuration and process control phase

HMI devices can be used to operate and monitor tasks in process and production
automation. The plant screens on the HMI devices are used to provide a clear overview of
the active processes.

The HMI device project, which includes the plant screens, is created during the configuration
phase. The configuration engineer defines which tasks the HMI device has in the process
and defines the following in detail:

e \Which process data is displayed on the individual HMI device
e \Which plant components are controlled by this HMI device

The configuration engineer stores this information in the project's screens. The project is
transferred to the HMI device during commissioning.

After transfer to the HMI device, current processes can be operated and monitored in the
project's screens. The screens enable you to observe, for example, operational states,
current process data and faults in a plant. Operating elements which are used to operate the
process, for example buttons, I/O fields and alarm windows, are displayed in the screens.

Operator input options

The hardware of the HMI device determines which of the following operator control options
are available:

® Touch screen

The operator controls shown in the figures are touch-sensitive. They are basically
operated in the same way as mechanical keys. You activate operator controls by
touching them with your finger. To double-click them, touch an operator control twice in
succession.

e External keyboard, connected via USB

o FExternal mouse, connected via USB

A\ crution

Do not use any pointed or sharp objects when operating the touch screen. Otherwise
this may damage the plastic membrane of the touch screen.

The following provides instructions for operating a project with the touch screen and the
keyboard.

MP 177 (WinCC flexible)
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8.1 Overview

Operating a project with an external keyboard

An external keyboard can be used to operate a project in exactly the same way as with the
HMI keyboard or screen keyboard.

Note

The function keys of the external keyboard are disabled.

Use the other keys of the external keyboard, which correspond to the HMI device keys in the
description.

Operating a project with an external mouse

An external mouse can be used to operate a project in exactly the same way as with the HMI
touch screen. Click the described operator controls with the mouse.

Unintentional actions

A\ crution

Do not carry out several operations simultaneously. Always touch only one operating
element on the screen. You may otherwise trigger unintentional actions.

Observing the plant documentation

Some operations with the project may require in-depth knowledge about the specific plant on
the part of the operator. Proceed with caution, for example, when you use jog mode. Refer to
your plant documentation to find any additional information on this topic.

Operation feedback from operator controls

The HMI device provides operation feedback as soon as it detects that an operating element
has been selected. This operation feedback is independent of any communication with the
PLC. Therefore, this operation feedback does not indicate whether the relevant action is
actually executed or not.

MP 177 (WinCC flexible)
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8.1 Overview

Optical feedback from operating elements

The operator control receives the focus and is selected. The configuration engineer can also
configure the selection of an operator control so that it deviates from the standard. Refer to
your plant documentation to find any additional information on this topic.

The type of optical feedback depends on the operator control:

® Buttons

MP 177 (WIinCC flexible)

The HMI device outputs different views of the "Pressed" and "Unpressed" states,
provided the configuration engineer has configured a 3D effect:

"Pressed" state:

"Unpressed" state:

The configuration engineer determines the appearance of a marked field, for example,
line width and color for the focus.

Invisible buttons

By default, invisible buttons are not displayed as pressed when they are touched. No
optical operation feedback is provided in this case.

The configuration engineer may, however, configure invisible buttons so that their outline
appears as lines when touched. This outline remains visible until you select another
operator control.

I/O fields

When you select an I/O field, the content of the 1/O field is displayed against a colored
background. With touch operation, a screen keyboard is displayed for the entering of
values.
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8.2 Direct Keys

8.2 Direct Keys

Introduction

Direct keys

See also

Direct keys on the HMI device are used to set bits in the 1/0 area of a SIMATIC S7.

Direct keys enable operations with short reaction times that are, for example, a jog mode
requirement.

NOTICE

Direct keys are still active when the HMI device is in "offline" mode.

Note

You can only use direct keys when there is a connection via PROFIBUS DP or
PROFINET IO.

Direct keys result in additional basic load on the HMI device.

Buttons can be configured as a direct key:

You can also define image numbers in the case of HMI devices with touch operation. In this
way, the project engineer can configure the direct keys on an image-specific basis.

Further information on configuring direct keys can be found in the
"WinCC flexible Communication" system manual.

Enabling PROFINET IO (Page 91)
Bit Assignment of the Direct Keys (Page 203)

8.3 Setting the project language

Introduction

Requirements

138

The HMI device supports multilingual projects. You must have configured a corresponding
operating element which lets you change the language setting on the HMI device during
runtime.

The project always starts with the language set in the previous session.

® The required language for the project must be available on the HMI device

® The language switching function must be logically linked to a configured operating
element such as a button

MP 177 (WinCC flexible)
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8.4 Input

Selecting a language

You can change project languages at any time. Language-specific objects are immediately
output to the screen in the new language when you switch languages.

The following options are available for switching the language:
® A configured operating element switches from one language to the next in a list
® A configured operating element directly sets the desired language

Please refer to your system documentation to check whether additional information on this
subject is available there.

See also

Changing regional settings (Page 76)
8.4 Input
8.4.1 Overview

Screen keyboard

When you touch an operating element requiring entry on the HMI device touch screen, a
screen keyboard appears. The screen keyboard is displayed in the following cases:

® An |/O field is selected for input
® A password must be entered for accessing a password-protected function
The screen keyboard is automatically hidden again when input is complete.

Based on the configuration of the operating element, the system displays different screen
keyboards for entering numerical or alphanumerical values.

Note

The screen keyboard display is independent of the configured project language.

General procedure
The operating elements of a screen are operated by touching the touch screen.
Proceed as follows:
1. Touch the desired operating element within the screen.

2. Depending on the operating element, perform further actions. Detailed descriptions can
be found under the respective operating element.

Examples:
— 1/O field: Enter numerical, alphanumerical or symbolic values in the I/O field
— Symbolic I/O field: Select an entry from the drop down list box

— Slider control: Move the slider control

MP 177 (WinCC flexible)
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8.4 Input

Procedure for text boxes

Values are entered in the project text boxes. Based on your configuration, the values are
saved to tags and transferred, for example, to the PLC.

Proceed as follows:
1. Touch the desired text box within the screen.
The screen keyboard opens.

Depending on your configuration, you can enter values in the text box in the following
manner:

— Numerical values, for example decimal numbers, hexadecimal numbers, binary values
— Alphanumerical values, for example digits and letters
— Date/time

2. Enter the value.

3. Confirm your entry with 4|"E or discard your entry with the button El

8.4.2 Entering and editing numerical values

Numerical screen keyboard

When you touch an operating element for numerical input on the HMI-device touch screen,
the numerical screen keyboard appears. This is the case, for example, for a text box. The
screen keyboard is automatically hidden again when input is complete.

7 g |« [EIx]

4 6 Del | Ins
1 3 <J INum Help

0- . |Esc| <= |—»

NG

Numerical screen keyboard

Note
Opened screen keyboard

When the screen keyboard is open, PLC job 51, "Select Screen" has no function.

MP 177 (WinCC flexible)
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8.4 Input

Formats for numerical values
You can enter values in numerical text boxes based on the following formats:
® Decimal
® Binary

® Hexadecimal

Note
Entry of hexadecimal values

When you enter values in hexadecimal format, the alphanumerical screen keyboard
opens.

Limit value test of numerical values

Tags can be assigned limit values. If you enter a value that lies outside of this limit, it will not
be accepted, for example, 80 with a limit value of 78. In this case the HMI device will deliver
a system alarm, if an alarm window is configured. The original value is displayed again.

Decimal places for numerical values

The configuration engineer can define the number of decimal places for a numerical text box.
The number of decimal places is checked when you enter a value in this type of I/O field.

® Decimal places in excess of the limit are ignored

® Empty decimal places are filled with "0"

Procedure

Numerical values can be entered character-by-character via the buttons on the numerical
screen keyboard.

Proceed as follows:
1. Touch the desired operating element within the screen.

The numerical screen keyboard opens. The existing value is displayed in the screen
keyboard and is selected.

2. Enter the value.

The keys with for example the letters G to Z are available to enter a hexadecimal value;
however, the characters are not entered. Depending on the settings, the HMI device
issues an acoustic signal.

You have the following options to enter a value:

— The selected value is deleted when you enter the first character. Completely reenter
the value.

MP 177 (WinCC flexible)
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8.4 Input

- Usethe il and il keys to move the cursor within the current value. You can

now edit the characters of the current value or add characters.

Use the = | key to delete the character to the left of the cursor. If the value is

selected, use this key to delete the selected part of the value.

The Del | key deletes the character positioned to the right of the cursor. If the value is

selected, use this key to delete the selected part of the value.

— Use the ﬂl key to display the infotext of the I/O field.

This button is only enabled if infotext has been configured for the input object or the
current screen.

3. Use the 4|"‘E key to confirm your entry or cancel it with ESC

screen keyboard.

. Either action closes the

Result
You have changed the numerical value or entered a new one.

8.4.3 Entering and editing alphanumerical values

Alphanumerical screen keyboard

When you touch an operating element for alphanumerical input on the HMI-device touch
screen, the alphanumerical screen keyboard appears. This is the case, for example, for a
text box. The screen keyboard is automatically hidden again when input is complete.

“[1lz2[3]as]e[7]e]o]o]-[=]«— [E X

_quert¥Ui0p[]JInsHome|;|

g0 a|s|d|{flg|h|[j|k|[I];]|"]|\ Del | End | ¥y
tly|z|x|ec|lv|b{n|m| | .| /| © |&c| um|$ |Help
T - | Lt | 4|

Alphanumerical screen keyboard, normal level

Note
Opened screen keyboard

When the screen keyboard is open, PLC job 51, "Select screen" has no function.
Language change

Language change in the project has no influence on the alphanumerical screen keyboard.
The entry of Cyrillic or Asian chracters is therefore not possible.

MP 177 (WinCC flexible)
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8.4 Input

Keyboard levels
The alphanumerical screen keyboard has various levels.
e Normal level
e Shift level

If you change the levels with key = | the key assignments change.

Procedure
Alphanumerical values can be entered character-by-character via the buttons on the
alphanumerical screen keyboard.
Proceed as follows:
1. Touch the desired operating element within the screen.
The alphanumerical screen keyboard opens. The existing value is displayed in the screen
keyboard and is selected.
2. Enter the value.
You have the following options to enter a value:
— The selected value is deleted when you enter the first character. Completely reenter
the value.
- Usethe il and il keys to move the cursor within the current value. You can
now edit the characters of the current value or add characters.
Use the = | key to delete the character to the left of the cursor. If the value is
selected, use this key to delete the selected part of the value.
The Del | key deletes the character positioned to the right of the cursor. If the value is
selected, use this key to delete the selected part of the value.
- Usingkey o | it is possible to switch between the keyboard levels of the screen
keyboard. On switchover, the key assignments of the screen keyboard change.
— Use the ﬂl key to display the infotext of the I/O field.
This key is only enabled if infotext has been configured for the input object or the
current screen.
3. Use the 4|"‘E key to confirm your entry or cancel it with ESC| Either action closes the
screen keyboard.
Result

You have changed the alphanumeric value or entered a new one.

MP 177 (WinCC flexible)
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8.4 Input

8.4.4

Entering the date and time

Entering the date and time

See also

8.4.5

Enter the date and time in the same way you enter alphanumerical values.

Note

When entering the date and time, please note that the format is determined by the
configured project language.

Entering and editing numerical values |(Page 140)

Entering and editing alphanumerical values (Page 142)

Entering symbolic values

Drop down list box

Procedure

Result

144

Operating elements for entering symbolic values offer you a list from which you can select
the input values. When you touch a symbolic I/O field on the HMI device touch screen, the
following drop down list box opens.

Symbolic I/O field after touch, example

Proceed as follows:

1. Touch the required operating element.
The drop down list box of the operating element opens. Select =l and 2l to scroll in the
drop down list box.

2. Touch the required entry in the drop down list box.

The selected entry is accepted as an entry.

You have changed the symbolic value or entered a new one.

MP 177 (WinCC flexible)
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8.5 Displaying infotext

Purpose

The configuration engineer uses infotext to provide additional information and operating
instructions. The configuration engineer can configure infotext on screens and operating
elements.

The infotext of an I/O field may contain, for example, information on the value to be entered.

Enter termperature setpoint for Tank_1
{Range 40...80 =C)

Infotext for an 1/O field, example

Opening infotext for operating elements
1. Touch the required operating element.

The screen keyboard opens. You can see from the appearance of the Hﬂ'Pl key whether

infotext has been configured for the operating element or the current screen.

2. Touch the ﬂl key on the screen keyboard.

The infotext for the operating element is displayed. If there is no infotext for the selected
screen object, the infotext for the current screen is displayed, if it has been configured.

You can scroll through the contents of long infotext with =land =1,

Note
Switching between displayed infotext

The configuration engineer can configure infotext for an I/O field and the associated
screen. You can switch between two infotexts by touching the infotext window.

3. Close the displayed infotext by pressing .

Alternative procedure

Depending on your configuration, infotext can also be called via a configured operating
element.

Please refer to your system documentation to check whether additional information on this
subject is available there.
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8.6 Bar and gauge

8.6 Bar and gauge

Bar

Layout

Gauge

Layout

Operation
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The bar is a dynamic display object. The bar displays a value from the PLC as a rectangular
area. The bar allows you to recognize the following at a glance:

® The distance of the current value from the configured limit values
e \Whether a set point value has been reached

The bar can display values such as fill levels or batch counts.

100

&0
30
0

The layout of the bar depends on the configuration:
® The bar may feature a scale of values
® The configured limit values can be indicated by lines

® (Color changes can signal when a limit value has been exceeded or has not been reached

The gauge is a dynamic display object. The gauge displays numerical values in analog form
by means of a pointer. This enables an operator at the HMI device to see at a glance if the
boiler pressure is in the normal range, for example.

The layout of the gauge depends on the configuration:

® A trailing pointer can display the maximum value reached so far on the scale. The trailing
pointer is reset when the screen is reloaded

® The label on the scale can show the measured variable, for example boiler pressure and
the physical unit, for example bar

The bar and the gauge are for display only. Both objects cannot be controlled by the
operator.

MP 177 (WinCC flexible)
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8.7

Introduction

Layout

Procedure

Result

8.7 Operating the swifch

Operating the switch

The switch is an operating element and display object with two predefined switching states,
for example "On" and "Off". Switches can signalize the state of a plant section, for example if
a motor is running or not. At the same time, you can use the switch to change the state of
the corresponding plant section via the HMI device, for example from "On" to "Off".

The layout of the switch depends on the configuration:
® Switch with slider
The two states are displayed by the position of the slider

Swyitch

) Slider

e Switch with text or graphic

The two states are displayed by the label on the slider

Depending on the switching state, the switch is labeled with one of two texts or one of two
graphics.

Examples:

"Backward" or "Forward"

e Switch with slider

Proceed as follows:

Move the slider to the other position or double-click the slider area
e Switch with text or graphic

Proceed as follows:

Touch the switch

The switch changes its appearance. The associated value is switched.

MP 177 (WinCC flexible)
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8.8 Operating the slider contro/

8.8 Operating the slider control

Introduction
The slider control can be used to monitor and change process values within a defined range.
The slider control can also be configured without a slider. In this case, you cannot enter a
value. The slider control is then only used for displaying values.
SIMATIC
100 =
0] Slider control for entering values
® Value display with current value
Slider control — example
Layout
The layout of the slider control depends on the configuration:
® The slider control can contain a label and a setting range
® The current value can be displayed below the area of the slider control
Procedure
Proceed as follows:
1. Touch the slider of the desired slider control.
2. Move the slider to the required value.
If a value display has been configured, you can check the exact value that has been set.
3. Release the slider.
Result

The set value is applied.
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8.9 Operating the Trend View

Trends
Trends continuously display the current process data.

Trend view

Trends are displayed in the trend view. A trend view can display several trends
simultaneously.

1007 _\_I_I_H—_.'—\_;'lEIEI

@ Ruler
@ Trend value in the value table

Trend view, example

Layout and operation

The layout and operation of the trend view depends on the configuration. The configuration
engineer determines, for example, the following:

® Appearance of the trend view, the axes, value ranges and labels
® Operating options of the trend view

® |imit values for the trend values

® The change of color of the trend in the event of limit violation

Refer to your plant documentation to find any additional information on this topic.

Value table
The trend values can be read from the value table if this is configured:

® When the ruler is displayed, the trend values are shown at a position of the ruler in the
value table

o \When the ruler is hidden, the latest trend values are displayed in the value table

MP 177 (WinCC flexible)
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8.10 Operating the Status Force

Ruler

Operation

8.10

8.10.1

Application

150

When configured, a ruler is available to provide an exact reading of the trend values in the
value table.

You can move the ruler to the desired position of the trend view.

The trend view can be operated as follows:

® Enlarge or reduce the time interval displayed
e Scroll forward or back by one display width
e Stop and resume trend recording

® Move the ruler

e Hide and display the ruler

The configuration engineer can configure function keys or operating elements used to
operate the trend view.

Refer to your plant documentation to find any additional information on this topic.

Operating the Status Force

Overview

You read or write access values of the connected PLC directly with Status Force. Status
force allows you to monitor or change addresses of the PLC program, etc. You don't need to
connect an additional programming device or additional PC to the PLC.

Note

Status force can only be used in combination with SIMATIC S7.

MP 177 (WinCC flexible)
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8.10 Operating the Status Force

Layout
The layout of Status Force depends on the configuration.

The figure shows the general layout of Status Force. A value can be monitored or controlled
on every line.

CDnnectiDnl Typel Oﬂ‘aetl FDrmatl Control Yalue | |l
FLC_1 il 120 | DEC 33
FLC_1 T 40 T 24,00
FLC_1 o} 50 DEC oj.—
FLC_1 o} 50 HEX 000
4] | ;IJ
A

Status Force, example

The configuration engineer specifies which columns appear in Status Force.

The table shows the significance of all configurable columns.

Column Functions

"Connection" The PLC whose address ranges must be displayed.

"Type", "DB Number", "Offset", "Bit" | The address range of the value

"Data type", "Format" The data type of the value
"Status value" The value read from the specified address.
"Control value" The value to be written to the specified address.

Please refer to your system documentation to check whether additional information on this
subject is available there.

Operator controls
Depending on your configuration, you can operate the trend view using the following buttons:

Buttons Functions

e "Read" button

Updates the display in the "Status value" column.

This button engages when it is pressed. You cannot operate any text boxes until
the button is actuated again and the refresh is stopped.

A "Write" button

Applies the new value in the "Control value" column. The control value is written
to the PLC.

MP 177 (WinCC flexible)
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8.10 Operating the Status Force

8.10.2 Operation

Operator input options
Status Force can be operated as follows:
® Change the column sequence
® Read the status values of the connected PLC

® Enter values and transfer them to the PLC

Change column sequence
Depending on the configuration, you can change the column sequence of Status Force.
Proceed as follows:
1. Touch the column header which you wish to exchange with a different column header

2. Keeping the touch screen pressed, move the column heading to the column heading you
wish to exchange it with

Result
The columns are displayed in the modified sequence.

Procedure for reading the status value
Proceed as follows:
1. Enter the address and the desired format of a value for each line. Touch the respective
columns to display the screen keyboard.

2. Once you have entered all of the desired values, touch the $ button.

Result

All values are read cyclically by the PLC and entered in the "Status value" column until the

& button is touched again.

Requirements for forcing
The following requirements must be fulfilled in order to force values:

® The "Control value" column must be available

® The "Write" button must be available

MP 177 (WinCC flexible)
152 Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0



Operating a project

8.11 Operating the Sm@rtClient view

Procedure for forcing a value

Result

8.11

8.11.1

Application

Layout

Monitoring mode

Operation

Proceed as follows:

1. Enter the address of a value for each line. Enter the desired value in the "Control value"
column. Touch the respective columns to display the screen keyboard.

2. Once you have entered all of the desired values, touch the # button.

The values from the "Control value" column are transferred once to the PLC.

Operating the Sm@rtClient view

Overview

The Sm@rtClient view enables you to monitor and remotely operate the current project of a
remote HMI device. With the correct configuration, several equal priority HMI devices can
access a remote HMI device.

Note

If another HMI device accesses your HMI device via the Sm@rtClient view, this leads to an
additional load on your HMI device.

In the Sm@rtClient view, the remote HMI is displayed with the complete layout.
Depending on the configuration, you can monitor and also operate this screen.

You can also operate the function keys like buttons on an HMI device with a touch screen.

On a Sm@rtClient view which is configured for monitoring mode, you can only monitor the
remote HMI device. You cannot control its operation.

Note

It is not possible to operate the direct keys of the remote HMI device from the local HMI
device.

MP 177 (WinCC flexible)
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8.117 Operating the Sm@rtClient view

The available operator controls depend on the HMI devices used:

e Same type of HMI devices

You can operate the project of the remote HMI device with the operator controls of your
HMI device

Operate keys from a local touch screen

All the keys of the remote HMI device are displayed as buttons on the touch screen. You
can touch them to operate them.

Touch operation from a local HMI device using keys

You operate the buttons in the usual manner.

8.11.2 Operation

Operator input options
The Sm@rtClient view can be operated as follows:

e Starting remote control

® Forcing permission

e Ending remote control

Procedure for starting remote control

154

Proceed as follows:

On the HMI device change to the screen with the Sm@rtClient view.

The following options are available for establishing the connection to the remote HMI
device:

— The connection is established automatically.
— The connection must be established by touching the appropriate button.

Depending on the configuration, you may be required to enter the address of the
remote HMI device and a password.

. The current screen of the project running on the remote device is displayed on the screen

of your HMI device.

. You can now monitor or control this screen depending on your configuration.

Scroll bars are displayed if the screen of the remote HMI device is larger than that of the
current HMI device.

MP 177 (WinCC flexible)
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8.12 Project security

Procedure for forcing permission

If several HMI devices have access to a HMI device, only one HMI device has operating
permission at any one time.

Two cases must be distinguished for this case:

e |f another HMI device is already controlling the remote HMI device, if configured
accordingly, you can force operating permission for the remote HMI device

— You are trying to operate the remote HMI device

— A dialog appears in which you are prompted to enter the appropriate password for
forcing remote control

— You are now authorized to operate the remote HMI device

e [f another HMI device is accessing your HMI device via the Sm@rtClient view, you can
force local operating permission for your HMI device

— Touch the screen of your HMI device five times consecutively

— You are given permission to operate your local HMI device

Procedure for ending remote control

You can end monitoring and control of a remote HMI device with one of the following
methods depending on the configuration:

® Touch a button configured for this action
e Exit the screen containing the Sm@rtClient view

e |f configured, a menu is displayed after you have touched an empty space over a longer
period. Select the "Close" menu item.

Please refer to your system documentation to check whether additional information on this
subject is available there.

8.12 Project security

8.12.1 Overview

Design of the security system

The configuration engineer can protect the operation of a project by implementing a security
system.

The security system is based on authorizations, user groups and users.

If operating elements protected by a password are pressed, the HMI device first requests
that you log on. A logon screen is displayed in which you enter your user name and
password. After logging on, you can press the operating elements for which you have the
necessary authorizations.

The logon dialog can be set up by the configuration engineer via an individual operating
element.

MP 177 (WinCC flexible)
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8. 12 Project security

In the same way, the configuration engineer can set up an operating element to log off. After
logging off, objects assigned password protection can no longer be operated; to do so, log
on again.

Please refer to your system documentation to check whether additional information on this
subject is available there.

Central user administration using SIMATIC Logon

Users, user groups and authorizations can be stored on a central server.

If user administration cannot contact the server, an error message is displayed. If this is the
case, you can only log on locally. Check whether additional information is available in your
plant documentation.

The operation of SIMATIC Logon differs as follows:

® The simple user display is not supported

® Users cannot be deleted

® You cannot change your logout time

® \When changing the password, you must enter it twice for security reasons

® The domain name is also indicated in the "User" field

User groups and authorizations

Project-specific user groups are created by the configuration engineer. The "Administrators™
and "PLC User" groups are included in all projects by default. User groups are assigned
authorizations. Authorization required for an operation is specifically defined for each
individual object and function in the project.

Users and passwords

Logoff times

156

Each user is assigned to exactly one user group.

The following persons are allowed to create users and assign them passwords:
® The configuration engineer during configuration

® The administrator on the HMI device

® A user with user management authorization on the HMI device

Irrespective of the user group, each user is allowed to change his own password.

A logoff time is specified in the system for each user. If the time between any two user
actions, such as entering a value or changing screens, exceeds this logoff time, the user is
automatically logged off. The user must then log on again to continue to operate objects
assigned password protection.

MP 177 (WinCC flexible)
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8.12 Project security

Backup and restore

Note
Backup and restore is not available to central user administration with SIMATIC Logon.

The user data is encrypted and saved on the HMI device to protect it from loss due to power
failure.

The users, passwords, group assignments and logoff times set up on the HMI device can be
backed up and restored. This prevents you having to enter all of the data again on another
HMI device.

NOTICE

The currently valid user data is overwritten in the following cases:
e Depending on the transfer settings, when the project is transferred again
e Upon restore of a backed-up project

¢ Upon import of the user administration via an operating element. Please refer to your
system documentation to check whether additional information on this subject is
available there.

The retransferred or restored user data and passwords are valid with immediate effect.

Limits for user, password and user view

8.12.2

Application

Number of characters
Length of user name, maximum 40
Length of password, minimum 3
Length of password, maximum 24
Entries in user view, maximum 50

User view

The user view is used to display the users on the HMI device:

e All users on the HMI device are displayed in the user view to the administrator or to a
user with administrator authorizations

® |f you are a user without user management authorization, you can only see your personal
user entry

The authorizations of a user after logging on depends on the user group to which the user is
assigned.

Please refer to your system documentation to check whether additional information on this
subject is available there.
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8. 12 Project security

Layout

The configuration engineer can implement a simple or extended user view.

The two user views offer the same functions. They differ only in the display of information.

Simple user view

If you are not logged on to the HMI device, the only entry contained in the simple user view
is "<ENTER>".

If you are logged on to the HMI device, the simple user view only displays the user name
and user group.

Group =)
PLC User Group (1)
Uzer 1 Group (1)
<ew Lisers=

Extended user view

The extended user view displays information about the users.

Logoff time

| Croup (5 5

PLC User

Uger 1 | *#*#**rs | Group (1) 5

Aok ok ok ok ok GrDup (1:] 5

1]

| E

The extended user view contains the following columns:

Users
Password
Group
Logoff time

The passwords are encrypted by appearing as asterisks.
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8.12 Project security

8.12.3 User Logon

Logon dialog

Requirement

Procedure

Result

Use the logon dialog to log on to the security system of the HMI device. Enter your user
name and password in the logon dialog.

x

Lser: I

Password: I

(04 | Cancel |

The logon dialog opens in the following cases:

You press an operator control with password protection

You press an operator control that was configured for displaying the logon dialog
Select the "<ENTER>" entry in the simple user view

Select a blank entry in the extended user view

The logon dialog will be automatically displayed when the project is started, depending on
the configuration

Refer to your plant documentation to find any additional information on this topic.

The logon dialog is open.

Proceed as follows:

1.

Enter the user name and password.
Touch the corresponding text box. The alphanumerical screen keyboard is displayed.

Select "OK" to confirm logon.

Note
The user name is not case-sensitive.

The password is case-sensitive.

After successful logon to the security system, you can execute password-protected functions
on the HMI device for which you have authorizations.

If you enter a wrong password, an error message is displayed when an alarm window has
been configured.
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8. 12 Project security

8.124 User logoff

Requirements
You have logged into the security system of the HMI device.

Procedure
You have the following options for logging off:
® You press an operating element that was configured for logoff
e You will be logged off automatically if you are not operating the project and if the logoff
time has been exceeded
You will also be automatically logged off if you enter an incorrect password.
Result

You are no longer logged into the project. In order to activate an operating element with
password protection, you must first log on again.

8.12.5 Creating users

Requirements
You have opened a screen containing the user view.

You have user management authorization or you are the administrator.

NOTICE

The following characters cannot be used in passwords:
e Blank
e Special characters *? . % /\""

MP 177 (WinCC flexible)
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8.12 Project security

Procedure for creating a user in the simple user view

Proceed as follows:

1.

Touch the "<New User>" entry in the user view.

The following dialog opens:
I x|

Liser: I

Password: I

Ok | Cancel |

. Enter the desired user name and password.

Touch the corresponding text box. The alphanumerical screen keyboard is displayed.
Touch the "OK" button.

The following dialog opens:

DN x|
Gravip: |Group (1) |

Logoff time: |5

o ]

Cancel |

. Assign the user to a group.

In order to do so, open the "Group" drop down list box by means of the =l button. Select

~land =l to scroll in the drop down list box.

. Touch the required entry in the drop down list box.

The selected entry is then accepted as input.

6. Touch the text box "Logoff time". The screen keyboard is displayed.

7. Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for "no

automatic logoff."

. Touch the "OK" button to confirm your entries.

Procedure for creating a user in the extended user view

Proceed as follows:

1.

MP 177 (WIinCC flexible)
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Double-click the desired field in the blank line of the user view.

The appropriate screen keyboard is displayed.

. Enter the respective user data in the field:

— Assign the user to one of the groups from the drop down list box.

— Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for
"no automatic logoff."
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8. 12 Project security

Result
The new user is created.

8.12.6 Changing user data

Requirements
You have opened a screen containing the user view.
Which data you are allowed to change depends on your authorization:

® You are an administrator or a user with user management authorization. In these cases
you are allowed to change the data for all the users on the HMI device in the user view:

User name

Group assignment

Password

Logoff time

® You are a user without user management authorization. In this case you are only allowed
to change your personal user data:

— Password

— Logoff time, if configured

Note
You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging
on via the PLC

Procedure for changing user data in the simple user view
Proceed as follows:
1. In the user view, touch the user whose user data you want to change

2. When entering the data, use exactly the same procedure as for creating a user

Procedure for changing user data in the extended user view
Proceed as follows:
1. In the user view, touch the user whose user data you want to change

2. When entering the data, use exactly the same procedure as for creating a user

Result
The user data for the user is changed.
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8.13 Closing the project

8.12.7 Deleting users

Requirements
You have opened a screen containing the user view.

To delete a user, you must be an administrator or have user management authorization.

Note

The "Admin" and "PLC_User" users exist by default. These users cannot be deleted.

Procedure

To delete a user, delete the user name entered.

Result

The user has been deleted and may no longer log onto the project.

8.13 Closing the project

Procedure
Proceed as follows:
1. Use the corresponding operating element object to close the project.
Wait for the Loader to open after you closed the project.
2. Switch off power to the HMI device.

MP 177 (WinCC flexible)
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8.13 Closing the project
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Operating alarms

9.1 Overview

Alarms

Alarms indicate events and states on the HMI device which have occurred in the system, in
the process or on the HMI device itself. A status is reported when it is received.

An alarm could trigger one of the following alarm events:

Incoming
Outgoing

Acknowledge

The configuration engineer defines which alarms must be acknowledged by the user.

An alarm may contain the following information:

Alarm classes

Date

Time

Alarm text
Location of fault
State

Alarm class
Alarm number
Alarm group

Diagnostics capability

Alarms are assigned to various alarm classes:

MP 177 (WIinCC flexible)

Error

Alarms in this class must always be acknowledged. Error alarms normally indicate critical
errors within the plant such as "Motor temperature too high"

Operation

Warning alarms usually indicate states of a plant such as "Motor switched on"
System

System alarms indicate states or events which occur on the HMI device
SIMATIC diagnostic alarms

SIMATIC diagnostic alarms show states and events of the SIMATIC S7 or SIMOTION
PLCs
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9.2 Recognizing pending alarms

® User-specific alarm classes
The properties of this alarm class must be defined in the configuration

Refer to your plant documentation to find any additional information on this topic.

Alarm groups

The configuration engineer can group alarms into alarm groups. When you acknowledge an
individual alarm of an alarm group, you acknowledge all alarms which belong to the same
alarm group.

Alarm buffer
The alarm events are stored in an internal buffer. The size of this alarm buffer depends on
the HMI device type.

Alarm report
The configuration engineer can activate alarm reporting on the project. In this case, alarm
events are output directly on the connected printer.
The configuration engineer can define whether each individual alarm is logged. An alarm of
this type is printed when the alarm events "Incoming" and "Outgoing" occur.
If you want to print alarms of the "System" alarm class, you have to print the contents of the
associated alarm buffer. For this case the configuration engineer has to configure an
operating element for printing the alarm buffer.

9.2 Recognizing pending alarms
You can recognize pending alarms that must be acknowledged by means of the alarm
indicator.

The alarm indicator is a graphic symbol indicating pending alarms or alarms requiring
acknowledgment, depending on the configuration. The configuration determines whether an
alarm has to be acknowledged or not. This is also defined by the alarm class which an alarm
belongs to.

/\

Alarm indicator with three pending alarms

The alarm indicator flashes as long as alarms are pending for acknowledgment. The number
displayed indicates the number of pending alarms. The configuration engineer can assign
functions to be executed when the alarm indicator is operated.

Usually, the alarm indicator is only used for error alarms. Please refer to your system
documentation to check whether additional information on this subject is available there.
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9.3 Displaying alarms

9.3 Displaying alarms

Displaying alarms
Alarms are displayed in the alarm view or in the alarm window on the HMI device.

Alarm view
Depending on the configuration, the alarm view is displayed as follows:
® As a single line. Alarm numbers and alarm texts are displayed as single lines
® As simple alarm view
® As extended alarm view

In the simple or extended alarm views the configuration engineer specifies the alarm
information to be displayed.

Depending on the configuration, alarms from alarm logs are also displayed in the alarm view.

Simple alarm view

19.04.2005 11:41:37 ! 1 "
Motor 23 too hot t
¥

ﬂ J

The buttons have the following functions:

Buttons Functions

Displaying infotext for an alarm.

Process alarm.

Acknowledge alarm.

Select the next or previous alarm in the list.

Scroll one page up or down.

EEEE
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9.3 Displaying alarms

Extended alarm view

| |No. |Time |Date |Status
11 12:04:59 19.04.2005 K

Motor 23 too hot

& | F |

The buttons have the following functions:

Buttons Functions

Displaying infotext for an alarm.

Process alarm.

(h]

Acknowledge alarm.

Changing the column sequence and sorting in the extended alarm view

Depending on the configuration, you can change the column sequence and sorting order on
HMI devices with touch operation.

e Change column sequence
— Touch the column header which you wish to exchange with a different column header

— Keeping the touch screen pressed, move the column heading to the column heading
you wish to exchange it with

® Change sorting order

To change the sorting order of the alarms, touch the respective column header on the
touch screen

Alarm class layout

The various alarm classes are identified in order to distinguish between them in the alarm

view.

Symbol Alarm class

! Error

Without a symbol Operation

Symbol depending on the configuration | User-defined alarm classes

S7 SIMATIC or SIMOTION diagnostic alarms
$ System

The configuration engineer can change the symbols for the alarm classes. Please refer to
your system documentation to check whether additional information on this subject is
available there.
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Alarm window

9.4 Display infotexts for an alarm

The alarm window is independent of the process screen. Depending on the configuration,
the alarm window opens automatically as soon as a new alarm is pending for
acknowledgment. The alarm window can be configured so that it only closes after all the
alarms have been acknowledged.

The layout and the operation of the alarm window are the same as for the alarm view.

Please refer to your system documentation to check whether additional information on this
subject is available there.

94 Display infotexts for an alarm

Displaying infotext

Procedure

See also

The configuration engineer can also provide infotext for alarms.

Proceed as follows:
1. Touch the desired alarm in the alarm view or the alarm window.

The alarm is selected.

2. Touch the j button in the simple alarm view or in the extended alarm view.

If configured, the infotext assigned to this alarm is displayed.

3. Close the screen for displaying the infotext by means of the button.

Displaying alarms (Page 167)

9.5 Acknowledge alarm

Requirements

Procedure

The alarm to be acknowledged is displayed in the alarm window or the alarm view.

Proceed as follows:
1. Touch the desired alarm in the alarm view or the alarm window.

The alarm is selected.

2. Touch the J button in the simple alarm view or il in the extended alarm view.

MP 177 (WinCC flexible)
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9.6 Edit alarm

Alternative operation

Result

See also

Depending on the configuration, you can also acknowledge an alarm with a function key.

The alarm is acknowledged. If the alarm belongs to an alarm group, all the alarms of the
associated group are acknowledged.

Please refer to your system documentation to check whether additional information on
acknowledgment and available alarm groups is available there.

Displaying alarms (Page 167)

9.6 Edit alarm

Introduction

Requirements

Procedure

Result

See also

170

The configuration engineer can assign additional functions to each alarm. These functions
are executed when the alarm is processed.

Note
When you edit an unacknowledged alarm, it is acknowledged automatically.

The alarm to be edited is displayed in the alarm window or the alarm view.

Proceed as follows:

1. Touch the desired alarm in the alarm view or the alarm window. The alarm is selected.

2. Touch the ﬂ button in the simple alarm view or Ll in the extended alarm view.

The system executes the additional functions of the alarm. Please refer to your system
documentation to check whether additional information on this subject is available there.

Displaying alarms (Page 167)
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10.1 Overview

Introduction

Recipes are used when different variants of a product are manufactured with the same
process. In this case, the product variants differ in terms of their type and quantity of the
components, but not in terms of the manufacturing process sequence. The configuration
engineer can store the combination of each individual product variant in a recipe.

Field of application

Recipes can be used everywhere the same product components are used in variable
combinations to create different product variants.

Examples:

® Beverage industry

® Food processing industry
® Pharmaceutical industry

® Paint industry

e Building materials industry

e Steel industry

MP 177 (WinCC flexible)
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10.2 Structure of a recijpe

10.2

Recipes

172

Structure of a recipe

The recipe collection for the production of a product family can be compared to a file cabinet.
A recipe which is used to manufacture a product corresponds to a drawer in a file cabinet.

Example:

In a plant for producing fruit juice, recipes are required for different flavors. There is a recipe,
for example, for the flavors orange, grape, apple and cherry.

®

®

©

®

v
</
' 4
<« /
[
©O) File cabinet Recipe collection
@ Drawer Recipe
® Drawer Recipe
0] Drawer Recipe
® Drawer Recipe

C)

Recipes for a fruit juice plant
Orange flavored drinks
Grape flavored drinks

Apple flavored drinks
Cherry flavored drinks
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10.2 Structure of a recipe

Recipe data records

The drawers of the file cabinet are filled with suspension folders. The suspension folders in
the drawers represent records required for manufacturing various product variants.

Example:

Product variants of the flavor apple might be a soft drink, a juice or nectar, for example.

ONONONO

—

Drawer Recipe Product variants of apple flavored drinks
Suspension folder  Recipe datarecord  Apple drink
Suspension folder Recipe data record  Apple nectar

® 00

Suspension folder  Recipe data record  Apple juice

Elements

In the figure showing the file cabinet, each suspension folder contains the same number of
sheets. Each sheet in the suspension folder corresponds to an element of the recipe data
record. All the records of a recipe contain the same elements. The records differ, however, in
the value of the individual elements.

Example:

All drinks contain the same components: water, concentrate, sugar and flavoring. The
records for soft drink, fruit juice or nectar differ, however, in the quantity of sugar used in
production.

MP 177 (WinCC flexible)
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10.3 Recipes in the Project

10.3 Recipes in the Project

Overview

174

If recipes are used in a project, the following components interact:

® Recipe view / recipe screen

On the HMI device, recipes are displayed and edited in the recipe view or in a recipe
screen.

— The recipe data records from the internal memory of the HMI device are displayed and
edited in the recipe view.

— The values of the recipe tags are displayed and edited in the recipe screen.

Depending on the configuration, the values displayed in the recipe view are synchronized
with the values of recipe tags.

HMI device recipe memory

Recipes are saved in the form of data records in the HMI device recipe memory.
The recipe data can also be saved in recipe tags.

Recipe tags

The recipe tags contain recipe data. When you edit recipes in a recipe screen, the recipe
values are stored in recipe tags. Depending on the configuration, the values of the recipe
tags are exchanged with the PLC.

The recipe tags can be synchronized with the recipe data records so that the same
values are saved in both.

External memory medium

Memory cards or USB sticks are external memory media for recipe data records. The
recipe data records are exported from the HMI device recipe memory and are saved on
the external memory medium in a *.csv file. The records can be reimported from the
external memory medium to the recipe memory.

MP 177 (WinCC flexible)
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Data flow

MP 177 (WinCC flexible)

10.3 Recipes in the Project

The following figure shows the data flow in a project with recipes.

HMI device Recipe Memory
Recipe display @ w

Recipe 1
/‘> 4 Recipe 2
/ « o= Recipe 3
1 @
Recipe Recipe tag A

@ f ~_ |
@

®

Controller External v

storage device

d

®

Editing, saving or deleting a recipe data record
Display recipe data record

Synchronize or do not synchronize recipe tags
Display and edit recipe tags in the recipe screen

Write records from the recipe view to the PLC or read records from the PLC and display them
in the recipe view

Recipe tags are sent to the PLC online or offline
Export or import recipe data record to external memory medium.

QO ©6e 600
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10.4 Recipe displays

10.4 Recipe displays

Displaying recipes
You can display and edit recipes on the HMI device with a recipe view or recipe screen.

Recipe view

A recipe view is a screen object used to manage recipe data records. The recipe view shows
recipe data records in tabular form.

Depending on the configuration, the recipe view is displayed as follows:
® As extended recipe view
® As simple recipe view

The configuration engineer also defines which operator controls are displayed in the recipe
view.

Extended recipe view
The following figure shows an example of the extended recipe view.

RFecipe Mame: Mo,
@7|Orange j | 1 4@
Data Record Mame: Ma.:

@7| Mectar j |2 4@
Enfry Mame YWalue 2
(B)———water a——5)
Concentrate o

Slalx]  ala)©

Selection box for the recipe

Selection box for the recipe data record

Element name
The element name designates a specific element in the recipe data record

Display field

This show the number of the selected recipe or the selected recipe data record
Value of the element

Buttons for editing a recipe data record

Status bar for display of the status messages

Qe © 606
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10.4 Recipe displays

Simple recipe view

Display of values

The simple recipe view consists of three areas:
® Recipe list

e Data record list

® Element list

In the simple recipe view, each area is shown separately on the HMI device. Depending on
the configuration, the simple recipe view starts with the recipe list or data record list.

The following figure shows an example of the record list.

1 Juice
2 Beverage -—
Nectar

3
O]
@
®

Number of the recipe data record
Recipe data records
Buttons for changing the displayed list and calling the menu

NOTICE
Changing the recipe data record in the background

Applies to the processing of a recipe data record:
If values of the corresponding recipe data record are changed by a PLC job, the recipe view
is not updated automatically.

To update the recipe view, reselect the respective recipe data record.
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10.4 Recipe displays

Recipe screen

178

A recipe screen allows the correlation between the plant and the recipe data to be displayed
in graphic form. The configuration engineer combines /O fields and screen objects to form a
custom input screen. The configuration engineer can distribute the 1/O fields of a recipe over
several recipe screens, thus allowing recipe elements to be arranged by subject. The recipe
screen can be operated using buttons configured accordingly.

The following figure shows an example of the recipe screen.

N ™
_ 40 - Recipe name No_:
\Concenirale ] 70 [ || [Orange UK
Sugar I 30 [kl || patarecordname  No
S ]|
( T
Save | Data from the PLC |
Load | Data to PLC |
@

® QD
Element name and associated values

The element name designates a specific element in the recipe data record
Buttons for editing a recipe data record

Modified recipe view

Buttons for transferring recipe data

®e 6 6

The values displayed or entered in the recipe screen are saved in recipe tags. The recipe
values are exchanged with the PLC immediately or later via these tags.

A configured recipe view can itself be a component of a recipe screen You must synchronize
the tags in order to synchronize data between the tags of the recipe screen and the recipe
data records displayed in the recipe view. Synchronization of tags is only possible in the
extended recipe view.

Please refer to your system documentation to check whether additional information on this
subject is available there.

MP 177 (WinCC flexible)
Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0



Operating recipes
10.5 Recipe Values in the HMI Device and the PLC

10.5 Recipe Values in the HMI Device and the PLC

Introduction

You can change the values of a recipe on the HMI device and therefore influence the
manufacturing process or a machine.

Depending on the configuration, the recipe values are displayed, edited and saved in
different ways:

e |f you are editing recipes with a recipe view in your project, the values are saved in recipe
data records.

® |f you are editing recipes in a recipe screen in your project, the values are saved in recipe
tags.

Differences may occur between the display values in the recipe view and the values saved in
the associated tags in an ongoing project when you edit recipes with a recipe view and in a
recipe screen. To prevent this, the recipe data record values must be synchronized with the
values of the recipe tags.

You have however the option to perform synchronization operations at any time.
Synchronization only takes place if the configuration engineer has activated the respective
settings for a recipe.

Note
Recipe tags can only be synchronized in the extended recipe view.

Synchronizing recipe tags
Synchronization of the recipe tags depends on the configuration:
® Automatic synchronization:

The values of the recipe view are synchronized with the associated recipe tags. In this
case, changes to values in the recipe view have an immediate effect on the values of the
associated recipe tags. The values are only synchronized, when an operating element
that is outside the recipe view is operated.

® Synchronization by the user:

The values of the recipe view and the associated recipe tags are not synchronized

automatically. The configuration engineer has assigned the same function to the él
button or a different operating element in the recipe view. The recipe tags and the recipe
view are only synchronized when you operate the buttons or the appropriate operating

element.
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10.6 Operating the recipe view

Recipe tags online / offline

The configuration engineer can configure a recipe so that changes to the values of the recipe
tags do not have an immediate effect on the current process.

Synchronization of the recipe values between the HMI device and the PLC depends on
whether the configuration engineer has selected the settings "Tags online" or the setting
"Tags offline" for a recipe.

"Tags online:"
This setting has the following effect:

— When you change recipe values in the recipe screen, these changes are applied
immediately by the PLC and immediately influence the process.

— If recipe values are changed in the PLC, the changed values are displayed
immediately in the recipe screen.

"Tags offline"

With this setting, changed recipe values are not synchronized immediately between the
HMI device and the PLC.

In this case, the configuration engineer must configure operating elements for transferring
the values to the PLC or reading them from the PLC in a recipe screen. The recipe values
are only synchronized between HMI device and PLC when you operate the appropriate
operating element.

10.6 Operating the recipe view

10.6.1 Overview

Operation

The recipe view can be operated as follows:

180

Enter values for the recipe elements

Create recipe data records

Save recipe data records or save them under a new name

Delete recipe data records

Synchronize values of the recipe view with the associated recipe tags

Transfer recipe data records from the PLC and to the PLC

MP 177 (WinCC flexible)
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70.6 Operating the recipe view

Operator controls of the recipe view

The following table shows the operator controls of the recipe view.

Functions

Creates a new recipe data record.
If a start value is configured, it is shown in the text box.

Saves the displayed values of the recipe data record.
The storage location is predefined by the project.

The recipe data record is saved under a different name irrespective of the recipe
view. A dialog box opens in which the name is entered.

The displayed recipe data record is deleted.

The values of the recipe view are synchronized with the associated recipe tags.
The values changed during editing are written to the associated recipe tags.
Subsequently all the values of the tags are read out and updated in the table.

The recipe values from the PLC are displayed in the recipe view.

DEEREEE

The values of the set recipe data record displayed in the recipe view are
transferred to the PLC.

Operating the recipe screen

You operate the recipes in a recipe screen with the operator controls provided by the
configuration engineer.

Please refer to your system documentation to check whether additional information on this
subject is available there.

10.6.2 Creating a recipe data record

Introduction

You create a new recipe data record by modifying an existing record. You then save the
modified data record under a new name.

Requirements

A screen with a recipe view is displayed.

MP 177 (WIinCC flexible)
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10.6 Operating the recipe view

Proceed as follows:

If the recipe view contains several recipes: Select the recipe for which you want to create
a new recipe data record.

Touch El

A new recipe data record with the next available number is created.

If you change the new data record number to an existing data record number, the existing
data record is overwritten.

Enter values for the elements of the data record.

The elements of the recipe data record can be assigned default values depending on the
configuration.

Touch E

Enter a name for the data record.
The data record is saved under the new name.

If the recipe data record already exists, a dialog is opened. In this dialog, specify whether
the existing data record is to be overwritten.

The new recipe data record is saved to the selected recipe.

Procedure
1.
2.
3.
4.
5.

Result

See also

Recipes in the Project (Page 174)

10.6.3 Editing a recipe data record

Introduction

Edit the values of the recipe data records and save them in a recipe view.

Synchronization with the PLC

If you want to display the current recipe values from the PLC in the recipe view, you first

have to read the current values from the PLC with ﬂ

The values changed in the recipe view only become effective when the amended data record

is transferred to the PLC by means of theﬂ button.

182
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Requirements

Procedure

Result

See also

70.6 Operating the recipe view

A screen with a recipe view is displayed.

Proceed as follows:

1.

If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to change.

3. Change the data record as required.

Save your changes by means of the El button.

If you want to save the recipe data record under a different name, touch the El key.

The recipe data record is saved.

The edited recipe data record has now been saved in the selected recipe.

Recipes in the Project (Page 174)

10.6.4 Deleting a recipe data record

Introduction

Requirements

Procedure

Result

You can delete all the data records of a recipe which are not required.

A screen with a recipe view is displayed.

Proceed as follows:

1.

If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

Select the recipe data record you want to delete.

Touch il

The recipe data record is deleted.

MP 177 (WinCC flexible)
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10.6 Operating the recipe view

10.6.5 Synchronizing tags

Introduction

Requirement

Procedure

Result

See also

184

The values of the recipe elements can be saved to recipe tags, depending on the
configuration.

Differences may occur between the display values in the recipe view and the actual values of
tags in an ongoing project. Synchronize the tags to equalize such differences.

Synchronization always includes all the variables which belong to a recipe data record.

NOTICE

Changed tag name

Tags and the value of the recipe data record cannot be assigned to each other if the tag
name of the tag to be synchronized has been changed. The tags in question are not
synchronized.

Note
Recipe tags can only be synchronized in the enhanced recipe view.

A screen with a recipe view is displayed.

Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to synchronize.

3. Touch @

The elements of the recipe data record are synchronized with the recipe tags.

If the values of the recipe view and the tag do not match, the more current value is accepted.

Recipes in the Project (Page 174)
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70.6 Operating the recipe view
10.6.6 Reading a recipe data record from the PLC

Introduction

In the current project, the values which are also stored in the recipes in the HMI device can

be changed directly in the plant. This is the case, for example, if a valve was opened further
directly at the plant than is stored in the recipe. The values of the recipe data records saved
in the HMI device possibly no longer match the values in the PLC.

To synchronize the recipe values, read the values from the PLC and display them in the
recipe view.

Requirements
A screen with a recipe view is displayed.

Procedure
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record to which you want to apply the values from the PLC.

3. Touch ﬂ

The values are read from the PLC.

4. If you want to store the displayed values in the HMI device, touch the E button.

Result

The values were read from the PLC, displayed on the HMI device and saved to the selected
recipe data record.

See also
Recipes in the Project (Page 174)
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10.6 Operating the recipe view
10.6.7 Transferring a recipe data record to the PLC

Introduction

In order for an edited recipe data record to take effect in the process, you must transfer the
values to the PLC.

The display values in the recipe view are always transferred to the PLC.

Requirements
A screen with a recipe view is displayed.

Procedure
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record whose values you want to transfer to the PLC.

3. Touch El

Result

The display values in the recipe view were transferred to the PLC and take effect in the
process.

See also
Recipes in the Project (Page 174)
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10.7

10.7.1

Introduction

Operation

10.7 Operating the simple recipe view

Operating the simple recipe view

Overview

The simple recipe view consists of three areas:
® Recipe list
e Data record list

® FElement list

You can use the context menu to operate each of these display areas.

The simple recipe view can be operated as follows:

® Enter values for the recipe elements

® (Create recipe data records

® Save recipe data records or save them under a new name
® Delete recipe data records

® Transfer recipe data records from the PLC and to the PLC

Operator controls of the simple recipe view
Toggle between the display areas and the context menus to operate the simple recipe views.

The following table shows the operation of the display area.

Operation Functions

Touching an entry The next lower display area opens.

:l The next higher display area opens.

:l The context menu of the display area opens.

The following table shows the operation of the context menu.

Operation Functions

:l The menu is closed.
The display area opens.

Touch the menu command | The menu command is executed.

MP 177 (WinCC flexible)
Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0

187



Operating recipes

10.7 Operating the simple recipe view

Context menus of the simple recipe view

® Recipe list

Menu item Functions
New A new recipe data record is created for the selected recipe.

If a start value is configured, it is shown in the text box.
Displaying infotext The infotext configured for the simple recipe view is displayed.
Open The record list of the selected recipe opens.

® Data record list

Menu item Functions
New A new recipe data record is created for the selected recipe.
If a start value is configured, it is shown in the text box.
Delete The selected record is deleted.
Save as The selected record is saved under a different name irrespective of the

simple recipe view. A dialog box opens in which the name is entered.

Rename The selected data record is renamed. A dialog box opens in which the
name is entered.

® FElement list

Menu item Functions

Save The selected record is saved.

To PLC The displayed values of the selected data record are transferred from the
HMI device to the PLC.

From PLC The recipe values from the PLC are displayed on the HMI device in the
recipe view.

Save as The selected data record is saved under a new name. A dialog box opens
in which the name is entered.

Operating the menu
Touch the desired menu command. The command is executed.

Operating the recipe screen

You operate the recipes in a recipe screen with the operator controls provided by the
configuration engineer.

Please refer to your system documentation to check whether additional information on this
subject is available there.
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10.7 Operating the simple recipe view

10.7.2 Creating a recipe data record

Introduction

Requirements

Procedure

Result

See also

Create a new recipe data record in the recipe list or in the record list. Then enter the values
for the new record in the element list and save the record.

A screen with a simple recipe view is displayed.

Proceed as follows:

1.

If the recipe list contains several recipes: Select the recipe for which you want to create a
new recipe data record.

Open the recipe list menu.

3. Select the menu command "New".

Creates a new record

The element list of the new record opens.

. Enter values for the elements of the data record.

The tags of the record can be assigned default values depending on the configuration.

5. Open the menu of the element list and select the command "Save".

6. Enter a name for the new record.

Confirm your entries.

If you change the new data record number to an existing data record number, the existing
data record is overwritten.

The new recipe data record is saved to the selected recipe.

Recipes in the Project (Page 174)
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10.7 Operating the simple recipe view

10.7.3 Editing a recipe data record

Introduction

Edit the values of the recipe data records in a simple recipe view.

Synchronization with the PLC

If you want to display the current recipe values from the PLC in the simple recipe view, you
first have to read the current values from the PLC with the menu command "From PLC" in
the element list.

The values changed in the recipe view only take effect in the PLC when you transfer the
edited data record to the PLC with the menu command "To PLC".

Requirements

A screen with a simple recipe view is displayed.

Procedure

Proceed as follows:

1.

o gk~ 0w N

Result

If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

Open the data record list.

Select the recipe data record you want to change.
Open the element list.

Change the values of the records as required.

Save your changes with the menu command "Save".

The recipe data record is saved.

The edited recipe data record has now been saved in the selected recipe.

See also

Recipes in the Project (Page 174)
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10.7 Operating the simple recipe view

10.7.4 Deleting a recipe data record

Introduction
You can delete all the data records which are not required.

Requirements
A screen with a simple recipe view is displayed.

Procedure
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

Open the data record list.
Select the data record you want to delete.

Open the menu.

o > 0N

Select the menu command "Delete".

Result
The data record is deleted.

See also
Recipes in the Project (Page 174)

10.7.5 Reading a recipe data record from the PLC

Introduction
The values of recipe elements are exchanged with the PLC via tags.

In the current project, the values which are also stored in the recipes in the HMI device can
be changed directly in the plant. This is the case, for example, if a valve was opened further
directly at the plant than is stored in the recipe. The values of the tags on the HMI device
possibly no longer match the values in the PLC.

To synchronize the recipe values, read the values from the PLC and display them in the
recipe view.

Requirements
A screen with a simple recipe view is displayed.
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10.7 Operating the simple recipe view

Procedure

Result

See also

Proceed as follows:

1.

If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

. Select the element list of the recipe data record to which you want to apply the values

from the PLC.

3. Open the menu.

4. Select the menu item "From PLC".

The values are read from the PLC.

If you want to save the displayed values in the HMI device, select the menu item "Save".

The values were read from the PLC, displayed on the HMI device and saved to the selected
recipe data record.

Recipes in the Project (Page 174)

10.7.6 Transferring a recipe data record to the PLC

Introduction

Requirements

Procedure

Result

192

In order for an edited recipe data record to take effect in the process, you must transfer the
values to the PLC.

The display values in the recipe view are always transferred to the PLC.

A screen with a simple recipe view is displayed.

Proceed as follows:

1.

If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

Select the element list of the recipe data record whose values you want to transfer to the
PLC.

3. Open the menu.

4. Select the menu item "To PLC".

The values of the recipe data record were transferred to the PLC and take effect in the
process.
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See also

10.8 Exporting a recipe data record

Recipes in the Project (Page 174)

10.8 Exporting a recipe data record

Introduction

Requirements

Procedure

Result

You can export one or more recipe data records to a CSV file, depending on the
configuration. After export, the values in the recipe data record can be further processed in a
spreadsheet program such as MS Excel. The degree to which you can influence the export
depends on the configuration:

NOTICE

Export of recipe data to USB memory stick not possible

The USB interface is deactivated while the main battery is changed. Make sure that no
recipe data is exported to a USB memory stick while the main battery is being changed.

® A screen with a recipe view is displayed
® An operating element with the function "Export record" has been configured.

® The following tags are configured equally in the recipe view and for the "Export record"
operating element.

— Recipe number

— Data record number

Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to export.

3. Operate the operator control which was configured for export, for example the "Export
data record" button.

The data record is exported as a CSV file to an external data medium.

Please refer to your system documentation to check whether additional information on this
subject is available there.

The recipe data record is exported.
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10.9 Importing a recipe data record

Introduction

You can import values from a CSV file to a recipe data record, depending on the
configuration.

Requirements

® An operating element with the function "Import data record" has been configured, for
example a button

® A screen with a recipe view is displayed

Procedure
Proceed as follows:
1. If the recipe view contains several recipes: Select the recipe which contains the recipe
data record to be imported.
2. Operate the operating element with the function "Import data record".
The record is imported from an external data medium as a CSV file and then displayed in
the recipe view after import.
Result

The imported recipe data record is saved on the HMI device.

Deviating structure

If the structure of the CSYV file differs from the structure of the recipe, deviations are handled
as follows:

® Any additional values in the CSV file will be rejected

® The system applies the configured default value to the recipe data record if the CSV file
contains an insufficient number of values

e |f the CSV file contains values of the wrong data type, the configured default value is set
in the recipe data record

Example:
The imported CSV file contains values that were entered as floating point numbers

However, the corresponding tag expects an integer value. In this case, the system
discards the imported value and uses the configured default

MP 177 (WinCC flexible)
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10.10 Examples

10.10.1  Entering a recipe data record

Introduction
You would like to enter production data on the HMI device without interrupting the process in
the machine or plant. For this reason, the production data should not be transferred to the
PLC.

Procedure

Proceed as follows:
1. Call the recipe view or a recipe screen.
Select the desired recipe data record.

Enter the values of the elements.

oD

Save the recipe data record.
The recipe data record is saved in the internal memory of the HMI device.

The following figure shows the data flow schematically.

HMI device m
Recipe view @ w

Recipe 1
Recipe 2
o—o @ Recipe 3
] ©
Recipe tag
Recipe
screen @ v

>
©

PLC

Display recipe data record

Save recipe data record

Tags are synchronized

Display and edit recipe tags in the recipe screen
Tags are offline

CECNONONC)
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10.10 Examples

10.10.2 Manual production sequence

Introduction
You request the production data of different workpieces from the PLC and display this data
on the screen of the HMI device for inspection. You want to correct the transferred
production data in the recipe view or the recipe screen if necessary.

Procedure

A scanner connected to the PLC reads the barcode of a workpiece. The barcode names
correspond to the names in the recipe data record. Based on the barcode name, the PLC
can read the required recipe data record. The recipe data record is displayed for inspection
on the HMI device. You can now edit and save the recipe data record. Then transfer the
edited recipe data record to the PLC again.

The following figure shows the data flow schematically.

HMI device m
Recipe view @ u
o—o
1 ©
Recipe tag

Recipe

screen @ v

The recipe data record is read from the PLC and written to the PLC again following
changes

Display and edit recipe tags in the recipe screen
Tags are synchronized

®e 60 O

Recipe data records are saved in the recipe memory of the HMI device
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11.1 Maintenance and Care

Scope of maintenance
The HMI device is designed for maintenance-free operation. You should clean the touch
screen at regular intervals, however.

Preparation

A\ caution

Inadvertent operation

Always switch off the HMI device before cleaning it. This will ensure that you do not trigger
functions unintentionally when you touch the touch screen.

Requirement
Use a cleaning cloth dampened with a cleaning agent to clean the equipment. Only use
water with a little liquid soap or a screen cleaning foam.

CAUTION

Do not clean the HMI device with compressed air or steam jet blowers. Never use
aggressive solvents or scouring powder.

Procedure
Proceed as follows:

1. Switch off the HMI device.
2. Spray the cleaning solution onto a cleaning cloth.
Do not spray directly onto the HMI device.
3. Clean the HMI device.
When cleaning the display wipe from the screen edge inwards.

MP 177 (WIinCC flexible)
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11.2 Clean screen

Clean screen

The HMI touch screen can be cleaned when it is switched on and a project is running. An
operating element must be available in the project with which the clean screen can be called.
Once the clean screen is activated, touch screen operation is locked for a configured period
of time. The time the touch screen is locked can be set between 5 and 30 seconds. The time
remaining for the lockout is indicated by a progress bar.

A WARNING

Locking operating elements

Always open the clean screen or switch off the HMI device before you clean the touch
screen while the system is running!

It is important to note when the clean screen function is unlocked. Ignoring this instruction
may lead to inadvertent operation of a function.

11.3 Protective Foil

Protective foil

Protective foil is available for the HMI device touch screens. You can find the required
ordering information on the Internet at "http://mall.automation.siemens.com" The protective
foil is not part of the scope of delivery of the HMI device.

The self-adhesive protective foil prevents the screen from being scratched and soiled. The
matt surface of the protective foil reduces reflections where lighting is poor.

The protective foil can be removed without leaving any adhesive residue on the screen.

CAUTION
Applying and removing the protective foil

Always switch off the HMI device before applying the protective foil. Otherwise, there is a
risk that functions are inadvertently activated. This also applies to removing the protective
foil.

Never use sharp or pointed objects such as a knife to remove the protective foil. You might
otherwise damage the touch screen.

MP 177 (WinCC flexible)
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11.4 Spare Parts and Repairs

Repairs

Service pack

In case of repair, the HMI device must be shipped to the Return Center in Fiirth. Repairs
may only be carried out at the Return Center in Firth.

Depending on the work necessary to repair the device, the Center may decide to give you a
credit note. In this case, it is your responsibility to order a new device.

The address is:
Industry Sector

Return Center
Siemensstr. 2

90766 Firth, Germany

A service pack can be ordered for servicing purposes.
The service pack includes:

® Mounting seals

® Mounting clamps

® Plug-in terminal strip, 2-pin

The service pack can be ordered from your Siemens representative.

Service & Support on the Internet

Service & Support provides additional comprehensive information on SIMATIC products
through online services at "http://www.siemens.com/automation/support”.

Information about on-site services, repairs, spare parts, and much more is available on our
"Services" pages.
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12.1 Dimension drawings of the MP 177

SIEMENS| SIVATIC MULTI PANEL.

HONOL

156

140

212

196

=

12.2 Specifications of the MP 177

22

All specifications in mm
Tolerance 1 mm

HMI device
‘ Weight without packing approx. 850 g
Display

Type LCD-TFT

Display area, active

115,18 mm x 86,38 mm (5,7")

Resolution 320 x 240 pixels
Colors, displayable 65.536
Backlighting CCFL

Half brightness life time, typical 50,000 h

Pixel error class according to DIN EN ISO 13406-2

MP 177 (WinCC flexible)
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12.2 Specifications of the MP 177

Input unit
’ Type Touch screen, analog, resistive
Memory
Application memory 2 MB
MRAM for PLC data 64 KB
Ports
1 x RS 422/RS 485 Max. 12 Mbps

1x USB

e USB host; conforms to USB standard 1.1
(supporting low-speed and full-speed USB devices)

e Maximum load 100 mA

1 x Ethernet

RJ45 10/100 Mbps

Supply voltage

Nominal voltage
Range, permissible

+24 VDC
19.2 V10 28.8 V (-20 %, +20%)

Transients, maximum permissible

35V (500 ms)

Time between two transients, minimum

50 sec

Current consumption

e Typical

e Constant current, maximum
e Power on current surge [t

e approx. 670 mA
e approx. 740 mA
e approx. 0.5 A%s

Fuse, internal Electronic
Miscellaneous
’ Realtime clock, buffered Yes

202
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Bit Assignment of the Direct Keys

12.3 Bit Assignment of the Direct Keys

The following figures show the assignment to the bytes in the PLC process image.

Bit assignment of the direct keys for the MP 177

Touch assignment

7 6 5 4 3 2 1 0 Byte
7 6 5 4 3 2 1 n

15 | 14 Bl12 | 1" 10 9 n+1
23 1 22| 2120 | 19 | 18 [ 17 | 16 n+2
31 | 30 [ 29| 28 | 27 | 26 | 256 | 24 n+3
39 | 38 | 37 | 36 | 35 | 34 [ 33 | 32 n+4

WinAC MP
Configuration of the direct keys is not required for WinAC MP.
The direct key bits are always available through 1/O direct accesses to the 1/O area,
beginning with address 40004 or 16384p.
The following table shows the direct key areas.
Input area Input area Output area Output area
Hexadecimal Decimal Hexadecimal Decimal
MP 177 4000+ — 40031 16384 - 16387 -- -
Check whether additional information is available in your plant documentation.
See also

Direct Keys (Page 138)

MP 177 (WIinCC flexible)
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12.4 Description of the ports

12.4.1 Power Supply

Plug connector, 2-pin

1 2

]

Power supply pin assignment

Pin Assignment
1 +24 VDC
2 GND 24 V

12.4.2 RS 422/RS 485 (IF 1B)

Sub-D socket, 9-pin, with screw lock
5 1
0O 00 OO0
B8
9 6
Pin assignment of the RS 422/RS 485 interface

Pin Assignment for the RS 422 Assignment for the RS 485
1 n. c. n. c.
2 GND 24 V GND 24V
3 TxD+ Data channel B (+)
4 RD+ RTS"Y
5 GND 5V, floating GND 5V, floating
6 +5 VDC, floating +5 VDC, floating
7 +24 VDC, out (max. 100 mA) +24 VDC, out (max. 100 mA)
8 TxD—- Data channel A (-)
9 RxD- RTS"

N On pin 4 or pin 9, can be set with DIP switch on the rear of the device

MP 177 (WinCC flexible)
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12.4.3 USB

USB standard connector

=]

Pin assignment of the USB port

Pin Assignment
1 +5 VDC, out, max. 100 mA
2 USB-DN
3 USB-DP
4 GND
1244 PROFINET
RJ45 plug connector
I
nnnnnng
1 8

Pin assignment of the RJ45 connector

Pin Assignment
TX+

TX-

RX+

n.c.

n.c.
RX-

n.c.

O IN|oo|Ja|ld|WIN]|~

n.c.

There is a green and a yellow LED at each PROFINET interface; these LEDs display the
status of PROFINET communication.

The following table shows the meaning of the LEDs.

Green LED Yellow LED Meaning

"LINK" "RX/TX"

Off Off There is no PROFINET connection.

On Off PROFINET communication is possible.

On On Data is exchanged via the PROFINET connection.

MP 177 (WinCC flexible)
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12.4 Description of the ports
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Appendix l \

A1 ESD guideline

Definition of ESD

All electronic modules are equipped with large-scale integrated ICs or components. Due to
their design, these electronic elements are highly sensitive to overvoltage, and thus to any
electrostatic discharge. These electronic components are therefore specially identified as

ESDs.
Abbreviations
The following abbreviation is commonly used for electrostatic sensitive devices:
® EGB - Elektrostatisch Gefahrdete Bauteile/Baugruppen (Germany)
® ESD - Electrostatic Sensitive Device (internationally recognized term)
Labeling

ESDs are labeled with the following symbol:

Electrostatic charging

CAUTION

Electrostatic charging

ESDs may be destroyed by voltages far below the level perceived by human beings.
Voltages of this kind develop when a component or an assembly is touched by a person
who is not grounded against static electricity. Usually, it is unlikely that damage to an ESD
as a result of overvoltage is detected immediately but may become apparent only after a
longer period of operation.

Prevent electrostatic charging of your body before you touch the ESD!

MP 177 (WinCC flexible)
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A.1 ESD guideline

Anyone who is not connected to the electrical potential of their surroundings is subjected to
electrostatic charging.

The following figure indicates the maximum electrostatic charge anyone is subjected to when
coming into contact with the materials shown. These values correspond with specifications to
IEC 801-2.

[kv]

16
15
14
13
12
11
10

Voltage

SNWAhOION®O

]

LI T T T T T T T T T

510 20 30 40 50 60 70 80 90 100 [%]
Relative humidity

0] Synthetic materials
® Wool
®

Antistatic materials such as wood or concrete

Protective measures against electrostatic discharge

CAUTION

Observe grounding measures

When working with electrostatic sensitive devices, make sure that the person, the
workplace and the packaging are properly grounded. This helps to avoid electrostatic
charging.

As arule, only touch the ESD if this is unavoidable, for example for maintenance. When you
touch modules, make sure that you do not touch the pins on the modules or the PCB tracks.
In this way, the discharged energy cannot reach and damage the sensitive devices.

Discharge electrostatic electricity from your body if you are performing measurements on an
ESD. Do so by touching grounded metallic parts.

Always use grounded measuring instruments.

MP 177 (WinCC flexible)
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A2

Introduction

System alarms

A.2 System alarms

System alarms on the HMI device provide information about internal states of the HMI device

and PLC.

The following overview shows the causes of system alarms and how to eliminate the cause

of error.

Some of the system alarms described in this section are relevant to individual HMI devices

based on their range of features.

Note

System alarms are only indicated if an alarm window was configured. System alarms are
output in the language currently set on your HMI device.

System alarm parameters

Meaning of

System alarms may contain encrypted parameters which are relevant to troubleshooting
because they provide a reference to the source code of the runtime software. These
parameters are output after the text "Error code:"

the system alarms

All the system alarms that can be displayed are listed below. The system alarms are divided

into different ranges:

10000 - Printer alarms

Number Effect/cause Remedy

10000 The print job could not be started or was canceled | Check the printer settings, cable connections and the
due to an unknown error. Faulty printer setup. Or: power supply.
No authorization is available for accessing the Set up the printer once again. Obtain a network printer
network printer. authorization.
Power supply failure during data transfer. If the error persists, contact the Hotline!

10001 No printer is installed or a default printer has not Install a printer and/or select it as the default printer.
been set up.

10002 Overflow of the graphics buffer for printing. Up to Allow sufficient intervals between successive print jobs.
two images are buffered.

10003 Images can now be buffered again. -

10004 Overflow of the buffer for printing lines in text mode | Allow sufficient intervals between successive print jobs.
(e.g. alarms). Up to 1000 lines are buffered.

10005 Text lines can now be buffered again. --

10006 The Windows printing system reports an error. Repeat the action if necessary.
Refer to the output text and the error ID to
determine the possible causes. Nothing is printed
or the print is faulty.

MP 177 (WinCC
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A.2 System alarms

20000 - Global script alarms

in short intervals. When more than 20 scripts are
queued for processing, any subsequent scripts are
rejected. In this case, the script indicated in the
alarm is not executed.

Number Effect/causes Remedy

20010 An error has occurred in the specified script line. Select the specified script line in the configuration.
Execution of the script was therefore aborted. Note | Ensure that the tags used are of the allowed types.
the system alarm that may have occurred prior to Check system functions for the correct number and
this. types of parameters.

20011 An error has occurred in a script that was called by | In the configuration, select the script that has been
the specified script. called directly or indirectly by the specified script.
Execution of the script was therefore aborted in the | Ensure that the tags used are of the allowed types.
called script. Check system functions for the correct number and
Note the system alarm that may have occurred types of parameters.
prior to this.

20012 The configuration data is inconsistent. The script Recompile the configuration.
could therefore not be generated.

20013 The scripting component of WinCC flexible Reinstall WinCC flexible Runtime on your PC.
Runtime is not correctly installed. Therefore, no Rebuild your project with "Project > Generator >
scripts can be executed. Generate" and transfer the project to the HMI device.

20014 The system function returns a value that is not Select the specified script in the configuration.
written in any return tag. Check whether the script name has been assigned a

value.

20015 Too many successive scripts have been triggered | Find what is triggering the scripts. Extend the times,

e.g. the polling time of the tags which trigger the
scripts.

30000 - Alarms for IFwSetValue: SetValue()

Number Effect/causes Remedy

30010 The tag could not accept the function result, e.g. Check the tag type of the system function parameter.
when it has exceeded the value range.

30011 A system function could not be executed because | Check the parameter value and tag type of the invalid
the function was assigned an invalid value or type | parameter. If a tag is used as a parameter, check its
in the parameter. value.

30012 A system function could not be executed because | Check the parameter value and tag type of the invalid
the function was assigned an invalid value or type | parameter. If a tag is used as a parameter, check its
in the parameter. value.

40000 - Linear scaling alarms

Number Effect/causes Remedy
40010 The system function could not be executed since Check the parameter types in the configuration.
the parameters could not be converted to a
common tag type.
40011 The system function could not be executed since Check the parameter types in the configuration.
the parameters could not be converted to a
common tag type.
MP 177 (WinCC flexible)
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50000 - Data server alarms

A.2 System alarms

Number Effect/causes Remedy

50000 The HMI device is receiving data faster than it is --
capable of processing. Therefore, no further data is
accepted until all current data have been
processed. Data exchange then resumes.

50001 Data exchange has been resumed. --

60000 - Win32 function alarms

Number Effect/causes Remedy

60000 This alarm is generated by the --
“DisplaySystemAlarms” function. The text to be
displayed is transferred to the function as a
parameter.

60010 The file could not be copied in the direction defined | Restart the system function or check the paths of the
because one of the two files is currently open or the | source/target files. Using Windows NT/XP: The user
source/target path is not available. executing WinCC flexible Runtime must be granted
It is possible that the Windows user has no access | access rights for the files.
rights to one of the two files.

60011 An attempt was made to copy a file to itself. Check the path of the source/target file.

It is possible that the Windows user has no access
rights to one of the two files.

Using Windows NT/XP with NTFS: The user executing
WinCC flexible Runtime must be granted access rights
for the files.

70000 - Win32 function alarms

Number Effect/causes Remedy
70010 The application could not be started because it Check whether the application exists in the specified
could not be found in the path specified or there is | path or close other applications.
insufficient memory space.
70011 The system time could not be modified. Check the time which is to be set.
The error alarm only appears in connection with Using Windows NT/XP: The user executing WinCC
area pointer "Date/time PLC". Possible causes: flexible Runtime must be granted the right to change
o Aninvalid time was transferred in the job the system time of the operating system.
mailbox.
e The Windows user has no right to modify the
system time.
If the first parameter in the system alarm is
displayed with the value 13, the second parameter
indicates the byte containing the incorrect value.
70012 An error occurred when executing the function Close all programs currently running.
"StopRuntime" with the option "Runtime and Then close Windows.
operating system".
Windows and WinCC flexible Runtime are not
closed.
One possible cause is that other programs cannot
be closed.
70013 The system time could not be modified because an | Check the time which is to be set.

invalid value was entered. Incorrect separators may
have been used.

MP 177 (WinCC flexible)
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Number

Effect/causes

Remedy

70014

The system time could not be modified. Possible
causes:

e An invalid time was transferred.

e The Windows user has no right to modify the
system time.

Windows rejects the setting request.

Check the time which is to be set.

Using Windows NT/XP: The user executing WinCC
flexible Runtime must be granted the right to change
the system time of the operating system.

70015

The system time could not be read because
Windows rejects the reading function.

70016

An attempt was made to select a screen by means
of a system function or job. This is not possible
because the screen number specified does not
exist.

Or: A screen could not be generated due to
insufficient system memory.

Or: The screen is blocked.
Or: Screen call has not been executed correctly.

Check the screen number in the function or job with the
screen numbers configured.
Assign the number to a screen if necessary.

Check the details for the screen call and whether the
screen is blocked for specific users.

70017

Date/time is not read from the area pointer because
the address set in the PLC is either not available or
has not been set up.

Change the address or set up the address in the PLC.

70018

Acknowledgment that the password list has been
successfully imported.

70019

Acknowledgment that the password list has been
successfully exported.

70020

Acknowledgment for activation of alarm reporting.

70021

Acknowledgment for deactivation of alarm
reporting.

70022

Acknowledgment to starting the Import Password
List action.

70023

Acknowledgment to starting the Export Password
List action.

70024

The value range of the tag has been exceeded in
the system function.

The calculation of the system function is not
performed.

Check the desired calculation and correct it if
necessary.

70025

The value range of the tag has been exceeded in
the system function.

The calculation of the system function is not
performed.

Check the desired calculation and correct it if
necessary.

70026

No other screens are stored in the internal screen
memory.
No other screens can be selected.

70027

The backup of the RAM file system has been
started.

70028

The files from the RAM have been copied in the
Flash memory.

The files from the RAM have been copied in the
Flash memory. Following a restart, these saved
files are copied back to the RAM file system.
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Number Effect/causes Remedy

70029 Backup of the RAM file system has failed. Check the settings in the "Control Panel > OP" dialog
No backup copy of the RAM file system has been | and save the RAM file system using the "Save Files"
made. button in the "Persistent Storage" tab.

70030 The parameters configured for the system function | Compare the parameters configured for the system
are faulty. function with the parameters configured for the PLCs
The connection to the new PLC was not and correct them as necessary.
established.

70031 The PLC configured in the system function is not Compare the S7 PLC name parameter configured for
an S7 PLC. the system function with the parameters configured for
The connection to the new PLC was not the PLC and correct them as necessary.
established.

70032 The object configured with this number in the tab Check the number of the tab order and correct it if
order is not available in the selected screen. necessary.

The screen changes but the focus is set to the first
object.

70033 An e-mail cannot be sent because a TCP/IP Check the network connection to the SMTP server and
connection to the SMTP server no longer exists. re-establish it if necessary.
This system alarm is generated only at the first
attempt. All subsequent unsuccessful attempts to
send an e-mail will no longer generate a system
alarm. The event is regenerated when an e-mail
has been successfully sent in the meantime.

The central e-mail component in WinCC flexible
Runtime attempts, in regular intervals (1 minute), to
establish the connection to the SMTP server and to
send the remaining e-mails.

70034 Following a disruption, the TCP/IP connection to --

the SMTP server could be re-established.

The queued e-mails are then sent.

70036 No SMTP server for sending e-mails is configured. | Configure an SMTP server:

An attempt to connect to an SMTP server has In WinCC flexible Engineering System

failed and it is not possible to send e-mails. using "Device settings > Device settings"

WinCC flexible Runtime generates the system In the Wind CE i ¢

alarm after the first attempt to send an e-mail. n e,, INdows operating system .
using "Control Panel > Internet Settings > E-mail >
SMTP Server"

70037 An e-mail cannot be sent for unknown reasons. Check the e-mail parameters (recipient etc.).
The contents of the e-mail are lost.

70038 The SMTP server has rejected sending or Check the domain of the recipient address or disable
forwarding an e-mail because the domain of the the authentication on the SMTP server if possible.
recipient is unknown to the server or because the SMTP authentication is currently not used in WinCC
SMTP server requires authentication. flexible Runtime.

The contents of the e-mail are lost.

70039 The syntax of the e-mail address is incorrect or Check the e-mail address of the recipient.
contains illegal characters.

The contents of the e-mail are discarded.

70040 The syntax of the e-mail address is incorrect or --
contains illegal characters.

70041 The import of the user management was aborted Check your user management or transfer it again to

due to an error.
Nothing was imported.

the panel.
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Number Effect/causes Remedy

70042 The value range for the tags has been exceeded Check the desired calculation and correct it if
while executing the system function. necessary.
The system function calculation has not been
carried out.

70043 The value range for the tags has been exceeded Check the desired calculation and correct it if

while executing the system function.

The system function calculation has not been
carried out.

necessary.

80000 - Archive alarms

Number

Effect/causes

Remedy

80001

The log specified is filled to the size defined (in
percent) and must be stored elsewhere.

Store the file or table by executing a ‘move’ or ‘copy’
function.

80002

A line is missing in the specified log.

80003

The copying process for logging was not
successful.

In this case, it is advisable to check any
subsequent system alarms, too.

80006

Since logging is not possible, this causes a
permanent loss of the functionality.

In the case of databases, check whether the
corresponding data source exists and start up the
system again.

80009

A copying action has been completed successfully.

80010

Since the storage location was incorrectly entered
in WinCC flexible, this causes a permanent loss of
the functionality.

Configure the storage location for the respective log
again and restart the system when the full functionality
is required.

80012

Log entries are stored in a buffer. If the values are
read to the buffer faster than they can be physically
written (using a hard disk, for example),
overloading may occur and recording is then
stopped.

Archive fewer values.
Or:
Increase the logging cycle.

80013

The overload status no longer applies. Archiving
resumes the recording of all values.

80014

The same action was triggered twice in quick
succession. Since the process is already in
operation, the action is only carried out once.

80015

This system alarm is used to report DOS or
database errors to the user.

80016

The logs are separated by the system function
"CloseAllLogs" and the incoming entries exceed
the defined buffer size.

All entries in the buffer are deleted.

Reconnect the logs.

80017

The number of incoming events cause a buffer
overflow. This can be caused, for example, by
several copying actions being activated at the

same time.

All copy jobs are deleted.

Stop the copy action.

214
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80019 The connection between WinCC flexible and all --
logs were closed, for example, after executing the
system function "CloseAllLogs".

Entries are written to the buffer and are then written
to the logs when a connection is re-established.
There is no connection to the storage location and
the storage medium may be replaced, for example.

80020 The maximum number of simultaneously copy Wait until the current copying actions have been
operations has been exceeded. Copying is not completed, then restart the last copy action.
executed.

80021 An attempt was made to delete a log which is still Wait until the current copying actions have been
busy with a copy action. Deletion has not been completed, then restart the last action.
executed.

80022 An attempt was made to use the system function In the project, check
"StartSequencelog" to start a sequence log fora | o if the "StartSequenceLog" system function was
log which is not configured as a sequence log. No properly configured.
sequence log file is created. e if the tag parameters are properly provided with

data on the HMI device.

80023 An attempt was made to copy a log to itself. In the project, check
The log is not copied. e if the "CopyLog" system function was properly

configured.
o if the tag parameters are properly provided with
data on the HMI device.

80024 The "CopyLog" system function does not allow Edit the "CopyLog" system function in the project if
copying when the target log already contains data | necessary. Before you initiate the system function,
("Mode" parameter). The log is not copied. delete the destination log file.

80025 You have canceled the copy operation. --

Data written up to this point are retained. The
destination log file (if configured) is not deleted.
The cancellation is reported by an error entry
$RT_ERRS at the end of the destination log.

80026 This alarm is output after all logs are initialized. --
Values are written to the logs from then on. Prior to
this, no entries are written to the logs, irrespective
whether WinCC flexible Runtime is active or not.

80027 The internal Flash memory has been specified as | Configure "Storage Card" or a network path as the
the storage location for a log. This is not storage location.
permissible.

No values are written to this log and the log file is
not created.

80028 The alarm returns a status report indicating that the | --
logs are currently being initialized. No values are
logged until the alarm 80026 is output.

80029 The number of logs specified in the alarm could not | Evaluate the additional system alarms related to this
be initialized. The logs are initialized. alarm. Check the configuration, the ODBC (Open
The faulty log files are not available for logging Database Connectivity) and the specified drive.
jobs.

80030 The structure of the existing log file does not match | Delete the existing log data manually, in advance.
the expected structure.

Logging is stopped for this log.

MP 177 (WIinCC flexible)
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80031 The log in CSV format is corrupted. Delete the faulty file.
The log cannot be used.

80032 Logs can be assigned events. These are triggered | Close WinCC flexible Runtime, delete the log, then
as soon as the log is full. If WinCC flexible Runtime | restart WinCC flexible Runtime.
is started and the log is already full, the event is not | Or:
triggered. Configure a button which contains the same actions as
The log specified no longer logs data because itis | the event and press it.
full.

80033 "System Defined" is set in the data log file as the Reinstall SQL Sever 2005 Express.
data source name. This causes an error. No data is
written to the database logs, whereas the logging to
the CSV logs works.

80034 An error has occurred in the initialization of the No action is necessary. However, it is recommended to
logs. An attempt has been made to create the save the backup files or delete them in order to make
tables as a backup. This action was successful. A | the space available again.
backup has been made of the tables of the
corrupted log file and the cleared log was restarted.

80035 An error has occurred in the initialization of the It is recommended to save the backups or to delete
logs. An attempt has been made to create backups | them in order to release memory.
of the tables and this has failed. No logging or
backup has been performed.

80044 The export of a log was interrupted because The export resumes automatically.

Runtime was closed or due to a power failure. It
was detected that the export needed to be resume
when Runtime restarted.

80045 The export of a log was interrupted due to an error | The export is repeated automatically. Check:
in the connection to the server or at the server e The connection to the server.
itself. e If the server is running.

e If there is enough free space on the server.

80046 The destination file could not be written while Check whether there is enough space on the server
exporting the log. and it you have permission to create the log file.

80047 The log could not be read while exporting it. Check whether the storage medium is correctly

inserted.

80049 The log could not be renamed while preparing to Check whether the storage medium is correctly
export it. inserted and if there is sufficient space on the medium.
The job can not be completed.”

80050 The log which shall be exported is not closed. Make sure the "CloseAll Logs" system function is

The job can not be completed.

called before using the "ExportLog" system function.
Change the configuration as required.

90000 - FDA alarms

Number Effect/causes Remedy
90024 No operator actions can be logged due to lack of Make more space available by inserting an empty
space on the storage medium for log. The operator | storage medium or swapping out the log files on the
action will therefore not be executed. server using "ExportLog".
90025 No user actions can be logged because of error Check whether the storage medium is correctly
state of the archive. Therefore the user action will inserted.
not be executed.
MP 177 (WinCC flexible)
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90026 No operator actions can be logged because the log | Before further operator actions are carried out, the log
is closed. The operator action will therefore not be | must be opened again using the system function
executed. "OpenAllLogs". Change the configuration as required.

90028 The password you entered is incorrect. Enter the correct password.

90029 Runtime was closed during ongoing operation Ensure that you are using the correct storage medium.
(perhaps due to a power failure) or a storage
medium in use is incompatible with Audit Trail. An
Audit Trail is not suitable if it belongs to another
project or has already be archived.

90030 Runtime was closed during ongoing operation --
(perhaps due to a power failure).

90031 Runtime was closed during ongoing operation --
(perhaps due to a power failure).

90032 Running out of space on the storage medium for Make more space available by inserting an empty
log. storage medium or swapping out the log files on the

server using "ExportLog".

90033 No more space on the storage medium for log. As | Make more space available by inserting an empty
of now, no more operator actions requiring logging | storage medium or swapping out the log files on the
will be executed. server using "ExportLog".

90039 You do not have the necessary authorization to Adapt or upgrade your authorizations.
perform this action.

90040 Audit Trail is switched off because of a forced user | Activate the "Audit Trail" again using the system
action. function "StartLog".

90041 A user action which has to be logged has been A user action requiring logging should only be possible
executed without a logged on user. with permission. Change the configuration by setting a

required permission for the input object.
90044 A user action which has to be confirmed was Repeat the user action if necessary.

blocked, because there is another user action
pending.

110000 - Offline function alarms

Number Effect/causes Remedy
110000 The operating mode was changed. "Offline" mode | --
is now set.
110001 The operating mode was changed. "Online" mode | --
is now set.
110002 The operating mode was not changed. Check the connection to the PLCs.
Check whether the address area for the area pointer
88 “Coordination” in the PLC is available.
110003 The operating mode of the specified PLC was -
changed by the system function
"SetConnectionMode".
The operating mode is now "offline".
110004 The operating mode of the specified PLC has been | --

changed by the system function
"SetConnectionMode".
The operating mode is now "online".

MP 177 (WinCC flexible)
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110005 An attempt was made to use the system function Switch the complete system to "online" mode, then
SetConnectionMode to switch the specified PLC to | execute the system function again.
"online" mode, although the entire system is in
"offline" mode. This changeover is not allowed. The
PLC remains in "offline" mode.
110006 The content of the "project version" area pointer Check:

does not match the user version configured in
WinCC flexible. WinCC flexible Runtime is
therefore closed.

e The project ID entered on the PLC.
e The project ID entered in WinCC flexible.

120000 - Trend alarms

Number Effect/causes Remedy
120000 The trend is not displayed because you configured | Change the configuration.
an incorrect axis to the trend or an incorrect trend.
120001 The trend is not displayed because you configured | Change the configuration.
an incorrect axis to the trend or an incorrect trend.
120002 The trend is not displayed because the tag Check whether the data area for the tag exists in the

assigned attempts to access an invalid PLC
address.

PLC, the configured address is correct and the value
range for the tag is correct.

130000 - System information alarms

Number Effect/causes Remedy
130000 The action was not executed. Close all other programs.
Delete files no longer required from the hard disk.
130001 The action was not executed. Delete files no longer required from the hard disk.
130002 The action was not executed. Close all other programs.
Delete files no longer required from the hard disk.
130003 No data medium found. The operation is canceled. | Check, for example, if
e The correct data medium is being accessed
e The data medium is inserted
130004 The data medium is write-protected. The operation | Check whether access has been made to the correct
is canceled. data carrier. Remove the write protection.
130005 The file is read only. The operation is canceled. Check whether access has been made to the correct
file. Edit the file attributes if necessary.
130006 Access to file failed. The operation is canceled. Check, for example, if
e The correct file is being accessed
e The file exists
e Another action is preventing simultaneous access
to the file.
130007 The network connection is interrupted. Check the network connection and eliminate the cause
Records cannot be saved or read over the network | of error.
connection.
130008 The storage card is not available. Insert the storage card.
Records cannot be saved to / read from the storage
card.
MP 177 (WinCC flexible)
218 Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0



Appendix

A.2 System alarms

Number Effect/causes Remedy
130009 The specified folder does not exist on the storage Insert the storage card.
card.

Any files saved to this directory are not backed up
when you switch off the HMI device.

130010 The maximum nesting depth can be exhausted Check the configuration.
when, for example, a value change in a script
results in the call of another script and the second
script in turn has a value change that results in the
call of yet a further script etc.

The configured functionality is not supported.

140000 - Connection alarms chns7: Connection + device

Number Effect/causes Remedy

140000 An online connection to the PLC is established. -

140001 The online connection to the PLC was shut down. | --

140003 No tag updating or writing is executed. Check the connection and if the PLC is switched on.

Check the parameter definitions in the Control Panel
using "Set PG/PC interface".
Restart the system.

140004 No tag update or write operations are executed Verify the connection and check whether the PLC is
because the access point or the module switched on.
configuration is faulty. Check the access point or the module configuration

(MPI, PPI, PROFIBUS) in the Control Panel with
"Set PG/PC interface".
Restart the system.

140005 No tag updating or writing is executed because the | Use a different HMI device address.
HMI device address is incorrect (possibly too high). | Verify the connection and check whether the PLC is
switched on.

Check the parameter definitions in the Control Panel
using "Set PG/PC interface".
Restart the system.

140006 No tag updating or writing is executed because the | Select a different baud rate in WinCC flexible
baud rate is incorrect. (according to module, profile, communication peer,
etc.).
140007 Tags are not updated or written because the bus Check the user-defined bus profile.
profile is incorrect (see %1). Check the connection and if the PLC is switched on.
The following parameters could not be written to Check the parameter definitions in the Control Panel
the registry: using "Set PG/PC interface".
1: Tslot Restart the system.
2: Tqui
3: Tset
4: MinTsdr
5: MaxTsdr
6: Trdy
7: Tid1
8: Tid2
9: Gap Factor
10: Retry Limit

MP 177 (WinCC flexible)
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140008 No tag updating or writing is executed because Check the connection and if the PLC is switched on.
baud rate is incorrect. The following parameters Check the parameter definitions in the Control Panel
could not be written to the registry: using "Set PG/PC interface".
0: General error Restart the system.
1: Wrong version
2: Profile cannot be written to the registry.
3: The subnet type cannot be written to the
registry.
4: The Target Rotation Time cannot be written to
the registry.
5: Faulty Highest Address (HSA).
140009 Tags are not updated or written because the Reinstall the module in the Control Panel using
module for S7 communication was not found. "Set PG/PC interface”.
140010 No S7 communication partner found because the Switch the PLC on.
PLC is shut down. DP/T:
DP/T: If only one master is connected to the network, disable
The option “PG/PC is the only master” is not setin | "PG/PC is the only master" in "Set PG/PC interface".
the Control Panel under “Set PG/PC interface.” If several masters are connected to the network,
enable these. Do not change any settings, for this will
cause bus errors.
140011 No tag updating or writing is executed because Check the connection and that the communication
communication is down. partner is switched on.
140012 There is an initialization problem (e.g. when WinCC | Restart the HMI device.
flexible Runtime was closed in Task Manager). Or:
Or: Run WinCC flexible Runtime, then start your other
Another application (e.g.STEP7) with different bus | applications.
parameters is active and the driver cannot be
started with the new bus parameters (transmission
rate, for example).
140013 The MPI cable is disconnected and, thus, there is Check the connections.
no power supply.
140014 The configured bus address is in already in use by | Edit the HMI device address in the PLC configuration.
another application.
140015 Wrong transmission rate Correct the relevant parameters.
Or:
Faulty bus parameters (e.g. HSA)
Or:
OP address > HSA or: Wrong interrupt vector
(interrupt does not arrive at the driver)
140016 The hardware does not support the configured Change the interrupt number.
interrupt.
140017 The set interrupt is in use by another driver. Change the interrupt number.
140018 The consistency check was disabled by SIMOTION | Enable the consistency check with SIMOTION Scout
Scout. Only a corresponding note appears. and once again download the project to the PLC.
140019 SIMOTION Scout is downloading a new project to | Wait until the end of the reconfiguration.
the PLC. Connection to the PLC is canceled.
MP 177 (WinCC flexible)
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140020 The version in the PLC and that of the project The following remedies are available:
(FWXfile) do not match. Download the current version to the PLC using
Connection to the PLC is canceled. SIMOTION Scout.

Regenerate the project using WinCC flexible ES, close
WinCC flexible Runtime and restart with a new

configuration.
150000 - Connection alarms chnAS511: Connection
Number Effect/causes Remedy
150000 No more data is read or written. Possible causes: Ensure that the cable is plugged in, the PLC is
e The cable is defective. operational, the correct port is being used.

« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.

e The wrong port is used for the connection.
e System overload

150001 Connection is up because the cause of the -
interruption has been eliminated.

160000 - Connection alarms IVar (WinLC) / OPC: Connection

Number Effect/causes Remedy
160000 No more data is read or written. Possible causes: Ensure that the cable is plugged in, the PLC is
e The cable is defective. operational, the correct port is being used.

« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.

e The wrong port is used for the connection.
e System overload

160001 Connection is up because the cause of the --
interruption has been eliminated.

160010 No connection to the server because the server Check access rights.
identification (CLS-ID) cannot be determined.
Values cannot be read or written.

160011 No connection to the server because the server Check, for example, if
identification (CLS-ID) cannot be determined. e The server name is correct.

Values cannot be read or written. « The computer name is correct.

e The server is registered.

160012 No connection to the server because the server Check, for example, if
identification (CLS-ID) cannot be determined. e The server name is correct.

Values cannot be read or written. e The computer name is correct.

e The server is registered.

Note for advanced users:
Interpret the value from HRESULT.

160013 The specified server was started as InProc server. | Configure the server as OutProc Server or Local
This has not been released and may possibly lead | Server.

to incorrect behavior because the server is running
in the same process area as the WinCC flexible
Runtime software.

MP 177 (WinCC flexible)
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Effect/causes

Remedy

160014

Only one OPC server project can be started on a
PC/MP. An alarm is output when an attempt is
made to start a second project.

The second project has no OPC server functionality
and cannot be located as an OPC server by
external sources.

Do not start a second project with OPC server
functionality on the computer.

170000 - S7 dialog alarms

Number

Effect/causes

Remedy

170000

S7 diagnostics events are not indicated because it
is not possible to log on to the S7 diagnostics
functions at this device. The service is not
supported.

170001

The S7 diagnostics buffer cannot be viewed
because communication with the PLC is shut down.

Set the PLC to online mode.

170002

The S7 diagnostics buffer cannot be viewed
because reading of the diagnostics buffer (SSL)
was canceled with error.

170003

An S7 diagnostics event cannot be visualized. The
system returns internal error %2.

170004

An S7 diagnostics event cannot be visualized. The
system returns an internal error of error class %2,
error number %3.

170007

It is not possible to read the S7 diagnostics buffer
(SSL) because this operation was canceled with an
internal error of class %2 and error code %3.

180000 - Misc/common alarms

Possible causes:

"TouchlnputPC.exe" was not registered due to a
faulty Setup.

Number Effect/causes Remedy
180000 A component/OCX received configuration data with | Install a newer component.
a version ID which is not supported.
180001 System overload because too many actions Several remedies are available:
running in parallel. Not all the actions can be e Generate the alarms at a slower rate (polling).
executed, some are rejected. ¢ Initiate scripts and functions at greater intervals.
If the alarm appears more frequently:
Restart the HMI device.
180002 The screen keyboard could not be activated. Reinstall WinCC flexible Runtime.

190000 - Tag alarms

Number Effect/causes Remedy
190000 It is possible that the tag is not updated. --
MP 177 (WinCC flexible)
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190001

The tag is updated after the cause of the last error
state has been eliminated (return to normal
operation).

190002

The tag is not updated because communication
with the PLC is down.

Select the system function "SetOnline" to go online.

190004

The tag is not updated because the configured tag
address does not exist.

Check the configuration.

190005

The tag is not updated because the configured PLC
type does not exist for this tag.

Check the configuration.

190006

The tag is not updated because it is not possible to
map the PLC type in the data type of the tag.

Check the configuration.

190007

The tag value is not modified because the
connection to the PLC is interrupted or the tag is
offline.

Set online mode or reconnect to the PLC.

190008

The threshold values configured for the tag have
been violated, for example, by

e A value entered
e A system function
e A script

Observe the configured or current threshold values of
the tag.

190009

An attempt has been made to assign the tag a
value which is outside the permitted range of
values for this data type.

For example, a value of 260 was entered for a byte
tag or a value of -3 for an unsigned word tag.

Observe the range of values for the data type of the
tags.

190010

Too many values are written to the tag

(for example, in a loop triggered by a script).
Values are lost because only up to 100 actions are
saved to the buffer.

The following remedies are available:

Increase the time interval between multiple write
actions.

Do not use an array tag longer than 6 words when
you configure an acknowledgment on the HMI
device using "Acknowledgment HMI".

190011

Possible cause 1:

The value entered could not be written to the
configured PLC tag because the high or low limit
was exceeded.

The system discards the entry and restores the
original value.

Possible cause 2:
The connection to the PLC was interrupted.

Make sure that the value entered lies within the range
of values of the control tags.

Check the connection to the PLC.

190012

It is not possible to convert a value from a source
format to a target format, for example:

An attempt is being made to assign a value to a
counter that is outside the valid, PLC-specific value
range.

A tag of the type Integer should be assigned a
value of the type String.

Check the range of values or the data type of the tags.

190013

The user has entered a string that is longer than
the tag. The string is automatically shortened to the
permitted length.

Only enter strings that do not exceed the permitted tag
length.

MP 177 (WinCC flexible)
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190100 - Area pointer alarms

Number Effect/causes

Remedy

190100 The area pointer is not updated because the
address configured for this pointer does not exist.
Type

1 Warnings

Errors

PLC acknowledgment

HMI device acknowledgment

LED mapping

Trend request

Trend transfer 1

Trend transfer 2

No.:

Consecutive number displayed in WinCC flexible
ES.

co~NOoO Ok WN

Check the configuration.

190101 The area pointer is not updated because it is not
possible to map the PLC type to the area pointer
type.

Parameter type and no.:

see alarm 190100

190102 The area pointer is updated after the cause of the
last error state has been eliminated (return to
normal operation). Parameter type and no.: See
alarm 190100.

200000 - PLC coordination alarms

Number Effect/causes

Remedy

200000 Coordination is not executed because the address
configured in the PLC does not exist/is not set.

Change the address or set up the address in the PLC.

because the address format of the area pointer
does not match the internal storage format.

200001 Coordination is canceled because the write access | Change the address or set the address in the PLC at
to the address configured in the PLC is not an area which allows write access.
possible.

200002 Coordination is not carried out at the moment Internal error

e The cable is defective.
e The PLC does not respond, is defective, etc.
e System overload

200003 Coordination can be executed again because the -
last error state is eliminated (return to normal
operation).
200004 The coordination may not be executed. --
200005 No more data is read or written. Possible causes: Ensure that the cable is plugged in and the PLC is

operational.
Restart the system if the system alarm persists.

200100 - PLC user version alarms

Number Effect/causes

Remedy

200100 Coordination is not executed because the address
configured in the PLC does not exist/is not set.

Change the address or set up the address in the PLC.

224
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200101 Coordination is canceled because the write access | Change the address or set the address in the PLC at
to the address configured in the PLC is not an area which allows write access.
possible.
200102 Coordination is not carried out at the moment Internal error
because the address format of the area pointer
does not match the internal storage format.
200103 Coordination can be executed again because the -
last error state is eliminated (return to normal
operation).
200104 The coordination may not be executed. --
200105 No more data is read or written. Possible causes: Ensure that the cable is plugged in and the PLC is

e The cable is defective.
e The PLC does not respond, is defective, etc.
e System overload

operational.
Restart the system if the system alarm persists.

210000 - PLC job alarms

Number

Effect/causes

Remedy

210000

Jobs are not processed because the address
configured in the PLC does not exist/has not been
set up.

Change the address or set up the address in the PLC.

210001

Jobs are not processed because read/write access
to the address configured in the PLC is not
possible.

Change the address or set up the address in the PLC
in an area which allows read/write access.

210002

Jobs are not executed because the address format
of the area pointer does not match the internal
storage format.

Internal error

210003

The job buffer is processed again because the last
error status has been eliminated (return to normal
operation).

210004

It is possible that the job buffer will not be
processed.

210005

A control request with an illegal number was
initiated.

Check the PLC program.

210006

An error occurred while attempting to execute the
control request. As a result, the control request is
not executed. Observe the next/previous system
alarms.

Check the parameters of the control request.
Recompile the configuration.

220000 - WinCC channel adapter alarms

Number Effect/causes Remedy

220001 The tag is not downloaded because the associated | Change the configuration.
communication driver / HMI device does not
support the download of Boolean/discrete data
types.

220002 The tag is not downloaded because the associated | Change the configuration.

communication driver / HMI device does not
support write access to the data type BYTE.

MP 177 (WinCC flexible)
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220003 The communication driver cannot be loaded. The Install the driver by reinstalling WinCC flexible
driver may not be installed. Runtime.
220004 Communication is down and no update data is Check the connection.
transferred because the cable is not connected or
defective etc.
220005 Communication is up. -
220006 The connection between the specified PLC and the | --
specified port is active.
220007 The connection to the specified PLC is interrupted | Check whether
e The PLCis OK
e The correct port is used
e Your configuration is OK (port parameters, protocol
settings, PLC address).
Restart the system if the system alarm persists.
220008 The communication driver cannot access or open Close all the applications which access this port and

the specified port. The port may be in use by
another application or the port used is not available
on the destination device.

There is no communication with the PLC.

restart the computer.
Use another port of the system.

230000 - View alarms

Number

Effect/causes

Remedy

230000

The value entered could not be accepted. The
system discards the entry and restores the
previous value.

Either

e The value range has been exceeded

¢ lllegal characters have been entered

e The maximum permitted number of users has
been exceeded.

Enter a practical value or delete any unneeded users.

230002

The currently logged in user has not the required
authorization. The system therefore discards the
input and restored the previous value.

Log on as a user with appropriate authorization.

230003

Changeover to the specified screen failed because
the screen is not available/configured. The current
screen remains selected.

Configure the screen and check the screen selection
function.

230005

The value range of the tag has been exceeded in
the 1/O field.
The original value of the tag is retained.

Observe the range of values for the tag when entering
a value.

230100

During navigation in the web browser, the system
returned a message which may be of interest to the
user.

The web browser continues to run but may not
(fully) show the new page.

Navigate to another page.

230200

The connection to the HTTP channel was
interrupted due to an error. This error is explained
in detail by another system alarm.

Data is no longer exchanged.

Check the network connection.
Check the server configuration.
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230201 The connection to HTTP channel was established. | --
Data is exchanged.
230202 WININET.DLL has detected an error. This erroris | Depending on the cause:
usually generated if it is not possible to connect to | \when an attempt to connect fails or a timeout error
the server or if the server denies access because occurs:
the <_:I|ent could not aqt_henhcate itself. e Check the network connection and the network.
A rejected server certificate could also cause a
communication error in secure SSL connections. ¢ Check the server address.
For details, refer to the error text in the alarm. » Check whether the WebServer is actually running
This text is always output in the language of your on the destination station.
Windows installation, as it is returned by the Faulty authorization:
Windows operating system. ¢ The configured user name and/or password do not
Process values are not exchanged. match those on the server. Establish consistency
The part of the alarm which is returned by the e L .
. . ’ When the server certificate is rejected:
Windows operating system may not be displayed, Certificate signed by an unknown CA ( ):
for example "An error has occurred." WININET.DLL ] ) 9 _y ) ) o
returns the following error: Number: 12055 * Either ignore this item in your project, or
Text:HTTP: <no error text available>." e Install a certificate that has been signed with a root
certificate known to the client computer.
The date of the certificate is invalid:
o Either ignore this item in your project, or
o Install a certificate with a valid date on the server.
Invalid CN (Common Name or Computer Name):
e Either ignore this item in your project, or
¢ Install a certificate with a name that corresponds to
that of the server address.
230203 Although a connection can be made to the server, | Error 503 Service unavailable:
the HTTP server refuses to connect because Check that WinCC flexible Runtime is running on the
e WinCC flexible Runtime is not running on the server and the HTTP channel is supported.
server, or
e The HTTP channel is not supported
(503 Service unavailable).
Other errors can only occur if the Webserver does
not support the HTTP channel. The language of the
alarm text depends on the Webserver.
Data is not exchanged.
230301 An internal error has occurred. An English text --
explains the error in more detail. This may be
caused by insufficient memory.
OCX does not work.
230302 The name of the remote server cannot be resolved. | Check the configured server address.
The attempt to connect failed. Check whether the DNS service is available on the
network.
230303 The remote server is not running on the addressed | Check the configured server address.
computer. Check whether the remote server is running on the
Wrong server address. target computer.
The attempt to connect failed.
230304 The remote server on the addressed computer is Use a compatible remote server.

incompatible with VNCOCX.
The attempt to connect failed.
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status.
An attempt is made to connect.

Number Effect/causes Remedy
230305 The authentication has failed because the Configure the correct password.
password is incorrect.
The attempt to connect failed.
230306 Error in the connection to the remote server. This Check whether
may occur as a result of network problems. e The bus cable is plugged in
The attempt to connect failed. « There are network problems.
230307 The connection to the remote server was shut -
down because
e The remote server was shut down, or
e The user instructed the server to close all
connections.
The connection is closed.
230308 This alarm provides information on the connection | --

240000 - Authorization alarms

Number Effect/causes Remedy

240000 WinCC flexible Runtime is operating in demo Install the authorization.
mode.

You have no authorization or your authorization is
corrupted.

240001 WinCC flexible Runtime is operating in demo Load an adequate authorization / powerpack.
mode.

Too many tags are configured for the installed
version.

240002 WinCC flexible Runtime is operating with a time- Restore the full authorization.
limited emergency authorization.

240004 Error while reading the emergency authorization. Restart WinCC flexible Runtime, install the
WinCC flexible Runtime is operating in demo authorization or repair the authorization (see
mode. Commissioning Instructions Software Protection).

240005 The Automation License Manager has detected an | Reboot the HMI device or PC. If this does not solve the

internal system fault.
Possible causes:

e A corrupt file
e A defective installation

¢ No free space for the Automation License
Manager etc.

problem, remove the Automation License Manager and
install it again.

250000 - S7 Force alarms

Number Effect/causes Remedy

250000 The tag in the specified line in "Status Force" is not | Check the set address and then verify that the address
updated because the address configured for this is set up in the PLC.
tag is not available.

250001 The tag in the specified line in "Status Force" is not | Check the set address.
updated because the PLC type configured for this
tag does not exist.
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Number Effect/causes Remedy
250002 The tag in the specified line in "Status Force" is not | Check the set address.
updated because it is not possible to map the PLC
type in the tag type.
250003 An attempt to connect to the PLC failed. The tags Check the connection to the PLC. Check that the PLC

are not updated.

is switched on and is online.

260000 - Password system alarms

Number Effect/causes Remedy

260000 An unknown user or an unknown password has Log on to the system as a user with a valid password.
been entered in the system.
The current user is logged off from the system.

260001 The logged in user does not have sufficient Log on to the system as a user with sufficient
authorization to execute the protected functions on | authorization.
the system.

260002 This alarm is triggered by the system function --
"TrackUserChange".

260003 The user has logged off from the system. --

260004 The user name entered into the user view already | Select another user name because user names have
exists in the user management. to be unique in the user management.

260005 The entry is discarded. Enter a shorter user name.

260006 The entry is discarded. Use a shorter or longer password.

260007 The logon timeout value entered is outside the valid | Enter a logon timeout value between 0 and 60
range of 0 to 60 minutes. minutes.
The new value is discarded and the original value
is retained.

260008 An attempt was made to read a PTProRun.pwl file | --
created with ProTool V 6.0 in WinCC flexible.
Reading the file was canceled due to
incompatibility of the format.

260009 You have attempted to delete the user "Admin" or | If you need to delete a user, because perhaps you
"PLC User". These users are fixed components of | have exceeded the maximum number permitted,
the user management and cannot be deleted. delete another user.

260012 The passwords entered in the "Change Password" | You have to log on to the system again. Then enter the
dialog and the confirmation field are not identical. identical password twice to be able to change the
The password has not been changed. User will be | password.
logged off.

260013 The password entered in the "Change Password" | You have to log on to the system again. Then enter a
dialog is invalid because it is already in use. new password that has not been used before.
The password has not been changed. User will be
logged off.

260014 You have tried unsuccessfully to log on three times | You can log on to the system with your correct
in succession. password. Only an administrator can change the
You will be locked out and assigned to group no. 0. | assignment to a group.

260023 The password you entered does not meet the Enter a password that contains at least one number.
necessary security guidelines.

260024 The password you entered does not meet the Enter a password that contains at least one character.

necessary security guidelines.
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Number Effect/causes Remedy

260025 The password you entered does not meet the Enter a password that contains at least one special
necessary security guidelines. character.

260028 Upon system start-up, an attempt to log on, or Check the connection to the SIMATIC Logon Server
when trying to change the password of a SIMATIC | and its configuration; for example:
log-on user, the system attempts to access the 1. Port number
ﬁll\/tltATlC.LogonI Server.h . | ) 2 IP address
| a emptlng to log on, the new user is not logge 3 Server name
in. If a different user was logged on before, then
this useris |ogged off. 4. Functional transfer cable

Or use a local user.

260029 The SIMATIC Logon user is not associated to any | Check the user data on the SIMATIC Logon Server
or several groups. and the configuration in your WinCC flexible project. A
The new user is not logged in. If a different user user may only be assigned to one group.
was logged on before, then this user is logged off.

260030 The SIMATIC Logon user could not change his Log in again and choose a different password. Check
password on the SIMATIC Logon Server. The new | the password rules on the SIMATIC Logon Server.
password may not comply with the password
regulations on the server or the user does not have
the right to change his password.

The old password remains and the user is logged
off.

260031 It was not possible to log the user on to the Try again. If necessary, check the password data on
SIMATIC Logon Server. The user name or the the SIMATIC Logon Server.
password could be incorrect or the user does not
have sufficient rights to log on.

The new user is not logged in. If a different user
was logged on before, then this user is logged off.

260032 It was not possible to log the user on to the Check the user data on the SIMATIC Logon Server.
SIMATIC Logon Server as his account is blocked.

The new user is not logged in. If a different user
was logged on before, then this user is logged off.

260033 The action change password or log on user could Check the connection to the SIMATIC Logon Server
not be carried out. and its configuration; for example:

1. Port number

2. |IP address

3. Server name

4. Functional transfer cable
Or use a local user.

260034 The last logon operation has not yet ended. A user | Wait until the logon operation is complete.
action or a logon dialog can therefore not be called.
The logon dialog is not opened. The user action is
not executed.

260035 The last attempt to change the password was not Wait until the procedure is complete.
completed. A user action or a logon dialog can
therefore not be called.

The logon dialog is not opened. The user action is
not executed.

260036 There are insufficient licenses on the SIMATIC Check the licensing on the SIMATIC Logon Server.
Logon Sever. The logon is not authorized.
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Number Effect/causes Remedy

260037 There is no license on the SIMATIC Logon Sever. | Check the licensing on the SIMATIC Logon Server.
A logon is not possible.
It is not possible to log on via the SIMATIC Logon
Server, only via a local user.

260040 The system attempts to access the SIMATIC Logon | Check connection to the domain and its configuration

Server upon system start-up or when trying to
change the password.

If attempting to log on, the new user is not logged
in. If a different user was logged on before, then
this user is logged off.

in the Runtime security settings editor.
Or use a local user.

270000 - System alarms

Number Effect/causes Remedy

270000 A tag is not indicated in the alarm because it Check whether the data area for the tag exists in the
attempts to access an invalid address in the PLC. PLC, the configured address is correct and the value

range for the tag is correct.

270001 There is a device-specific limit as to how many --
alarms may be queued for output (see the
operating instructions). This limit has been
exceeded.
The view no longer contains all the alarms.
However, all alarms are written to the alarm buffer.

270002 The view shows alarms of a log for which there is Delete older log data if necessary.
no data in the current project.
Wildcards are output for the alarms.

270003 The service cannot be set up because too many Reduce the number of HMI devices which want to use
devices want to use this service. the service.
A maximum of four devices may execute this
action.

270004 Access to persistent buffer is not possible. Alarms | If the problems persist at the next startup, contact
cannot be restored or saved. Customer Support (delete Flash).

270005 Persistent buffer damaged: Alarms cannot be If the problems persist at the next startup, contact
restored. Customer Support (delete Flash).

270006 Project modified: Alarms cannot be restored from The project was generated and transferred new to the
the persistent buffer. HMI device; The error should no longer occur when the

device starts again.
270007 A configuration problem is preventing the restore Update the operating system and then transfer your

(a DLL is missing, a directory is unknown, etc.).

project again to the HMI device.

280000 - DPHMI alarms Connection

Number

Effect/causes

Remedy

280000

Connection is up because the cause of the
interruption has been eliminated.
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Number Effect/causes Remedy
280001 No more data is read or written. Possible causes: Check whether
e The cable is defective e The cable is plugged in
e The PLC does not respond, is defective, etc. e The PLCis OK
e The wrong port is used for the connection e The correct port is used.
e System overload Restart the system if the system alarm persists.
280002 The connection used requires a function block in -
the PLC.
The function block has responded. Communication
is now enabled.
280003 The connection used requires a function block in Check whether
the PLC. e The cable is plugged in
The function block has not responded. e The PLCis OK
e The correct port is used.
Restart the system if the system alarm persists.
Remedy depends on the error code:
1: The function block must set the COM bit in the
response container.
2: The function block must not set the ERROR bit in
the response container.
3: The function block must respond within the
specified time (timeout).
4: Go online to the PLC.
280004 The connection to the PLC is interrupted. There is | Check the connection parameters in WinCC flexible.

no data exchange at present.

Ensure that the cable is plugged in, the PLC is
operational, the correct port is being used.
Restart the system if the system alarm persists.

290000 - Recipe system alarms

Number

Effect/causes

Remedy

290000

The recipe tag could not be read or written. It is
assigned the start value.

The alarm can be entered in the alarm buffer for up
to four more failed tags if necessary. After that,
alarm 290003 is output.

Check in the configuration that the address has been
set up in the PLC.

290001

An attempt has been made to assign a value to a
recipe tag which is outside the value range
permitted for this type.

The alarm can be entered in the alarm buffer for up
to four more failed tags if necessary. After that,
alarm 290004 is output.

Observe the value range for the tag type.

290002

It is not possible to convert a value from a source
format to a target format.

The alarm can be entered in the alarm buffer for up
to four more failed recipe tags if necessary. After
that, alarm 290005 is output.

Check the value range or type of the tag.

290003

This alarm is output when alarm number 290000 is
triggered more than five times.

In this case, no further separate alarms are
generated.

Check in the configuration that the tag addresses have
been set up in the PLC.
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Number Effect/causes Remedy

290004 This alarm is output when alarm number 290001 is | Observe the value range for the tag type.
triggered more than five times.

In this case, no further separate alarms are
generated.

290005 This alarm is output when alarm number 290002 is | Check the value range or type of the tag.
triggered more than five times.
In this case, no further separate alarms are

generated.

290006 The threshold values configured for the tag have Observe the configured or current threshold values of
been violated by values entered. the tag.

290007 There is a difference between the source and Insert the specified data recipe tag in the source
target structure of the recipe currently being structure.

processed. The target structure contains an
additional data recipe tag which is not available in
the source structure.

The data recipe tag specified is assigned its start

value.
290008 There is a difference between the source and Remove the specified data recipe tag in the specified
target structure of the recipe currently being recipe from the project.

processed. The source structure contains an
additional data recipe tag which is not available in
the target structure and therefore cannot be
assigned.

The value is rejected.

290010 The storage location configured for the recipe is not | Check the configured storage location.
permitted.

Possible causes:

lllegal characters, write protection, data carrier out
of space or does not exist.

290011 The record with the specified number does not Check the source for the number (constant or tag
exist. value).

290012 The recipe with the specified number does not Check the source for the number (constant or tag
exist. value).

290013 An attempt was made to save a record under a The following remedies are available:
record number which already exists. e Check the source for the number (constant or tag
The action is not executed. value).

e First, delete the record.
e Change the "Overwrite" function parameter.

290014 The file specified to be imported could not be Check:
found. e The file name
e Ensure that the file is in the specified directory.

290020 Alarm reporting that the download of records from | --
the HMI device to the PLC has started.

290021 Alarm reporting that the download of records from | --
the HMI device to the PLC was completed.

290022 Alarm reporting that the download of records from | Check in the configuration whether:

error. ¢ The recipe number exists

e The record number exist
e The "Overwrite" function parameter is set
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Number Effect/causes Remedy
290023 Alarm reporting that the download of records from | --
the PLC to the HMI device has started.
290024 Alarm reporting that the download of records from | ---
the PLC to the HMI device was completed.
290025 Alarm reporting that the download of records from | Check in the configuration whether:
the PLC to the HMI device was canceled due to an | The tag addresses are configured in the PLC
error. e The recipe number exists
e The record number exist
e The "Overwrite" function parameter is set
290026 An attempt has been made to read/write a record Set the record status to zero.
although the record is not free at present.
This error may occur in the case of recipes for
which downloading with synchronization has been
configured.
290027 Unable to connect to the PLC at present. As a Check the connection to the PLC.
result, the record can neither be read nor written.
Possible causes:
No physical connection to the PLC (no cable
plugged in, cable is defect) or the PLC is switched
off.
290030 This alarm is output after you selected screen Reload the record from the storage location or retain
which contains a recipe view in which a record is the current values.
already selected.
290031 While saving, it was detected that a record with the | Overwrite the record or cancel the action.
specified number already exists.
290032 While exporting records it was detected that a file Overwrite the file or cancel the process.
with the specified name already exists.
290033 Confirmation request before deleting records. -
290040 A record error with error code %1 that cannot be Check the storage location, the record, the "Data
described in more detail occurred. record" area pointer and if necessary, the connection
The action is canceled. to the PLC.
It is possible that the record was not installed Restart the action after a short time.
correctly on the PLC. If the error persists, contact Customer Support.
Forward the relevant error code to Customer Support.
290041 A record or file cannot be saved because the Delete files no longer required.
storage location is full.
290042 An attempt was made to execute several recipe Trigger the action again after waiting a short period.
actions simultaneously. The last action was not
executed.
290043 Confirmation request before storing records. --
290044 The data store for the recipe has been destroyed --
and is deleted.
290050 Alarm reporting that the export of records has --
started.
290051 Alarm reporting that the export of records was -
completed.
290052 Alarm reporting that the export of records was Ensure that the structure of the records at the storage
canceled due to an error. location and the current recipe structure on the HMI
device are identical.
MP 177 (WinCC flexible)
234 Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0



Appendix

A.2 System alarms

Number

Effect/causes

290053

Alarm reporting that the import of records has
started.

290054

Alarm reporting that the import of records was
completed.

290055

Alarm reporting that the import of records was
canceled due to an error.

Ensure that the structure of the records at the storage
location and the current recipe structure on the HMI
device are identical.

290056

Error when reading/writing the value in the
specified line/column.
The action was canceled.

Check the specified line/column.

290057

The tags of the recipe specified were toggled from
"offline" to "online" mode.

Each change of a tag in this recipe is now
immediately downloaded to the PLC.

290058

The tags of the specified recipe were toggled from
"offline" to "online" mode.

Modifications to tags in this recipe are no longer
immediately transferred to the PLC but must be
transferred there explicitly by downloading a
record.

290059

Alarm reporting that the specified record was
saved.

290060

Alarm reporting that the specified record memory
was cleared.

290061

Alarm reporting that clearing of record memory was
canceled due to an error.

290062

The record number is above the maximum of
65536.
This record cannot be created.

Select another number.

290063

This occurs with the system function
"ExportDataRecords" when the parameter
"Overwrite" is set to No.

An attempt has been made to save a recipe under
a file name which already exists.

The export is canceled.

Check the "ExportDataRecords" system function.

290064

Alarm reporting that the deletion of records has
started.

290065

Alarm reporting that the deletion of records has
successfully completed.

290066

Confirmation request before deleting records.

290068

Security request to confirm if all records in the
recipe should be deleted.

290069

Security request to confirm if all records in the
recipe should be deleted.

290070

The record specified is not in the import file.

Check the source of the record number or record name
(constant or tag value).

290071

During the editing of record values, a value was
entered which exceeded the low limit of the recipe
tag.

The entry is discarded.

Enter a value within the limits of the recipe tag.

MP 177 (WinCC flexible)
Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0

235



Appendix

A.2 System alarms
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290072 When editing record values, a value was entered Enter a value within the limits of the recipe tag.
which exceeds the high limit of the recipe tag.
The entry is discarded.
290073 An action (e.g. saving a record) failed due to an -
unknown error.
The error corresponds to the status alarm
IDS_OUT_CMD_EXE_ERR in the large recipe
view.
290074 While saving, it was detected that a record with the | Overwrite the record, change the record number or
specified number already exists but under another | cancel the action.
name.
290075 A record with this name already exists. Please select a different record name.
The record is not saved.
290110 The default values could not be set due to an error. | --
290111 The Recipes subsystem cannot be used. Recipe Transfer the project to the device again, together with

views have no content and recipe-specific functions
will not be performed.

Possible causes:
e An error occurred while transferring the recipes.

e The recipe structure was changed in ES. When
the project was downloaded again, the recipes
were not transferred with it. This means that the
new configuration data is not being transferred
to the old recipes on the device.

the recipes (the corresponding check box in the
Transfer dialog must be checked).

300000 - Alarm_S alarms

Number

Effect/causes

Remedy

300000

Faulty configuration of process monitoring

(e.g. using PDiag or S7-Graph): More alarms are
queued than specified in the specifications of the
CPU. No further ALARM_S alarms can be
managed by the PLC and reported to the HMI
devices.

Change the PLC configuration.

300001

ALARM_S is not registered on this PLC.

Select a controller that supports the ALARM_S service.

310000 - Report system alarms

Number Effect/causes Remedy
310000 An attempt is being made to print too many reports | Wait until the previous active log was printed.
in parallel. Repeat the print job if necessary.
Only one log file can be output to the printer at a
given time; the print job is therefore rejected.
310001 An error occurred on triggering the printer. The Evaluate the additional system alarms related to this
report is either not printed or printed with errors. alarm.
Repeat the print job if necessary.
MP 177 (WinCC flexible)
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Number Effect/causes Remedy
320000 The movements have already been indicated by Deselect the movements on the other display units and
another device. select the motion control screen on the required
The movements can no longer be controlled. display unit.
320001 The network is too complex. View the network in STL.
The faulty addresses cannot be indicated.
320002 No diagnosable alarm message (error) selected. Select a diagnostics alarm from the ZP_ALARM alarm
The unit associated with the alarm message could | screen.
not be selected.
320003 No alarm message (error) exists for the selected Select the defective unit from the overview screen.
unit. The detail view cannot visualize any networks.
320004 The required signal states could not be read by the | Check the consistency between the configuration on
PLC. The faulty addresses cannot be found. the display unit and the PLC program.
320005 The project contains ProAgent elements which are | In order to run the project, install the optional ProAgent
not installed. ProAgent diagnostic functions cannot | package.
be performed
320006 You have attempted to execute a function which is | Check the type of the selected unit.
not supported in the current constellation.
320007 No error-triggering addresses were found on the Switch the detail screen to STL layout mode and check
networks. the status of the addresses and exclusion addresses.
ProAgent cannot indicate any faulty addresses.
320008 The diagnostic data stored in the configuration are | Transfer the project to the HMI device again.
not synchronized with those in the PLC.
ProAgent can only indicate the diagnostic units.
320009 The diagnostic data stored in the configuration are | Transfer the project to the HMI device again.
not synchronized with those in the PLC. The
diagnostic screens can be operated as usual.
ProAgent may be unable to show all diagnostic
texts.
320010 The diagnostic data stored in the configuration are | Transfer the project to the HMI device again.
not synchronized with those in STEP7.
The ProAgent diagnostics data is not up-to-date.
320011 A unit with the corresponding DB number and FB Check the parameters of the "SelectUnit" function and
number does not exist. the units selected in the project.
The function cannot be executed.
320012 The "Step sequence mode" dialog is no longer Use the ZP_STEP step sequence screen from the
supported. corresponding standard project for your project.
Instead of calling the Overview_Step_Sequence_Mode
function, call the "FixedScreenSelection" function using
ZP_STEP as the screen name.
320014 The selected PLC cannot be evaluated for Check the parameters of the

ProAgent.

The Alarm view assigned to the
"EvaluateAlarmDisplayFault" system function could
not be found.

"EvaluateAlarmDisplayFault" system function.
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330000 - GUI alarms

Number Effect/causes Remedy
330022 Too many dialogs are open on the HMI device. Close all dialogs you do not require on the HMI device.
330026 The password will expire after the number of days | Enter a new password.

shown.

350000 - GUI alarms

Number Effect/causes Remedy
350000 PROFIsafe packages have not arrived within the Check the WLAN connection.
necessary period.
There is a communication problem with the F-CPU.
RT is terminated.
350001 PROFIsafe packages have not arrived within the Check the WLAN connection.
necessary period.
There is a communication problem with the F-CPU.
The PROFIsafe connection is re-established.
350002 An internal error has occurred. Internal error
Runtime is terminated.
350003 Feedback concerning the connection established -
with the F-CPU.
The Emergency-Off buttons are active immediately.
350004 PROFIsafe communication was set and the --
connection was cleared.
The Runtime can be terminated.
The Emergency-Off buttons are deactivated
immediately.
350005 Incorrect address configured for the F-slave. Check and modify the address of the F slave in WinCC
No PROFIsafe connection. flexible ES.
350006 The project has started. At the start of the project, | Press the two enabling buttons one after another in the
the enabling buttons must be checked for "Enable" and "Panic" positions.
functionality.
350008 The wrong number of fail-safe buttons was Change the number of fail-safe buttons in the project.
configured.
No PROFIsafe connection.
350009 The device is in Override mode. Exit Override mode.
It may no longer be possible to detect the location
because transponder detection fails.
350010 Internal error: The device has no fail-safe buttons. | Send the device back.
Worldwide contact person
MP 177 (WinCC flexible)
238 Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0



Abbreviations

ANSI
CPU
Csv
CTS
DC
DCD
DHCP
DIL
DNS
DP
DSN
DSR
DTR

ESD
EMC

PPI
PELV

RJ45
RTS

MP 177 (WIinCC flexible)

American National Standards Institution
Central Processing Unit

Comma Separated Values

Clear To Send

Direct Current

Data Carrier Detect

Dynamic Host Configuration Protocol
Dual-in-Line (electronic chip housing design)
Domain Name System

Distributed 1/0

Data Source Name

Data Set Ready

Data Terminal Ready

Input and Output

Components and modules endangered by electrostatic discharge
Electromagnetic Compatibility
European standard

Engineering System

Components and modules endangered by electrostatic discharge
Ground

High Frequency

Human Machine Interface

International Electronic Commission
Interface

Internet Protocol

Light Emitting Diode

Media Access Control

Metal Oxide Semiconductor

Multipoint Interface (SIMATIC S7)
Microsoft

Mean Time Between Failures

Not connected

Operator Panel

Personal Computer

Programming device

Point-to-Point Interface (SIMATIC S7)
Random Access Memory

Protective Extra Low Voltage
Registered Jack Type 45

Request to send
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RxD
SD Card
SELV
SP
PLC
STN
Sub-D
TAB
TCP/IP
TFT
TTY
TxD
UL
USB
UPS
WINS

Receive Data

Security Digital Card

Safety Extra Low Voltage

Service Pack

Programmable Logic Controller
Super Twisted Nematic
Subminiature D (plug)

Tabulator

Transmission Control Protocol/Internet Protocol
Thin Film Transistor

Teletype

Transmit Data

Underwriter’'s Laboratory
Universal Serial Bus
Uninterruptible power supply
Windows Internet Naming Service

MP 177 (WIinCC flexible)
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Acknowledge
Acknowledgment of an alarm confirms that it has been noted.

Alarm logging

Output of user-specific alarms to a printer, in parallel to their output to the HMI device
screen.

Alarm, acknowledging
Acknowledgment of an alarm confirms that it has been noted.

Alarm, activated
Moment at which an alarm is triggered by the PLC or HMI device.

Alarm, deactivated
Moment at which the initiation of an alarm is reset by the PLC.

Alarm, user-specific

A user-specific alarm designates a certain operating status of the plant connected to the HMI
device via the PLC.

Automation device
An automation device is a PLC of the SIMATIC S5 series, for example the AG S5-115U

Automation system
An automation system is a PLC of the SIMATIC S7 series, for example SIMATIC S7-300

Bootloader

Used to start the operating system. Automatically started when the HMI device is switched
on. After the operating system has been loaded, the Loader opens.

Configuration PC

A configuring PC is a programming device or PC on which plant projects are created using
an engineering software.

MP 177 (WinCC flexible)
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Configuration software

Display duration

EMC

Event

Field array

Flash memory

Function keys

Software used to generate projects used for the purpose of process visualization. An
example of configuring software is WinCC flexible.

Defines whether a system alarm is displayed on the HMI device and the duration of the
display.

Electromagnetic compatibility is the ability of electrical equipment to function properly in its
electromagnetic environment without influencing this environment.

Functions are triggered by defined incoming events. Events can be configured. Events which
can be assigned to a button include "Press" and "Release", for example.

Area reserved in configured screens for the input and output of values.

Non-volatile memory with EEPROM chips, used as mobile storage medium or as memory
module installed permanently on the motherboard.

Key on the HMI device which supports user-specific functions. A function is assigned to the
key in the configuration. The assignment of the keys may be specific to an active screen or
not.

Half Brightness Life Time

Hardcopy

HMI device

242

Time period after which the brightness reaches 50% of the original value. The specified
value is dependent on the operating temperature.

Output of the screen content to a printer.

An HMI device is a device used for the operation and monitoring of machines and plants.
The statuses of the machine or plant are indicated by means of graphic elements or by
indicator lamps on the HMI device. The operator controls of the HMI device allow the
operator to interact with the processes of the machine or plant.

MP 177 (WinCC flexible)
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HMI device image

I/0 field

Infotext

Object

A file that can be transferred from the configuring PC to the HMI device. The HMI device
image contains the operating system and elements of the runtime software required to run a
project.

An 1/O field enables the input or output of values on the HMI device which are transferred to
the PLC.

An infotext is a configured information on objects within a project. Infotext for an alarm, for
example, may contain information on the cause of the fault and troubleshooting routines.

An object is a component of a project. Example: screen or alarm. Objects are used to view or
enter texts and values on the HMI device.

Operating element

Plant

PLC

PLC job

Component of a project used to enter values and trigger functions. A button, for example, is
an operating element.

General term referring to machines, processing centers, systems, plants and processes
which are operated and monitored on an HMI device.

A PLC is a general term for devices and systems with which the HMI device communicates,
e.g. SIMATIC S7.

A PLC job triggers a function for the PLC at the HMI device.

Process visualization

Visualization of technical processes by means of text and graphic elements. Configured
plant screens allow operator intervention in active plant processes by means of the input and
output data.

MP 177 (WinCC flexible)
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Project

Result of a configuration using a configuration software. The project normally contains
several screens with embedded system-specific objects, basic settings and alarms. The
project file of a project configured in WinCC flexible is saved under the file name extension
*.hmi.

You need to distinguish between a project on the configuring PC and that on an HMI device.
A project may be available in more languages on the configuring PC than can be managed
on the HMI device. The project on the configuring PC can also be set up for different HMI
devices. Only the runtime project that has been generated for the respective HMI device can
be transferred to it.

Project file

File generated from the runtime project file for use on the HMI device. The project file is
normally not transferred and remains on the configuring PC.

The file name extension of a source file is *.hmi.

Project file, compressed

Compressed format of the project file. The compressed project file can be transferred
together with the runtime project file to the respective HMI device. For this purpose,
backtransfer must be enabled in the project on the configuring PC. The compressed project
file is normally stored on an external memory card.

The file extension of a compressed file is *.pdz.

Recipe

Combination of tags forming a fixed data structure. The data structure configured can be
assigned data on the HMI device and is then referred to as a record. The use of recipes
ensures that all the assigned data is transferred synchronously to the PLC during the
transfer of a record.

Runtime project file

File generated from the project file for a specific HMI device. The runtime project file is
transferred to the corresponding HMI device and used to operate and monitor plants.

The extension of a compressed file is *.pdz.

Runtime software

The runtime software is a process visualization software used to test a project on a
configuring PC.

Screen

Form of the visualization of all logically related process data for a plant. The visualization of
the process data can be supported by graphic objects.

MP 177 (WinCC flexible)
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Screen object

Configured object used to display or operate the plant, e.g. rectangle, I/O field or alarm view.

STEP 7
STEP 7 is the programming software for SIMATIC S7, SIMATIC C7 and SIMATIC WinAC
PLCs.

STEP 7 Micro/WIN

STEP 7 Micro/WIN is the programming software for SIMATIC S7-200 PLCs.

Symbolic 1/O field

System event

Tab sequence

Tag

"Transfer" mode

Transfer

WinAC MP

A symbolic 1/O field is a field for the input and output of the value. Contains a list of default
entries from which one can be selected.

A system alarm is assigned to the "System" alarm class. A system alarm refers to internal
states on the HMI device and the PLC.

During configuration, this defines the sequence in which objects are activated on pressing
the <TAB> key.

Defined memory location to which values can be written to and read from. This can be done
from the PLC or the HMI device. Based on whether the tag is interconnected with the PLC or
not, we distinguish between "external" tags (process tags) and "internal" tags.

An operating mode of the HMI device in which an executable project is transferred from the
configuring PC to an HMI device.

Transfer of a runtime project from the configuring PC to the HMI device.

WinAC is a software PLC for multifunctional platforms.

MP 177 (WinCC flexible)
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A

Accessory kit, 17
Acknowledge
Alarm, 169
Error alarm, 169
Acoustic signal, 141
Address assignment
LAN network, 102
Addressing, 99
Admin, 162, 163
Agency, 6
Alarm, 165
Acknowledge, 169
Alarm indicator, 166
Display, 167
Editing, 170
Functional scope, 20
Alarm buffer, 166
Functional scope, 20
Alarm class, 165, 168
Alarm event, 165
Alarm group, 166
Alarm indicator, 166
Alarm line, 167
Alarm report, 166
Alarm view, 167
Extended, 168
Simple, 167
Alarm window, 169
ALARM_S, 20
Alphanumerical
Screen keyboard, 142
Alphanumerical value
Changing, 143
Entering, 143
Ambient conditions
Climatic, 32
Mechanical, 31
Test, 32
Ambient temperature, 33
Applications
MP 177,15
Authorization, 156
Automatic
Transfer, 116
Automation License Manager, 132

MP 177 (WinCC flexible)
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Backlighting
Reducing, 79
Backtransfer, 114, 118
Backup, 63, 109, 113, 120, 121, 123, 157
Registry information, 64
Registry Information, 77
Temporary files, 77
To external storage medium, 63, 107
With ProSave, 123
With WinCC flexible, 121
Bar, 146
Basic knowledge
Required, 3
Booting, 82
Bottom view, 16
Brightness
Changing, [79
Bus connection, 23
Bus parameters
Profile, 98

C

Cable

Connecting, 40

Data exchange, 51
Cable cross-section, 44

Equipotential bonding, 42
Calibrating

Touch screen, 64, 71
Cancel

Secure mode, 61
Cancel

Password protection, 74
Care, 197
CE approval, 26
Certificate

Deleting, 63, 106

Displaying, 63

Importing, 106
Certifications, 26
Changing

Brightness, 79

User data, 162
Character repeat, 63

Screen keyboard, 68
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Charging
Electrostatic, 207
Clean screen, 198
Clearance
MP 177, 35
Climatic
Storage conditions, 30
Transport conditions, 30
Closing
Project, 163
Column sequence
Alarm view, 168
Commissioning engineers, 3
Compeatibility conflict, 120
Computer name
For network operation, 100
Setting, 64
Configuration PC, 19, 111
Connecting, 48
Connection diagram, 48
Configuration phase, 19, 111
Configuring
Data channel, 64
Network, 100
Operating system, 59
PC/PPI cable, 48
RS-422/RS-485 port, 47
Screen keyboard, 63, 67
Connecting
Configuration PC, 48
Equipotential bonding, 42
PLC, 46
Plug-in terminal strip, 44
Power supply, 44, 45
Printer, 51
PROFINET, 47, 48
UPS, 52
USB device, 50
Connection, 23
Connection diagram
Configuration PC, 48
PLC, 46
Power supply, 44
Printer, 51
UPS, 52
Connection graphic
Equipotential bonding, 43
Connection sequence, 40
Connections to PLC
Number, 23
Control Panel, 62
MPI, 97
Opening, 63
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Operating, 65

Password protection, 60

PROFIBUS, 97

Screen keyboard, 66
Creating

Recipe data record, 181, 189

Users, [160
C-Tick mark (Australia), 27

D

Data channel
Configuring, 64
Locking, 93

Data flow, 175

Data record list, 177, 188

Date, 63
Entering, 144
Setting, 74
Synchronizing, 76

Date format, 77

Date/time properties, 63, 75

Decimal, 141

Default gateway, 102

Degree of protection, 34

Protection against ingress of solid foreign

bodies, 36

Protection against water, 36

Delay time
Setting, 64, 89
Delete

Recipe data record, 183, 191

Users, 163
Deleting
Certificate, 63, 106
DHCP, 102
DIP switch
Setting, 47
Direct key, 138
Assigning, 203
Functional scope, 22
Direct keys
Direct key areas, 203

WinCC flexible direct keys in WinAC MP 2008, 203

Display
Alarm, 167
Infotext, 145, 169
MP 177, 201
Displaying
HMI device information, 64

Information on the MP 177, 84

Memory information, 86
System information, 85, 86

MP 177 (WIinCC flexible)
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Disposal, [7

Disturbance
Pulse-shaped, 28
Sinusoidal, 29

DNS, 103
Server, 99

Documentation
Conventions, 6
Enclosed, 37
Getting started, 4
Operating instructions, 5
User manual, 4

Double-click, 63
Setting, [70

Drop down list box, 144

E

EC Declaration of Conformity, 26
Editing
Alarm, 170
Recipe data record, 182, 190
Elbow adapter, 18
Electrical
Safe separation, 45
Electrical potential difference, 42
Electrostatic charging, 207
Electrostatic discharge
Precautions, 208
Element list, 177, 188
E-mail
Setting, 64, 105
EMC directive, 26
Emission, 28, 29
Entering
Alphanumerical value, 143
Date, 144
Numerical value, 141
Recipe data record, 195
Symbolic value, 144
Text box, 140
Time, 144
Entry on the HMI device
Using operating elements, 135
Equipotential bonding
Cable, 42
Connecting, 42
Connection graphic, 43
Requirements, 42
Error alarm
Acknowledge, 169
ESD

MP 177 (WinCC flexible)
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Abbreviations, 207

Labeling, 207
Ethernet settings

IP address, 102
Exporting

Recipe data record, 193
Extended alarm view, 168
Extended recipe view, 176
Extended user view, 158
External

Keyboard, 65

Mouse, 65

USB devices, 41

F

Feedback
Optical, 137
FM Approval, 27
Front view, 16
Function test, 54
Functional scope
Alarm buffer, 20
ALARM_S, 20
Alarms, 20
Graphics list, 21
Infotext, 22
Limit value monitoring, 21
Recipe, 21
Safety, 21
Scaling, 21
Screen, 21
Tag, 21
Text list, 21
Functions
Additional, 22

G

Gauge, 146
Graphics list
Functional scope, 21

H

High frequency radiation, 25
HMI device
EMC-compliant installation, 28
Information, 64
Ports, 41
Restart, 82
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Restarting, 64
Switch off, 54
Switching on, 53
Testing, 53

HMI Input Panel
Options, 67

Host cable
Safety instruction, 49

Identification, 104
Importing
Certificate, 106
Recipe data record, 194
Information
For the HMI device, 84
Infotext
Display, 145, 169
Functional scope, 22
Initial startup, 111
Input Panel, 63
Input unit
MP 177, 202
Installing
Option, 114, 129, 131
Instructions
General, 28
Insulation test
Test voltage, 35
Interface
MP 177, 202
Internal clock, 76
Internet
Service, 7, 199
Settings, 64, 105
Support, 7, 199
IP address, 102
Ethernet, 102

Setting, 64
K
Keyboard
External, 65

Keyboard properties, 63

L

Labeling
Certifications, 26
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EC Declaration of Conformity, 26
LAN connection, 64
Language change
Functional scope, 22
Layout
Slider control, 148
Sm@rtClient view, 153
Trend view, 149
License key, 132
Transferring, 114, 133
Transferring back, 114, 134
Limit value
For password, 157
For user, 157
For user view, 157
Limit value monitoring
Functional scope, 21
Limit value test, 141
List of abbreviations, 239

Loader, 59
Opening, 60
Locking
Operating element, 198
Logoff
Users, 160
Logoff time, 156
Logon
Users, 159

Logon data, 104

M

MAC address, 91
Maintenance, 197, 199
Maintenance technicians, 3
Manual
Production sequence, 196
Transfer, 115
Mechanical
Storage conditions, 30
Transport conditions, 30
Memory
MP 177, 202
Memory allocation, 64
Memory card, 18
Ejecting, 57
First use, 108
Inserting, 56
Restoring file system, 78
Memory information
Displaying, 86
Memory management, 64, 86

MP 177 (WinCC flexible)
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Monitoring mode
Sm@rtClient view, 153
Mounting, 34
EMC-compliant, 28
Mounting clamp
Mounting, 38
Mounting cut-out
Dimensions, 34
Preparing, 34
Mounting location, 34
Mounting position, 33
Mouse
External, 65
Mouse properties, 63
MP 177
Applications, 15
Bottom view, 16
Clearance, 35
Displaying information, 84
Front view, 16
Mounting, 39
Operator control, 55
Ports, 41
Rear view, 17
Side view, 16
Switching on, 53
Testing, 53
MPI
Setting, 64, 97
Multi-key operation, 136
Multimedia card, 56

N

Name server, 103
Network
Configuring, 100
Logon data, 64
Set up, 99
Setting, 102
Network & dial-up connections, 64
Network ID, 64
Network operation
Computer name, 100
Options, 64
Nominal voltage, 36
Non-isolated system configuration, 45
NOTE
License key, 129
Number format, 77
Numerical
Screen keyboard, 140

MP 177 (WinCC flexible)
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Numerical value
Changing, 141
Decimal places, 141
Entering, 141
Limit value test, 141

O

Offices, 6
Offline
Operating mode, 112
Recipe tag, 180
Test, 119
Online
Operating mode, 112
Recipe tag, 180
Test, 119
OP properties, 64
Device, 84
Memory monitoring, 87
Persistent storage, [78
Touch, 71
Opening
Control Panel, 63
Loader, 60
Operating
Control Panel, 65
Feedback, 136
Project, 135
Recipe menu, 188
Recipe screen, 181|, 188
Slider control, 148
Switches, 147
Trend view, 150
With external keyboard, 136
With external mouse, 136
Operating element
Locking, 198
Operating instructions
Purpose of, 3
Scope, 4
Operating mode, 112
Changing, 112
Offline, 112
Online, 112
Transfer, 53, 112
Operating system
Configuring, 59
Safety instruction, 49
Update via ProSave, 128
Update via WinCC flexible, 126
Updating, 125
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Operation feedback, 136
Operator control
MP 177, 55
Recipe view, 181
Simple recipe view, 187
Operator control options, 65
Operators, 3
Optical feedback, 137
Option
Installing, 114, 129
Installing with ProSave, 131
Installing with WinCC flexible, 129
Removing, 114, 129
Removing with ProSave, 131
Removing with WinCC flexible, 130
Options, 22
Network operation, 64

P

Password, 156
Backup, 157
Restoring, 157
Password list, 156
Password properties, 64, 73
Password protection, 60, 64
Cancel, 74
Set up, 74
Windows CE taskbar, 60
PC/PPI
Cable, 18
Configuring the cable, 48
Setting the adapter, 49
PELV, 45
Peripherals
Rated load, 50
Permission in remote control, 155
Pin assignment
Power supply, 204
RJ45 plug connector, 205
RS-422/RS-485 port, 204
USB port, 205
PLC
Configuring the port, 47
Connecting, 46
Connection diagram, 46
Number of connectable, 23
Protocol, 23
Reading recipe data record, 185, 191
Transferring recipe data record, 186, 192
PLC_User, 162, 163
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Plug-in terminal strip
Connecting, 44
Ports
MP 177, 41
Rated load, 50
Power failure, 120
Power supply
Connecting, 44, 45
Connection diagram, 44
Pin assignment, 204
Setting, 64
Precautions
Electrostatic discharge, 208
Printer
Connecting, 51
Connection diagram, 51
Setting properties, 64
Printer connection
Setting, 81
Printer properties, 64, 81
Printing
Via network printer, 100
Process control phase, 111
Production sequence
Manual, 196
PROFIBUS DP
Setting, 64, 97
PROFINET, 99
Addressing, 99
Connecting, 47, 48
PROFINET IO
Disabling direct keys, 91
Enabling direct keys, 91
Setting, 64
Project
Closing, 163
Offline testing, 119
Operating, 135
Reuse, 113
Testing online, 119
Transferring, 111, 113
Proper use, 25
Protection class, 35
Protective cover, 18
Protective foil, 18, 198
Protocol
PLC, 23
Proxy
Server, 105
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R

Radiation
High frequency, 25
Radio interference, 28
Emission, 29
Rated load
Interface, 50
Reading
Recipe data record, 185
Reading out
Recipe data record, 191
Real-time clock
Internal, 76
Rear view, 17
Recipe, 172
Control, 173
Data flow, 175
Data record, 173
Field of application, 171
Functional scope, 21
Recipe screen, 176
Recipe view, 176
Synchronizing tags, 184
Recipe data record
Creating, 181, 189
Delete, 183, 191
Editing, 182, 190
Entering, 195
Exporting, 193
Importing, 194
Reading from PLC, 185, 191
Synchronize with PLC, 182
Transferring to PLC, 186, 192
Recipe list, 177, 188
Recipe menu
Operating, 188
Recipe screen, 178
Operating, 181, 188
Overview, 178
Recipe tag
Offline, 180
Online, 180
Synchronizing, 179, 184
Recipe view, 176
Extended, 176
Menu items, 188
Operator control, 181, 187
Simple, 177
Recommissioning, 111
Recycling, 7
Regional and language settings, 64, 77
Regional settings, 77
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Registered trademarks, 6
Registry information
Backup, 64
Registry Information
Backup, 77
Regulations for the prevention of accidents, 25
Remote control
Forcing permission, 155
Start, 154
Removing
Option, 114, 129, 130, 131
Repairs, 199
Resetting to factory settings, 113
Restore, 63, 107
Restoring, 113, 120, 122, 124, 157
From external storage medium, 63, 109
From memory card, 78
With ProSave, 124
With WinCC flexible, 122
Return Center, 199
Reverse polarity protection, 45
RJ45 plug connector
Pin assignment, 205
RS 422-RS 232 converter, 17
RS-422/RS-485 port
Configuring, 47
Pin assignment, 204
Ruler, 150
Trend view, 150

S

S7 transfer settings, 64
Safe electrical separation, 45
Safety
Functional scope, 21
Standards, 26
Safety instruction
Backlighting, 80
Changed tag name, (184
Compeatibility conflict, 120
Compressed project file, 114
Connection sequence, 40
Data channel, 126
Data loss, 108, 125
Device name, 91
Direct key, 138
Electrostatic charging, 207
Equipotential bonding conductor, 42
High frequency radiation, 25
Interface, 50
License key, 126
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Loss of data possible, 109
Memory allocation, 86
Memory card, first use, 57
Multi-key operation, 136
Observe grounding measures, 208
Path, 88, 89
Power failure, 120
Preventing inadvertent operation, 197
Project file, 88, 89
Proper use, 25
Recipe data record in the background, 177
Remote control for channel 1, 94
Restart, 82
Restoring factory settings, 49
Storage, 30
Switching infotext, 145
Time-dependent reactions, 76
Touch screen, 55
Transfer mode, 96
Transfer mode channel 2, 94
Transport, 30
Unintentional action, 55
Unintentional transfer mode, 93
USB Host-to-Host cable, 49
Working on the control cabinet, 25
Safety regulations, 25
Scaling
Functional scope, 21
Screen
Functional scope, 21
Screen keyboard, 63, 139
Alphanumerical, 142
Change layout, 67
Character repeat, 68
Configuring, 67
For Control Panel, 66
Keyboard level, 143
Language change, 142
Numerical, 140
Representation types, 66
Screen saver, 64, 80
Setting, [79
Screen settings
Changing, 64
Secure mode, 61
Cancel, 61
Security system, 155
Service
On the Internet, 7, 199
Service pack, 199
Service technicians, 3
Set up
Network, 99
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Password protection, 74
Secure mode, 61

Setting

Computer name, 64
Date, 74

Date format, 77
Date/Time, 63

Delay time, 64, 89
DIP switch, 47
Double-click, 70
E-mail, 64

E-mail connection, 105
IP address, 64
Language, 138

MPI, 64, 97

Name server, 64
Network, 102
Number format, 77
PC/PPI adapter, 49
Power supply, 64
Printer connection, 81
Printer properties, 64
PROFIBUS, 97
PROFIBUS DP, 64
PROFINET IO, 64
Regional data, 77
Screen saver, 79
Storage location, 88
Time, 74

Time format, 77
UPS, 90

Setting language, 138
Settings

Country-specific, 77
Internet, 64
Language, 64
Regional, 64
S7-Transfer, 64

Side view, (16

Siemens HMI input panel options, 63
SIMATIC Logon, 156

Simple alarm view, 167

Simple recipe view, 177

Menu items, 188
Operator control, 187

Simple user view, 158
Slider control, 148
Sm@rtAccess, 22
Sm@rtClient view, 153, 154

Monitoring mode, 153
Usage, 153

Sm@rtService, 22
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SMTP server, 105
Software options, 22
Sort order

Alarm view, 168
Specifications

Display, 201

Input unit, 202

Memory, 202

MP 177, 201

Ports, 202

Power supply, 204

RJ45 port, 205

RS-422/RS-485 port, 204

Supply voltage, 202

USB port, 205
Standard operating system, (15
Start

HMI device, 64, 82
Status Force, 151

Touch operation, 152
Storage conditions, 30
Storage location

Setting, 88
Storage medium

Restoring from external, 109

Saving to external, 107
Subnet mask, 102
Supply voltage

MP 177, 202
Support

On the Internet, 7, 199
Switch off

HMI device, 54
Switches, 147
Switching cabinet

Working on, 25
Switching on

MP 177, 53
Symbolic value

Changing, 144

Entering, 144
Synchronizing

Date and time, 76

Recipe tag, 179, 184
System alarm

Meaning, 209

Parameters, 209
System configuration

Non-insolated, 45
System information

Displaying, 85, 86
System properties, 64

Device name, 101
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General, 85
Memory, 86

T

Tag
Functional scope, 21
Task planner
Functional scope, 22
Taskbar, 59
Technical Support, 7
Temporary files
Backup, 77
Test
For ambient conditions, 32
Testing
MP 177, 53
Text box, 140
Text list
Functional scope, 21
Time, 63
Entering, 144
Setting, 74
Synchronizing, 76
Time format, 77
Time zone
Setting, 74
Time-dependent reactions, 76
Touch screen
Calibrating, 64, 71
Safety instruction, 55
Trademarks, 6
Training center, 7
Transfer, 111,112, 114
Automatic, 116
Cancel, 53
Manual, 115
Transfer mode
Unintentional, 93
Via MPI, 96
Via PROFIBUS DP, 96
Transfer settings, 64, 93
Channel, 93
Directories, 88, 89
Transferring
License key, 114, 133
Project, 111, 113
Recipe data record, 186, 192
Transferring back
License key, 114, 134
Transport conditions, 30
Transport damage, 37
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Trend view, 149

Trends
Functional scope, 22
Limit violation, 149

U

UL approval, 26
Unintentional action, 55, 136
Unintentional transfer mode, 93
Uninterruptible Power Supply (UPS) with USB
support, 22
Updating
About ProSave, (128
Operating system, 125
Via WinCC flexible, 126
Updating the operating system, 113
UPS
Connecting, 52
Connection diagram, 52
Setting, 90
State, 91
UPS properties
Configuration, 90
Usage
Conditions, 31
In industry, 28
In residential areas, 28
With additional measures, 31
USB device
Connecting, 50
USB port
External device, 41
Pin assignment, 205
User data
Backup, 157
Changing, 162
Restoring, 157
User group, 156
User manual, 4
User name, 104
User view, 157
Extended, 158
Simple, 158
Users, 156
Admin, 162, 163
Creating, touch operation, 160
Delete, 163
Logoff, 160
Logon, 159
PLC_User, 162, 163
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Value table
Trend view, 149

WinCC flexible internet settings
E-mail, 64, 105

Windows CE taskbar, 59
Password protection, 60

WINS, 103
Server, 99

Working on the control cabinet, 25

MP 177 (WinCC flexible)
Operating Instructions, 08/2008, 6AV6691-1DP02-0AB0



	SIMATIC HMI HMI device MP 177 (WinCC flexible)
	Legal information  
	 Preface 
	Table of contents
	1  Overview 
	1.1  Product Overview 
	1.2  Design of the MP 177 HMI device 
	1.3  Supplementary pack and other accessories 
	1.4  Configuration and process control phase 
	1.5  Functional Scope with WinCC flexible 
	1.6  Software Options 
	1.7  Communications 

	2  Safety instructions 
	2.1  Safety Instructions 
	2.2  Standards, Certificates and Approvals 
	2.3  Notes about Usage 
	2.4  Electromagnetic Compatibility 
	2.5  Transport and Storage Conditions 

	3  Planning application 
	3.1  Mounting Information 
	3.2  Mounting Positions and Type of Fixation 
	3.3  Preparing for Mounting 
	3.4  Specifications for Insulation Tests, Protection Class and Degree of Protection 
	3.5  Rated voltages 

	4  Mounting and connecting 
	4.1  Checking the Package Contents 
	4.2  Mounting the HMI Device 
	4.3  Connecting the HMI device 
	4.3.1 Overview
	4.3.2 Ports
	4.3.3 Connection of equipotential
	4.3.4 Power supply connection
	4.3.5 Connecting a PLC
	4.3.6 Configuration PC connection
	4.3.7 USB device connection
	4.3.8 Printer connection
	4.3.9 Uninterruptible power supply connection

	4.4  Switching on and Testing the HMI device 

	5  Operator controls and displays 
	5.1  Front operator controls 
	5.2  Using Memory Cards with the HMI Device 

	6  Configuring the operating system 
	6.1  Loader 
	6.2  Setting up and canceling secure mode 
	6.3  Control Panel 
	6.3.1 Overview
	6.3.2 Opening the Control Panel
	6.3.3 Reference for functions
	6.3.4 Operating the Control Panel
	6.3.4.1 Operator control options for the Control Panel
	6.3.4.2 Operating the Control Panel with the touch screen

	6.3.5 Changing settings for operation
	6.3.5.1 Configuring the screen keyboard
	6.3.5.2 Setting the character repeat
	6.3.5.3 Setting the double-click
	6.3.5.4 Calibrating the touch screen

	6.3.6 Changing password protection
	6.3.7 Changing HMI device settings
	6.3.7.1 Setting the date and time
	6.3.7.2 Changing regional settings
	6.3.7.3 Backup registry information
	6.3.7.4 Changing monitor settings
	6.3.7.5 Setting the screen saver
	6.3.7.6 Changing the printer properties
	6.3.7.7 Restarting the HMI device
	6.3.7.8 Displaying information about the HMI device
	6.3.7.9 Displaying system properties
	6.3.7.10 Displaying memory distribution
	6.3.7.11 Activate memory management

	6.3.8 Setting storage location
	6.3.9 Setting the delay time
	6.3.10 Setting the uninterruptible power supply
	6.3.11 Enabling PROFINET IO
	6.3.12 Transfer settings
	6.3.12.1 Configuring the data channel
	6.3.12.2 Changing MPI/PROFIBUS DP settings

	6.3.13 Network operation
	6.3.13.1 Overview of network operation
	6.3.13.2 Setting the device name of the HMI device
	6.3.13.3 Changing the network configuration
	6.3.13.4 Changing the logon data
	6.3.13.5 Changing e-mail settings
	6.3.13.6 Importing and deleting certificates

	6.3.14 Backup and restore
	6.3.14.1 Saving to external storage device (backup)
	6.3.14.2 Restoring from external storage device



	7  Commissioning a project 
	7.1  Overview 
	7.2  Operating Modes 
	7.3  Using Existing Projects 
	7.4  Data Transmission Options 
	7.5  Transfer 
	7.5.1 Overview
	7.5.2 Starting manual transfer
	7.5.3 Starting automatic transfer
	7.5.4 Starting backtransfer
	7.5.5 Testing a project

	7.6  Backup and restore 
	7.6.1 Overview
	7.6.2 Backup and restore using WinCC flexible
	7.6.3 Backup and restore using ProSave

	7.7  Updating the operating system 
	7.7.1 Overview
	7.7.2 Resetting factory settings
	7.7.3 Updating the Operating System using WinCC flexible
	7.7.4 Updating the Operating System using ProSave

	7.8  Installing and removing options 
	7.8.1 Overview
	7.8.2 Installing and Removing Options using WinCC flexible
	7.8.3 Installing and removing options using ProSave

	7.9  Transferring and transferring back license keys 
	7.9.1 Overview
	7.9.2 Transferring and transferring back license keys


	8  Operating a project 
	8.1  Overview 
	8.2  Direct Keys 
	8.3  Setting the project language 
	8.4  Input 
	8.4.1 Overview
	8.4.2 Entering and editing numerical values
	8.4.3 Entering and editing alphanumerical values
	8.4.4 Entering the date and time
	8.4.5 Entering symbolic values

	8.5  Displaying infotext 
	8.6  Bar and gauge 
	8.7  Operating the switch 
	8.8  Operating the slider control 
	8.9  Operating the Trend View 
	8.10  Operating the Status Force 
	8.10.1 Overview
	8.10.2 Operation

	8.11  Operating the Sm@rtClient view 
	8.11.1 Overview
	8.11.2 Operation

	8.12  Project security 
	8.12.1 Overview
	8.12.2 User view
	8.12.3 User Logon
	8.12.4 User logoff
	8.12.5 Creating users
	8.12.6 Changing user data
	8.12.7 Deleting users

	8.13  Closing the project 

	9  Operating alarms 
	9.1  Overview 
	9.2  Recognizing pending alarms 
	9.3  Displaying alarms 
	9.4  Display infotexts for an alarm 
	9.5  Acknowledge alarm 
	9.6  Edit alarm 

	10  Operating recipes 
	10.1  Overview 
	10.2  Structure of a recipe 
	10.3  Recipes in the Project 
	10.4  Recipe displays 
	10.5  Recipe Values in the HMI Device and the PLC 
	10.6  Operating the recipe view 
	10.6.1 Overview
	10.6.2 Creating a recipe data record
	10.6.3 Editing a recipe data record
	10.6.4 Deleting a recipe data record
	10.6.5 Synchronizing tags
	10.6.6 Reading a recipe data record from the PLC
	10.6.7 Transferring a recipe data record to the PLC

	10.7  Operating the simple recipe view 
	10.7.1 Overview
	10.7.2 Creating a recipe data record
	10.7.3 Editing a recipe data record
	10.7.4 Deleting a recipe data record
	10.7.5 Reading a recipe data record from the PLC
	10.7.6 Transferring a recipe data record to the PLC

	10.8  Exporting a recipe data record 
	10.9  Importing a recipe data record 
	10.10  Examples 
	10.10.1 Entering a recipe data record
	10.10.2 Manual production sequence


	11  Maintenance and care 
	11.1  Maintenance and Care 
	11.2  Clean screen 
	11.3  Protective Foil 
	11.4  Spare Parts and Repairs 

	12  Technical specifications 
	12.1  Dimension drawings of the MP€177 
	12.2  Specifications of the MP 177 
	12.3  Bit Assignment of the Direct Keys 
	12.4  Description of the ports 
	12.4.1 Power Supply
	12.4.2 RS 422/RS 485 (IF 1B)
	12.4.3 USB
	12.4.4 PROFINET


	A  Appendix 
	A.1  ESD guideline 
	A.2  System alarms 

	B  Abbreviations 
	Glossary
	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	K
	L
	M
	N
	O
	P
	R
	S
	T
	U
	V
	W


